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1 Welcome

Astroart  7.0  is  a  fast  and  complete  software  for  image  analysis,  processing  and
camera  control.  Astroart  also  contains  a  star  atlas  for  astrometry,  photometry  and
minor planets research.

1.1 System Requirements

Astroart requires the following minimum hardware and software configuration:

§ A computer 100% PC compatible with at least a Pentium™ 800 Mhz CPU.

§ At least 512 MB of RAM. If you work with images bigger than 1024 x 1024 pixels,
1 GB or more is preferable.

§ 400 MB of free hard disk space.

§ 1024 x 720 graphic card with true color.

§ Windows 10, 8.1, 8, 7, Vista, XP.  32/64 bit.

1.2 Installation

1. Insert the CD-ROM in the CD drive.

2. Open the folder "Install Astroart 7" and double-click SETUP.EXE.

3. During the installation it's possible to choose a destination directory for Astroart
(default is C:\Program Files\MSB\Astroart7\). 

4. In  the  first  execution  of  Astroart  the  program  will  ask  the  user  name  and  the
serial number which is printed on the cover of this manual.

5. To change the language click the menu File / Language and restart Astroart.

6. To command your camera with Astroart it may be needed to download the latest
version  of  the  plugins,  at  the  web  site:  www.msb-astroart.com  .  Follow  the
instruction in chapter 5 "Camera Control".

1.3 Technical Assistance

M.S.B. Software

Via Goetz 93, Classe
48124 Ravenna RA - ITALY
FAX/TEL: +39-0544-527265. Mobile +39-339-2739548
MAIL: info@msbsoftware.it 
  
http://www.msb-astroart.com 
http://www.msbsoftware.it/astroart

http://www.msb-astroart.com
mailto:info@msbsoftware.it
http://www.msb-astroart.com
http://www.msbsoftware.it/astroart
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2 Introduction

In  this  chapter,  you  will  find  the  description  of  the  GUI  (Graphic  User  Interface)
adopted by Astroart, how it operates and how all windows are related to each other.

2.1 The Astroart Desktop

The  basic  components  of  the  Astroart  desktop  are  the  Tools  bar  at  the  top,  the
Status  bar  at  the  bottom,  and  a  Palette  bar  on  the  right.  The  brightness  of  the
desktop can be changed from the Preferences.

The Toolbars

They contain several buttons for quick access to common command. They can be
docked everywhere on any side of the Astroart desktop. The size of the icons can be
set in the Preferences.

The Status bar

Displays information about the active image: the X and Y coordinates of the pixel
under  the  mouse  pointer  and  the  ADU  value  of  that  pixel  (Luminance  and  RGB
values for a color image).

The Palette bar
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Shows the gray levels (or the false color palette) used to display the image. Double
click to open a custom palette from disk. Two small cursors represent the minimum
and maximum visualization thresholds.

2.2 The Image Window

Image Windows are used to display images. When an image is shown on the screen,
its  pixel  values  (ADU)  are  converted  in  realtime  to  a  shade  of  gray  or  to  a  color
palette. 

On the title bar of every Image Window you will find a number (it's a counter) and
the name of the file.  The counter is  useful  because you can open the same image
multiple times.

Status bar

On the bottom of the Image Window  there's another status bar, with the following
data:  (you  may  increase  the  size  of  the  text  with  the  option  "Big  fonts"  in
Preferences).

§ R  is  the  ADU  range  of  the  image  (i.e.  2769:32071)  this  means  that  the  darkest
pixel  has  a  value  of  2769  ADU  and  the  brightest  a  value  of  32071  ADU,  these
units  are  proportional  to  the  light  captured  by  the  CCD  if  it  is  working  on  the
linear range of its response curve.

§ B is the calculated sky background value.
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§ V  are  the  visualization  thresholds:  the  first  number  is  the  minimum  threshold,
the  second is  the  maximum  threshold  (see  below for  the  definition);  the  last  is
the transfer function used to map ADU values of the image to the gray levels of
the PC monitor, in this example it’s a linear function (labeled Lin).

Visualization

Every image is displayed according two visualization thresholds:

§ Minimum threshold: every pixel below this value will be displayed black.

§ Maximum threshold: every pixel above this value will be displayed white. 

All other pixels with values between the two thresholds will be displayed as shades
of gray (or shades of colors) according to the current transfer function and palette.

The  fastest  way  to  change  the  visualization  is  rotating  the  mouse  wheel.  It'  also
possible  to  drag  the  cursors  on  the  palette  bar  (use  the  right  mouse  button  for
precise  movements).  Keep  pressed  CTRL  for  finer  movements.  To  modify  the
visualization  with  the  keyboard  press  [PAG_UP]  and  [PAG_DOWN].  For  an
automatic visualization click the status bar of the image. 

Context menu

Click the right mouse button over the image to display the context menu: here you
will  find  some  quick  commands:  Edit  pixels,  Palette,  View  Range,  Transfer
Function.

Keyboard shortcuts

  [+] (Numeric keypad). Zooms in the image.

  [-] (Numeric keypad). Zooms out the image.

  [*] (Numeric keypad). Adapts the window frame to the image.

  [Arrows].  Moves  the  view  when  the  image  is  zoomed.  Press  SHIFT  for  fast
movements.

  [PAG_UP]  ,  [PAG_DOWN].  Changes  the  visualization  (white  threshold).  Press
CTRL for finer control.

  [SHIFT + PAG_UP  /  DOWN].  Changes  the  visualization  (black  threshold).  Press
CTRL for finer control.

Mouse commands

  Right click + drag. Pans the image if it’s zoomed.

  Wheel  rotation.  Changes  the  visualization  (white  threshold).  Press  Ctrl  for  finer
control.

  Wheel  rotation + [Shift].  Changes the  visualization  (black  threshold).  Press  Ctrl
for finer control.

  Wheel click + rotation. Changes the visualization (black threshold). Press Ctrl for
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finer control.

  Wheel click + drag. Zooms the image.

  Right click. Displays the context menu.

  Left click. Selects a point. If clicked over a star selects the star.

  [Ctrl] + left click. As above with inverted logic.

  Left click + drag. If some points are selected, deletes them otherwise it selects a
rectangle or a line.

  [Shift] + left click. Restores deleted points or copies them from another image.

Side by side comparison

  [Ctrl] + Right click + drag. Pans both images. They must have the same size and
should be aligned.

  [Ctrl] + Wheel click + drag. Zooms both images.

  [Ctrl] + [Shift] + Right click + drag. Pans both images when they have different
size or when they are not aligned.

3 Tutorials

The following Tutorials are useful to make practice with the commands of Astroart.

3.1 Noise reduction

In these example  you will learn the use of some Astroart commands to improve the
quality of two images.

Example 1

Before to start, let's take a look at the visualization of an image.

1. Open the image M65_CAL.FIT from the folder IMAGES.

2. Press  [PAGE_DOWN]  three  times,  then  [PAGE_UP]  three  times.  Repeat  this
procedure again, looking at the image and at the cursors on the palette bar.

3. As you can see you are modifying the visualization, but you are not changing the
image  data.  This  is  the  difference  between  scientific  software  and  painting
software, the visualization stretch does not change the image content.

4. Now press [SHIFT] + [PAGE_DOWN] three times. This time you are modifying
the brightness of the sky background, indeed you are moving the black cursor on
the palette bar.

5. If  your  mouse  has  the  wheel  try  to  rotate  it,  it  will  move  the  white  cursor.  To
move the black cursor click the wheel while rotating it. 

Example 2
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1. Open the image MOON.FIT. Press [PAGE_DOWN] on the keyboard to highlight
the left part of the picture. 

2. Click on menu View > Local Zoom.  Move the zoom window if  it  overlaps with
the main view. Move the cursor on the lower left side of the image and note with
the zoom window some noise (pixels brighter than usual).

3. Click the right  mouse button over the noisy area and select  Lock Zoom and 3D
from the Context menu.

4. Click on menu Filters > Median > Median 3x3, select Strength = 5%.  Note the
improved  image  quality;  press  [F9]  key  Undo  /  Redo  many  times  to  appreciate
the difference between before and after.  

5. Once you have eliminated the noise it is possible to enhance the definition with
High-Pass or Unsharp mask filters. 

Example 3

1. Click  on  menu File  > Open  to  display  the  Open  dialog  window.  In  the  combo
box “File Type” select  SBIG then select  the file  HORSE-SB.ST6 from the folder
IMAGES of the Astroart CDROM.

2. Press  [PAG_DOWN]  to  lower  the  visualization  threshold  and  enhance  the
nebulosity.  

3. Try to apply the filter Hot Pixels and DDP.

Example 4

1. Open  the  image  N6824.fit  and  click  Filters  >  Remove  gradient  with  the  option
Adaptive Subtract to remove the vignetting.

2. Select  (left  click)  the  two  end  points  of  the  satellite  streak  and  click  Filters  >
Cosmetic > Remove line to delete it.  

3. Select a point in the middle of the saturated star and click Filters > Cosmetic >
Remove blooming to fix the star. If some pixels are not corrected right click over
the star and fix them with the menu command Edit pixels.

3.2 Dark frame and Flat field

1. Open the image M3_RAW.FIT from the folder IMAGES of the Astroart  CDROM
and note the noise caused by the dark current and the black spots caused by dust
particles on the focal plane. Open M3_DARK.FIT and M3_FLAT.FIT: with these
images we will correct the above defects.

2. Select  the  image  M3_RAW.FIT  (an  image  is  Selected  when  his  title  bar  is
highlighted)  and  click  on  menu  Arithmetic  >  Subtract  and  select  the  image
M3_DARK.FIT  in  the  dialog  box.  Modify  the  Visualization  thresholds  to  better
display the image corrected for dark frame (use the cursors  on the right  side of
Astroart desktop or click on the status bar of the image).

3. Now it is possible to correct the image for the flat field. But before it is necessary
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to correct the flat field for the dark frame too: select M3_FLAT.FIT and subtract
from it the M3_DARK.FIT as you did before with the raw image.

4. Select  M3_RAW.FIT  and  click  on  menu  Arithmetic  >  Divide  and  select
M3_FLAT.FIT in the "Select image" dialog box.

Automatic processing

Clean the Astroart desktop with menu File > Close All. Do not save the changes.  

1. Click on menu Tools > Preprocessing. Drag & drop the file M3_RAW.FIT in the
"Images"  box,   the  M3_FLAT.FIT  in  the  "Flat  field"  box  and  the  file
M3_DARK.FIT  in  the  "Dark  frame"  box  and  in  the  "F.  Dark  frame"  boxes;  you
could add in the same Dark boxes the file M3_DARK2.FIT: in this case there will
be  calculated  a  Master  Dark  Frame  composed  by  the  averaged  values  between
the two dark frames. (During your own preprocessing session try to add at least 8
or 9 dark frames to reduce the noise fluctuations between the frames).

2. Click OK to start the automatic Preprocessing.

3.3 Searching for asteroids

Usually you can search faint asteroids blinking two images taken in different times.

1. Open the images ASTER_A1.FIT and  ASTER_A2.FIT  

2. Click on menu View | Blink to blink the two images.

3. Can  you  see  the  asteroid?  It  is  just  below  a  bright  star  near  the  center  of  the
frame.  Try  to  adjust  the  alignment  between  the  two  images  clicking  the  Align
button or the red arrows. Change the blinking frequency moving the slider.

4. Repeat  the  search  with  another  asteroid  using  the  images  ASTER_B1.FIT  and
ASTER_B2.FIT.

3.4 FFT

In this tutorial we will study the Fourier Transform and the frequency domain, to
correct images affected by periodic noise. 

1. Open the image M81.FIT and click on menu Arithmetic > Image->FFT to create
the FFT of the image. Press PAG-UP 3-4 times to darken the FFT.  

2. Bring  the  mouse  pointer  to  the  approximate  coordinates  (140,50)  and  click  the
right mouse button, then EDIT PIXELS on the context menu.

3. Edit the pixel at coordinates (140,50) and write 10000. Click OK.

4. Now execute the command FFT -> IMAGE.

The result of this procedure is a new M81 image where a periodic noise affects the
picture.  Now,  the  way  to  correct  such  image  is  clear:  at  first  perform  the  FFT
transform, look for isolated and bright pixels, delete them, and perform the inverse
transform at the end. 
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1. Open the image M51NOISE.FIT and perform the FFT.

2. Move the visualization threshold until  you  see  two bright  pixels  at  coordinates
(140,46)  and  (140,47).  Use  the  command  EDIT  PIXELS  and  set  them  to  zero.
Click OK.

3. Perform the inverse transform. Arithmetic > FFT->Image

The  periodic  noise  is  now perfectly  corrected.  Sometimes  it’s  not  easy  to  see  the
noise  pixels  (frequencies)  and  another  step  is  required:  after  opening  the  image
execute  the  command  Scale  >  Transfer  Function.  Try  with  the  M51NOISE.FIT
image.

3.5 Aligning and summing images

To obtain  a  good  Signal/Noise  ratio  it  is  often  necessary  to  sum or  average  many
images. Sometimes there is a misalignment from a frame to an other, due to a bad
telescope motion, so all images should be shifted to fit exactly the other.  

1. Open  the  images  ALIGN1.FIT  and  ALIGN2.FIT,  we  will  try  to  align  and  sum
them.  

2. Select ALIGN1.FIT and click on menu Arithmetic > Add image.  

3. The image ALIGN2.FIT is summed on the ALIGN1.FIT but, as you can see, it is
not exactly aligned with it (rotate the mouse wheel to fix the visualization). Press
[F9] to undo.

4. To  align  the  images  we  have  to  select  a  reference.  In  this  case  we'll  use  "Star
pattern - translation only". Click on menu Image > Align and click OK.  

5. The images are now exactly aligned and can be summed. After the sum click on
the status bar of the result image to adjust the visualization thresholds.

The align method "Star pattern" is the recommended one. It will analyze the image
and chose for you the best stars for the automatic alignment.

Automatic procedure

In  this  further  example  we  will  try  to  align  and  sum  automatically  a  series  of  4
images of  the planetary  nebula  M57.  These  images  are  already  preprocessed with
dark frames but summing them we want to increase the overall signal to noise ratio.

1. Click on menu Tools > PreProcessing and drag & drop in the "Images" box the 4
images of the planetary nebula (if other images are present in the boxes click the
Reset button).

2. Select  "Sum" in the Images section ("Average"  is  possible  too).  Select  the  folder
"Options"  then  disable  the  item  "Confirm  all  images"  and  enable  "Auto
alignment", click OK.

3. Click OK again in the Preprocessing window: The result  image,  the  sum of  the
selected 4 images, will be automatically built. Rotate the mouse wheel to adjust
the visualization.
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Close all  images.  Open in Astroart  all  four M57 images  into  the  Astroart  desktop,
then try the command "Align all".

Planets

Aligning  and  adding  planets  is  even  simpler,  since  you  don’t  need  to  select  any
reference.

1. Open the Preprocessing window and click on the Reset button. Select SBIG file
format and Drag & Drop into the Images box all the Saturn images available.

2. Click on Automatic Alignment and select “planet” as aligning method. Click OK
and wait for the final image. Remember to keep not selected the option “confirm
each image”.

3. Now that  a  good image  has  been built  it’s  possible  to  apply  the  Unsharp  Mask
filter to improve its sharpness.

4. Just for fun, repeat the preprocessing without enabling the Automatic Alignment
to verify that the planet is located at different coordinates in every frame.

3.6 Manual aligning

1. We will align a set of 4 images of the comet Hartley; the comet is quite faint and
passes  near  a  bright  star,  so  an  automatic  aligning  will  be  probably  a  difficult
task.

2. Click  on  menu  Tools  |  PreProcessing  and  drag  &  drop  in  the  "Images"  box  the
files  from  HARTL_01.FIT  to  HARTL_04.FIT.  Select  "Manual  alignment"  and
press OK.

3. The first image will be opened. Select a centroid aperture of 15 pixels.

4. Try  to  find  the  nucleus  of  the  comet,  click  on  it  with  the  mouse  then  use  the
arrows  button  to  center  the  pointer  over  the  nucleus  of  the  comet.  The  square
cursor  can also  be  moved with  the  keyboard,  using  the  arrow keys,  to  confirm
press [ENTER].

5. Repeat  the  last  step  for  the  other  images  to  correct  the  relative  shifting  of  the
comet.  At  the  end  of  the  process  you  will  find  a  resultant  image  with  a  better
signal to noise ratio.

3.7 Image processing on comets

To  obtain  a  good  and  "clean"  image  of  comet  Hyakutake  we  will  automatically
average 21 frames. Then we will apply the "Larson-Sekanina" filter to enhance the
jets and the shells around the false nucleus of the comet.

1. Click on menu Tools | PreProcessing and drag & drop over the "Images" box the
frames  from HYAK_001.FIT  to  HYAK_021.FIT  (use  multiple  selection  to  select
them all at once). Select the "Option" folder,  disable  "Confirm each image" and
enable "Average" of images.
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2. Select "Auto alignment" then "One star"  method.  Inside all  of  the 21 frames the
false  nucleus  of  the  comet  is  the  brightest  stellar-like  object:  therefore,  we  can
choose as a reference point the brightest pixel of the image, set for example  X,Y
= 100,100  and R = 400.

3. Press OK and wait for the resulting averaged image.

4. Select  the  pixel  corresponding  at  the  false  nucleus  of  the  comet  (the  brightest
pixel is X=190 Y=160) and click on menu Filter | Larson-Sekanina . 

5. In  the  Larson-Sekanina  dialog  box  set  Delta  R=3  pixel  and  Alpha=10  degrees
and  click  OK.  The  comet's  dust  shells  and  a  bright  jet  (toward  the  lower  right
corner of the image) will be clearly visible.

3.8 Mosaic

A limitation  of  some  CCD  cameras  is  the  little  field  of  view  caused  by  the  small
sensitive  areas.  Nevertheless  it  is  possible  to  join  many  images  of  adjacent  areas
and compose them into a wide field image.

1. Open the images Mosa_1.fit and Mosa_2.fit 

2. Select the same star (or point) on both images and click Image/Mosaic. 

3.  Enable  the  real  time preview and move  the  brightness  slider  to  match  the  two
parts. You may want to disable the faded border for a better inspection. 

4. Enable the faded border, increase it if you like, and OK. 

5. Close Mosa_1 and Mosa_2. 

6. Open Mosa_3 and repeat the procedure. 

7. Close Mosa_3 and the Mosa1+2 partial mosaic. 

8. Open Mosa_4 and repeat the procedure.

Doing so we obtain the mosaic, exactly balanced.

3.9 Astrometry and photometry

With the astrometric calibration we will establish a "link" between each point (x,y)
of the image and the corresponding celestial coordinates (R.A. and DEC.).  

The photometric calibration will allow us to derive a function which converts the
brightness  of  a  star  from  ADU  to  magnitudes.  To  do  all  this  we  need  some
"reference" stars with known R.A., DEC., and magnitude.

Manual procedure

1. Open M57_SUM.FIT.

2. Move the cursor of the mouse on a bright star. When the cursor becomes a little
circle click on it with the left button: the star will be selected.

3. Repeat the last step for other 3-4 bright stars.  
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4. Open the Stars Window: Menu view > Stars

5. Click on menu Tools > Star Atlas, (the default field displayed by the Atlas will
be exactly the field of the planetary nebula M57). Resize the Atlas window until
it become about the same size of the image.  

6. Click  the  first  star  in  the  Stars  window (  #1  or  the  first  row),  and  a  light  blue
cross  will  highlight  the  correspondent  star  of  the  image.  Click  with  the  left
mouse button the same star  on the  Star  Atlas  and its  data   (RA,  DEC.  e  MAG.)
will be copied to the list of the Stars window.  

7. Repeat the last step for all other stars.  

8. Click on menu Tools > Astrometry then "OK".

9. Click on menu Tools > Photometry then "OK". 

The image is now calibrated: for every new object added to the Star List, RA, DEC
and MAG. will be calculated. 

Automatic procedure

1. Close the M57 image and reopen it.

2. Click the button "Reference stars, automatic" in the Star Atlas.

That's  all.  Astroart  finds  for  you  the  best  stars  in  the  atlas  and  the  image  and
matches  them  via  pattern  recognition.  Now  you  can  click  on  menu  Tools  >
Astrometry  again.  If  the  nebula  was  recognized  as  a  star,  repeat  the  procedure
decreasing the FWHM max parameter to 5.0.

Semi-automatic procedure

1. Close the M57 image and reopen it.

2. Select some stars over the image.

3. Click the button "Reference stars, manual" in the Star Atlas.

4. A  cross  will  indicate  the  first  star  you  selected.  Now  click  the  star  on  the  star
atlas.

5. Repeat the last step for the other stars.

3.10 Deconvolution

Deconvolution  is  an  iterative  process  which  corrects  a  constant  defect  over  the
image, as bad focus or star trails. Theoretically there will be a total correction only
in total absence of noise.

1. Open the image DECONV.FIT  

2. Select  a  small  rectangle  around  a  non-saturated  star:  for  example:   x1,y1  =
126,26   x2,y2 = 140,37.  

3. Click on menu Filters > Deconvolution > Maximum entropy, then click on "Get
PSF" and then on OK.  
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4. Set 30 iterations and click OK to see the result.

Let's  now  simulate  a  guiding  error.  Open  an  image  containing  stars  and  click  on
menu Filters > Convolution then set the following matrix:

1 0 0 0 0 
0 0 0 0 0 
0 0 0 0 0      ( The central pixel must be zero ) 
0 0 0 0 0 
0 0 0 0 1
  

Note  that  image  obtained  is  similar  to  those  obtained  when  the  telescope  is  hit
during  the  exposure.  Click  on  menu  Filters  >  Maximum  entropy,  with  the  same
matrix to correct the defect.  

Set 40 iterations and click OK.

Close the image and repeat with another image and the following kernel.

0 0 0 0 1 
0 0 0 2 0 
0 0 3 0 0 
0 2 0 0 0 
1 0 0 0 0 

3.11 Masks

Masks  are  useful  in  image  processing  to  process  only  a  part  of  the  image.  For
example, to highlight an object without modifying the surrounding stars, you could
select  a  mask  around  the  object  then  use  the  command  "Histogram  stretch"  or
"Color curves". For a nice result remember to smooth the mask before applying the
filter.

In this example we'll use a mask to filter only the edges of an image.

1. Open the image Coma.jpg

2. Look at the corners of the image, we want to correct stars here without correcting
the stars in the center of the image.

3. Zoom out to see the whole image, open the Mask Window, select the Ellipse tool
and  draw  a  circle  with  a  diameter  of  90%  of  the  height  of  the  image.  While
drawing you may press CTRL to force a circular shape.

4. Invert the mask clicking the button "Invert", then smooth (100) the mask:
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Now we can apply the filter to compress stars: click Tools / "Find stars", write 5000
then OK. click Filters / Cosmetic / Compress Stars, enable the Adaptive option and
click OK.

Close the mask window, press CTRL+D to delete the mask, zoom in to a corner of
the image. Now if you press F9 (undo/redo) several times you can see the difference
with the original image. Notice that stars in the middle are not changed.

3.12 Camera control

Astroart contains a "Camera Simulator" which let you make practice with common
tasks like imaging, focusing and guiding.

1. Click on menu Plug-in > Camera control.

2. Select "Simulator" and click "Setup".

3. Click the Start button to acquire an image.

4. With the mouse, draw a rectangle around a star, select the Focus/Guide page and
click on Focus.

5. Close the Focus window, then click the Guide button.

3.13 Scripts

A script is a list of commands which are executed in sequence to perform camera
and telescope control.

1. Click on menu Plug-in > Camera control.

2. Click on the "Script" button to display the Script panel.

3. Click on button "Menu", select the first demo script then execute it.

4. Repeat the last step for the other demo scripts.

4 Reference

4.1 File Menu

The following commands perform the basic input-output actions.
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4.1.1 New

This command creates a new blank image (all  pixels  values = 0 ADU),  useful  for
tests.  A  dialog  box  will  ask  you  the  X  and  Y  size  in  pixel.  The  maximum  size  is
24000 pixels. 

For  images  bigger  than  20  megapixels  we  suggest  to  use  the  LAA  version  of
Astroart, or the 64 bit version.

4.1.2 Open

This command opens one or  more images from disk.  A preview of  the image and
the FITS header is available in real time.

Multiple  files  can  be  opened  at  a  time  using  the  standard  features  of  Windows:
[Shift]  to  select  a  range  of  files,  [Ctrl]  to  select  multiple  individual  files.  For
multiple  selections  with  the  mouse,  draw a  rectangle  around  the  icons.  Files  can
also  be  opened  via  drag  and  drop  into  the  Astroart  desktop,  dragging  from  the
Windows desktop or from programs like Total Commander.

DSLR  images  can  be  opened  with  or  without  automatic  demosaic  (debayer)  see
Preferences. 

4.1.3 Save 16/32 bit

Saves the active image into a 8 / 16 / 32 bit file accordingly with the dynamic of the
image.  If  the  image  is  colored  then  three  samples  will  be  saved  for  every  pixel.
Annotations will be saved as comments into the FITS header.

FITS  (32 / 16 / 8 bit)

If  all  pixels of the image are within the range 0 to 255 ADU and they are  integer,
Astroart will save the file as an 8 bit FITS.

If all pixels of the image are within the range 0 to 65535 ADU they and are integer,
Astroart will save the file as a 16 bit FITS.

If just one pixel has a value outside the range 0 to 65535 ADU or it is expressed as a
floating point value, Astroart will save the file as a 32 bit FITS (integer or floating
point).

PNG-FITS (16 / 8 bit)

Saves a PNG file maintaining the FITS header information. The FITS header will be
saved into a "Text Chuck" of the PNG file.

If  all  pixel  values  of  the  image  are  within  the  range  0  to  255  and  are  integer,
Astroart will save the file as a 8 bit PNG file otherwise it will save the image as a 16
bit PNG file.

TIFF (16 / 8 bit)

A widely used graphic format. Very useful to pass data to older programs.
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ASCII (32 bit)

It's an one-column plain text file: the first rows are the dimensions x and y of the
image in pixels,  the  third  is  blank,  the  following  are  the  ADU value  of  the  pixels
and read line by line.

RAW (32 bit)

An array of 32 bit numbers without any header (not to be confused with the various
RAW format from DSLR cameras).

4.1.4 Save view

Saves the active image as it appears on the screen. This means that the data saved
is only a view of the image, not the real pixel data. Use this command to export the
image to other graphic programs or to publish your image on the web. Annotations
will be saved as pixels over the image.

The image can be saved at  8 bits  per channel  (256 levels),  or  16 bits  per channel
(65536 levels).  The file formats available are:  PNG, TIFF,  JPEG and BMP.  To pass
the image to other software you may also copy and paste.

4.1.5 Close

Closes the active image. If you made any change in the image or in the FITS header
then a dialog window will ask you to save or skip the changes.

§ Close all. Closes all images, asking for confirmation only one time.

§ Close  all  and  save.  A  dialog  window  will  permit  to  save  each  image  before
closing it.

4.1.6 Configure RAW

This command opens the Raw Images  section of the Preferences Window.  Here it's
possible to configure two kinds of RAW files: DSLR RAW and Custom RAW.
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DSLR  means  Digital  Single-Lens  Reflex,  which  are  the  best  digital  cameras
available  today.  By  default  they  save  their  images  as  JPEG,  but  RAW  images  are
better,  because  they  have  an  higher  dynamic  and  they  are  not  lossy-compressed.
RAW files are also required for dark frame and flat field correction. 

§ DCRAW demosaic on load. If enabled, the image will be automatically converted
to color using the DCRAW library. Remember that a DSLR RAW image is actually
a grayscale image where  the color  information is  encoded as a  Bayer  pattern.  If
you enable this option (not recommended) you won't be able to correct the dark
frame and the hot pixels. Instead, disabling the option you will be able to correct
the defects and you will demosaic later with the command Demosaic.

§ Software binning 2x2.  Works only if  DCRAW demosaic on load  is enabled  The
image will be reduced in size (50%) since four pixels will be summed into one,
increasing  the  dynamic.  This  is  an  interesting  option since  has  three  important
advantages:  1)  On  most  image  you  don’t  lose  any  information  since  multi-
megapixels images are often heavily oversampled (e.g. blurred) so a 2x2 binning
does not  worsen the  resolution.  2)  Hot  pixels  remain  single  pixels,  so  they  still
can be corrected. 3) The image consumes less memory when processed.

§ High  quality  interpolation.  On  crisp  images  this  improves  the  quality  between
transitions of colors, but for astronomical images, which are often oversampled, it
may not worth the time.

§ Camera  white  balance.  The  white  balance  is  corrected  using  fixed  coefficients
which depend on the camera model.

§ Software  white  balance.  The  white  balance  is  corrected  using  a  software
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algorithm.

DCRAW DSLR in Astroart is implemented as a special plug-in that is updated every
8-12 months. Check for updates at: www.msb-astroart.com/plug_en.htm.

4.1.7 Optimize JPEG

This command allows to evaluate the quality of a compressed JPEG before saving it.

Move the  slider  until  you  are  satisfied with  the  compromise  between quality  and
size of the image.

4.1.8 Print

This command prints the current image.

1. Input  a  name in  the  title  text  box  (default  is  the  path  and  name  of  the  current
image).

2. Select an orientation (portrait or landscape).

3. Select a scale (from 5% to 100%). At 100% the image will fit the whole page.

4.1.9 Language

This  command  changes  the  language  of  Astroart.  Full  support  is  available  for
English,  French,  German,  Italian  and  Spanish.  Please  check  the  Astroart  web  site
for upgrades.

4.1.10 Preferences

The Preferences Window  is  composed of  six  pages:  Options,  Stars,  Observer,  MPC
Report, Raw Images and Star atlas.

Options

http://www.msb-astroart.com/plug_en.htm
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Zoom.  Set  "Anti  alias"  to  enable  the  high  quality  drawing  of  the  image  when  it's
displayed  zoomed  out  (drawing  may  be  slower).  Set  "Zoom  with  Fit  to  image"  to
resize automatically the Image Window during zoom. See also: menu Window / Fit
To Image.

Big icons and fonts. Sets the size of icons in the main Astroart window and the size
of text in the status bar of the Image window, Local zoom and 3D window. 

Fractional alignment. Enables sub-pixel shifting during alignment (recommended).

Enable MMX/SSE/SSE2.  If  enabled, Astroart  will use the SSE CPU instructions to
process 4 pixels at a time.

Enable  Multithreading.  If  enabled,  Astroart  will  use  all  cores  of  your  CPU  to
process images.

Undo/Redo max. memory.  Sets the maximum memory in megabytes for the undo
buffers,  when  multiple  images  are  processed  at  the  same  time.  The  depth  of  the
undo  buffer  is  always  one,  but  there  can  be  many  buffers  when  working  on
different images.

Duplicate Image. Select these options (not recommended) to force the creation of a
new image as a result of every operation.

Value  Outside  the  Image.  Some  elaborations  needs  to  estimate  the  value  outside
the boundaries of the image: here you can specify the Outside constant.

Grid. Select the number of sections for the Grid. Fractional values are accepted, for
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example it's possible to enter the field of view in arcminutes (example: 15.8 x 10.3)
so that every sector will be exactly one arcminute.

Open  Images  and  Save  Images.  Select  here  the  default  folders  for  opening  and
saving images, or select the option to remember the last used folder.

JPEG Compression. Sets the quality of images saved as JPEG. Default = 10, a higher
value  produces  better  compression  and  lower  quality.  You  may  also  select  to
embed the North-East astrometric marker.

FITS  time  compensation.  (not  recommended).  If  your  FITS  files  have  a  wrong
Universal Time, you may correct them here adding a time offset in hours.

FITS convert unsigned data. (not recommended). 16 bit FITS images with negative
pixels  and BZERO = 0 will  be considered  unsigned.  Enable  it  only  to  import  old
images from incompatible software. When this option is enabled you won't be able
to open valid FITS files with negative pixels.

Stars

Photometry.  Select  the size  (in  pixels)  to  calculate  the  magnitude and position  of
stars.

§ Aperture. The diameter (in pixel) of the circle that should contains the star. Be
careful that in previous versions of Astroart this value was a radius, now it's a
diameter.

§ Gap. The width (in pixel) of the annulus that is ignored while calculating the sky
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background.

§ Background. The width (in pixel) of the annulus used to calculate the sky
background.

Draw ring when image is zoomed.  By default  the three rings above are drawn on
the image only when the the image is zoomed 200% or more. You may disable this
option to have them always drawn.

Iterative  background  calculation.  If  enabled  (recommended)  the  background  is
calculated  with  an iterative  algorithm which  removes  the  stars  and all  bad  pixels
from the annulus. If not enabled, the background is calculated as a simple median
of the pixels.

Star detector. Choose the minimum and maximum FWHM (in pixels) and Signal to
Noise ratio to detect the stars of the image. See also: Find stars.

Signal  to  noise  ratio.  These values are  used in  the  Stars  window to  calculate  the
S/N for every star.

Observer

Observatory  and  Instruments  data.  The  most  important  data  to  be  set  is  the
longitude and latitude of the observatory (decimal or sexagesimal coordinates, e.g. 
+44 12 59,  which is used for parallax calculation of minor planets) and the CCD
scale /  Angle which is used in Preprocessing for  the option "Follow minor planet"
(these  values  can  be  found  with  the  Statistics  Window  on  a  astrometrically
calibrated image). 
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All  the  other  data  (Origin,  Observer,  Diameter,  Focal,  etc.)  are  just  the  FITS
keywords  which  will  be  written  to  every  image  if  you  enable  one  of  the  options
below:

Imported  files.  (not  recommended)  These  options  work  only  when  you  open  a
non-FITS image in Astroart. They add Observatory or Instruments keywords to your
imported files.

FITS files. These options act on the FITS header when you save your images. 

The options "Add observatory keywords to header when save" and "Add instruments
keywords to header when save" can be used to update a set of your images which do
not  contain  the  observatory  and  instrument  keywords.  By  the  way  they  are  not
recommended, since your risk to add the keywords to images which were not taken
by you. 

The  option  Add  visualization  keyword  on  save,  writes  to  the  FITS  header  the
following  keywords.  When  Astroart  opens  an  image,  these  keywords  are  used  to
display the image.

§ AVISUMIN. The minimum threshold visualization value. 

§ AVISUMAX. The maximum threshold visualization value. 

§ AVISUTYP. The type of the transfer function.

The  option  "Add  polynomial  keywords  after  reduction"  (recommended)  writes  the
astrometric  (WCS)  and  photometric  keywords  when  a  calibrated  image  is  saved.
See Astrometry.

MPC report  

This page contains of a text box to be edited following the rules of the Minor Planet
Center,  see  also  the  MPC  Submission  Information  Page.  They  refer  to  the  MPC
80-columns  format,  which  is  still  accepted  despite  the  introduction  of  the  new
ADES format.

RAW Images

See the Menu File / Configure RAW for details.

Star Atlas

http://cfa-www.harvard.edu/iau/mpc.html
http://cfa-www.harvard.edu/iau/mpc.html
http://cfa-www.harvard.edu/iau/mpc.html
http://cfa-www.harvard.edu/iau/info/ObsDetails.html
http://cfa-www.harvard.edu/iau/info/ObsDetails.html
http://cfa-www.harvard.edu/iau/info/ObsDetails.html
http://cfa-www.harvard.edu/iau/info/ObsDetails.html
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Show. Select here which objects are to be shown in the atlas.

Coordinates.  Choose  between  coordinates  in  the  decimal  or  sexagesimal  format
(hours, minutes and seconds for Right Ascension and degrees, minutes and seconds
for Declination).

MPCOrb.dat,  CometEls.txt. To display comets and asteroids you need to download
these files almost every month. Write here the folder where they are saved. These
files  are  downloadable  at  the  MPC  site:
www.minorplanetcenter.net/iau/MPCORB.html,  click  "MPCORB.DAT"  and
"Comets".

Minor  planets  magnitude  max.  The  maximum  magnitude  is  related  to  the  stars
currently shown. If you are displaying stars up to 8.0 mag, then "+3.5" will let you
see asteroids  and comets  up to mag 11.5.  However,  you  can display  more  objects
clicking the button "More objects" in the Star atlas.

Catalog 1  and Catalog 2.  Astroart  supports two star catalogs at a time. Write here
the  folders  where  they  are  placed.  You  may  also  write  the  year  for  the  proper
motion  of  stars.  The  USNO-B  and  GAIA  DR2  are  available  only  as  internet
download. Astroart will query in background the stars of the required region from
the Vizier web server. For fast downloads it's better to limit the magnitude to 15-18.

4.2 Edit Menu

These commands allow to change some properties of images and macros.

http://www.minorplanetcenter.net/iau/MPCORB.html


23

4.2.1 Undo

This command cancels or restores the last elaboration. Press [F9] multiple times to
switch with the keyboard,  you may use this  trick to  compare the result  of  a  filter
with the original image.

4.2.2 Copy and Paste

Copy

Copies the active image to the Clipboard. If a rectangle or a mask is selected in the
image, then only this region will be copied. You may paste this image into Astroart
or into other graphic applications.

Paste

Pastes  an  image  from the  Clipboard  as  a  new image,  or  inside  the  current  image.
Three options are available:

§ As  new  image.  A  new  image  will  be  created  from  the  image  stored  in  the
Clipboard.

§ Into selection.  The clipboard image will be copied inside the selected rectangle
or mask.

§ Into image.  The clipboard image will be copied inside the current image, at the
X,Y  selected  coordinates,  using  a  given  opacity.  It's  also  possible  to  Add  or
Subtract  the  pixel  values  (ADU).  Hint:  If  the  clipboard  image  has  a  black
background  (zero  ADU),  then  the  Add  option  makes  it  equivalent  to  an  alpha
channel,  so  you  may  add  a  logo  to  the  image.  Logos  can  also  be  added  as
Annotations.

Empty Clipboard

Deletes the image stored in the Clipboard, to free the memory used.

4.2.3 Select

Selecting points and rectangles is a fundamental step to perform many elaborations
with Astroart. Points and Rectangles are usually selected with the mouse, however
with these commands you can select them with the keyboard.

§ Select point . [CTRL+P] Set the X and Y coordinates of the point that you want to
select. 

§ Select  rectangle.  [CTRL+R]  Set  the  X  and  Y  coordinates  of  two  points  that
defines a rectangular region.

Astroart will keep in memory the coordinates of the most recent selections, so that
they can be retrieved by the commands which need them.
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4.2.4 Select point

An image can have one more selected points, a cross marks their position.  

To select a point simply click with the left button. To select a point over a star press
[CTRL]  while  clicking.  You  may  also  select  a  point  in  the  Edit  Pixel  window
pressing [SPACE], or launching the command Edit / Select.

To  delete  a  point  click  on  it.  To delete  all  points  draw a  rectangle.  To  restore  all
points or copy them from another image, left click keeping [SHIFT] pressed.

4.2.5 Select rectangle

To select a rectangle press the left mouse button and draw a rectangle,  or use the
command Edit / Select. To enlarge or shrink the rectangle press CTRL + NUMPAD
PLUS or  MINUS.  To select  a  rectangle  in  the  middle  of  the  image  press  CTRL +
NUMPAD5.

Once  the  rectangle  is  selected  you  may  move  it  pressing  CTRL  +  arrow  keys,  or
CTRL + left mouse. The selected rectangle is not a mask for filters. Use masks for
this purpose.

4.2.6 FITS Header

This  command  opens  a  window for  reading  or  modifying  the  FITS  header  of  the
image.

Click the right mouse button to open a context menu with the following items:

§ Undo. Cancels all modifications.

§ Protect header. If selected (by default) it does not allow any modifications of the
essential keywords.

§ Insert from file. Inserts a text file into the header at the position of the cursor.

§ Export to file. Saves the header as a text file.

All the changes will be stored in memory when you close the window.
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4.2.7 Annotations

Annotations are figures and labels placed over the image.

Click "New" to create a new annotation. Write a text in the edit box, then select the
shape  of  the  figure  (select  "None"  if  you  want  only  a  text).  You  may  change  the
color  of  text  and  figure  clicking  the  square  buttons.  Click  the  arrow  buttons  to
change the selected annotation.

When an annotation is selected, it can be moved and resized using the mouse, and
all  its  parameters  can  be  changed  in  real  time.  To  move  with  the  keyboard  press
CTRL and arrow keys.

Annotations are saved as comments in the FITS Header, so the pixels below them
are never lost. Annotations are kept in a separated layer, so they don't influence any
filtering, analysis or visualization function of Astroart. 

A special annotation is the Logo, which is an image that can be placed everywhere
over  the  image.  Logo  images  must  be  placed  in  the  folder  Public
Documents\Astroart\Logos,  the  recommended format  is  PNG with  alpha  layer.  On
Windows 8 and 10 the path is: C:\Users\Public\Documents etc.

Copy/Paste

These commands are useful to copy an annotation to another image, or to duplicate
it  over the same image.  You may duplicate  an  annotation also  clicking  the  "New"
button.

Copy All

Copies all annotations to another image.

Hide Annotations

This command hides all annotations on all images. A button is also available on the
left toolbar. Hotkey: CTRL+SHIFT+A.

Coordinates
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These fields are useful to set with absolute precision the position and the size of the
annotation.

4.2.8 Pixels

Use this command to analyze or modify the pixels of the image.

The window has two working modes: Analyze+Edit and Paint. We suggest to open
a sample image and try all the following operations.

Analyzing and Editing with the keyboard

Arrow keys: moves the cursor. 

Shift+arrows:  moves the zone.

+ -:  zooms in and out.

0..9:  starts editing the current cell.

C, V:  copies and pastes.  S:  selects a point over the image.

Analyzing and Editing with the mouse

Left click:  selects the current cell.

Double left click: selects and enters edit mode.

Right click+drag:  moves the zone.

Rotate wheel:  changes visualization.

Wheel click+drag:  zooms in and out.

Painting with the mouse

Left click:  starts painting.

Right click:  picks the color from the grid.
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Right click+drag:  moves the zone.

Painting mode is enabled after clicking the brush button. The window changes and
new options become visible. Set a value used for painting (to pick a value with the
mouse right-click over a cell) and an optional noise. You may also change the brush
shape and its size.

4.2.9 Data Format

Astroart  supports  both  floating  point  and  integer  images.  Use  this  command  to
switch between these formats. 

Although 16 bit images created by astronomic cameras have a sufficient dynamic, it
could  be  convenient  to  manage  them  as  floating  point  to  avoid  quantization.  For
example,  imagine  a  division  by  two  and  then  a  multiplication  by  two,  where  the
pixel value is 1035.

INTEGER:  1035/2 = 517    ->  517*2 = 1034

FLOAT:    1035/2 = 517.5  ->  517.5*2 = 1035

Working with integers causes a quantization error of 1, in this case it is not a great
error, but in other cases (8 bit images for example) it may become a source of noise.
For this reason, all temporary processing in Astroart is always performed in floating
point.

4.2.10 Define Macro

A Macro is a list of commands which are executed in sequence.

1. Drag and drop or double click a command to add it to the list. 

2. A  dialog  box  will  ask  you  the  parameters  of  the  command.  If  you  click  Cancel
then the command will  be added without parameters,  they will  be asked every
time the macro executes.

3. In the Title text box, write a name for the macro: it will appear in the Edit menu. 

To  remove  one  command  in  the  list  click  it  with  the  right  mouse  button.  If  you
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execute  a  macro  that  require  two  images  (see  Arithmetic  menu),  then  the  second
image must be present in memory, otherwise a dialog box will ask if  you want  to
abort the macro or perform it with another image.

Use the Apply macro command to apply a macro on a series of images.

4.2.11 Apply Macro

This command executes a macro on a group of images.

1. Drag and drop the files you intend to process into the Images box.  To select all
files  of  the  same kind  (same  filter  for  example)  double  click  on  a  filename.  To
select all files press SPACE or  double click  with the right  mouse button o  drag
and drop an entire folder from the Input panel.

2. Select  a  name for  the  output  files  (Astroart  will  automatically  add a  counter  to
that  name)  and  choose  if  you  want  to  keep  them  in  memory  or  write  them  to
disk.

3. In the Macro  panel,  select  the macro to  be  applied,  or  select  "None"  if  you  just
need to rename of convert a group of images.

4.3 View Menu

These commands are related to the visualization of the image.
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4.3.1 Local  Zoom

This  command  displays  an  interactive  window  to  analyze  or  to  perform  aperture
photometry over the image.

Move the mouse pointer over the image window to select the region to be zoomed
(you can disable that selecting Lock 3D / zoom from the Image Context Menu). The
zoomed region can also be moved by:

1. Pressing the arrow keys on the keyboard, hold down [SHIFT] to move it faster.

2. Clicking the left mouse button on the zoomed region and dragging it.

Click the [+]  and [-]  buttons to  increase or  decrease the zoom factor  (default  2X).
The last button enables the auto-contrast, which is useful on low contrast parts of
the image. In the status bar it's also calculated:

§ The minimum and maximum pixel value in the window. 

§ B. The local background value.

§ M. The local averaged value. 

§ D. The local standard deviation . 

Context Menu

Pointer. Selects the shape of the pointer, with Circle and Annulus you can perform
the aperture photometry.

Palette. Displays the image in false colors.
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Create new image. Creates a new image from the zoomed area.

Copy to clipboard. Copies the zoomed area to the Clipboard.

4.3.2 Histogram

This  window is  used  to  change  the  visualization  of  the  image  and  to  inspect  the
image histogram.

The  histogram  of  a  digital  image  is  a  graph  that  shows  the  distribution  of  pixel
values. On the X-axis we have the pixel values, on the Y-axis we have the “count”
of pixels for each value.

The  upper  cursor  in  the  histogram  window  corresponds  to  the  maximum
visualization threshold, it controls the pixels which appear white. The lower cursor
corresponds  to  the  pixels  which  appear  black.  Pixel  in-between  are  displayed  as
shades of gray according to the current transfer function.   

§ BITS (15,14, etc.). These buttons change the scale of the X-axis.

§ LUM. Changes the visualization brightness.

§ CNT. Changes the contrast.

§ LOG (LIN, EXP). Changes the transfer function (or LUT, Look Up Table) which is
the narrow line on the histogram graph. 

§ EQU.  Histogram  equalization:  a  non-linear  transfer  function  which  forces  the
final picture to have all level of grays represented equally. It is used to show the
faintest parts of diffuse objects. The contrast is very high.

§ GAU. Gaussian equalization: It is useful to highlight structures in nebulosity (and
galaxies) while maintaining the natural appearance of an astronomical picture.

§ CURVES. Sets a custom curve for visualization. It's possible to set up to 4 control
points.
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§ VAL. Shows the ADU value at the position of the mouse pointer. In the CNT field
you can see the number of pixel with this particular ADU value.

Left click and drag left-right to move the histogram. Left click and drag up-down to
change the scale. 

Right  click  to  display  the  context  menu.  The  command  Histogram  stretch  (not
recommended)  modifies  the  image  according  the  current  visualization.  You  may
obtain the same result using the command Filter / Histogram stretch. The histogram
data can be saved as a list of values/counts into a text file. The transfer function can
be saved for future use or copied to another image.

4.3.3 3D

This window displays in 3D a region of the image.

Move the mouse pointer over the image to explore it  in 3D. To disable this  select
Lock 3D/Zoom from the Image context menu.

It's  possible  to  rotate the graph with the keys [PAG_UP] and [PAG_DOWN].  Press
[SHIFT]  to  rotate  the  image  faster.  Press  the  [Arrow keys]  to  move  the  region.  To
rotate  and pan using the mouse,  click  and drag.  Right  click  to  display  the  context
menu:

§ Angle, Step. Sets the visualization angle and its step during movements.

§ Palette. Changes the graph colors.

§ Save.  Saves the 3D graph as a BMP image. "Save sequence" saves a 360 degrees
animation, the number of frames will be 360 divided by current Step.

§ Copy to clipboard. Copies the graph into the clipboard.
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4.3.4 Stars

Displays a table which contains information about the selected stellar objects of the
image.

It's  possible  to  sort  the  list  clicking  the  buttons  at  the  top  of  the  table.  Fields
displayed are:

Field Description

N# A progressive number for the star.

Xc The X coordinate of the star centroid (pixels).

Yc The Y coordinate of the star centroid (pixels).

Adu The sum of the pixels of the star, corrected from background.

A "REF" states that the star is an astrometric reference, click it to change.

P "REF" states that the star is a photometric reference, click it to change.

RA° Right ascension of the star in decimal degrees.

DEC° Declination of the star in decimal degrees.

RA Right ascension of the star in hours, minutes and decimal seconds.

DEC Declination of the star in degrees, minutes and decimal seconds.

Mag Instrumental magnitude.

O-C Pos The difference between the observed and the calculated position of the
star.

O-C Mag The difference between the observed and the calculated magnitude of
the star.

FWHM x Full width at half maximum of the star along the x axis (in pixels).

FWHM y Full width at half maximum of the star along the y axis (in pixels).

S/N Signal to noise ratio of the star.

A-G-B Aperture, Gap, Background dimensions in pixels, which were used to
measure the star. See the photometry settings in Preferences.
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To collect stars from the image, left click when the mouse cursor is above a star and
become a circle.  This  means that  a  star  is  recognized and can be  collected.  If  the
star is not recognized then it's possible to force the acquisition pressing the [CTRL]
key  and  the  left  mouse  button.  Stars  can  also  be  collected  from  the  Local  Zoom
Window  pressing  [ENTER].  Use  the  command  Find  stars  to  automatically  collect
the stars of the image. 

When  some  stars  have  been  collected,  move  the  mouse  cursor  over  the  image:
when the pointer is over a recognized star, the relative row in the Star Window will
be highlighted.  Instead,  if  you click  on a  row of  the list  the corresponding star  in
the image will be marked with a blue cross.

Right click to display the Context menu.

§ Edit.  Allows to modify RA, DEC and MAG of a star. This procedure also makes
the star a reference for further astrometric or photometric reduction.

§ Delete. Deletes one or more stars from the list.  

§ Reset. Deletes RA,DEC and others calculated fields from the star.  

§ MPC report. Sends the current stellar object to the MPC Report.

§ Mark stars. If enabled, stars will be marked on the image with a small sign.  

§ Separation.  Calculates  the  separation  and  the  position  angle  between  two
objects. If the list contains more than two objects,  use CTRL+click to select the
second object.

§ Open, Save. Opens or saves to disk all stars as a text file. This file may be edited
with a text editor.

§ Copy. Copies the stars from another image of the same field (ADU and centroids
will be recalculated). This command is useful to select the same stars on different
images.

4.3.5 Statistics

This  command  calculates  several  statistical  data  about  the  image,  or  about  a
selected region of the image.
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Name and Path. The name of the file and its path in the file system.

Size. Rows and columns of the image or boundaries of the selected area.

Field  of  view.  This  is  a  very  important  information  to  calibrate  the  plate  solving
engine of the Find Coordinate window. In the example above the horizontal field of
view is 13.7 arcminutes. If possible, the rotation angle relative to the equatorial grid
will  be  shown  as  well.  All  this  data  is  only  shown  after  the  image  has  been
calibrated. See: Tools/Astrometry.

Pixels. Number of points of the image or points of the selected area.

Minimum and Maximum. Minimum and maximum values and their coordinates.

Background. A calculated value for the sky level.

Sum and Average. The sum of the pixels values, and the sum divided by number of
pixels.

Standard  deviation.  Gaussian  standard  deviation.  If  the  region  contains  no  stars
this is a measure of noise.

4.3.6 Profile

Use this command to plot an intensity profile (in ADU) along the X or the Y axis or
between two points.

X or Y profile 

Select a point of the image. Click menu View / Profile / X or Y.

Free profile

Click  the  Profile  Mode  button  in  the  left  toolbar  and  draw  a  line  over  the  image
(click  on  the  first  point,  keep  pressed  the  mouse  button  and  release  it  over  the
second point), or select two points then click menu View / Profile / Free.

Realtime profile

Once the graph is displayed, click the button "Change profile". Move the first or the
second point and the profile will change in realtime.
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The title of Profile Window shows the coordinates of the starting and ending point,
the  inclination  and  their  separation  (in  pixel  units)  where  L  =  length  and  A  =
Angle. If the image is astrometrically calibrated then the separation is also shown in
arcseconds and the angle is shown as position angle. To measure the separation and
the  position  angle  between  two  stellar  objects  it’s  better  to  use  the  command
Separation from the Stars Window.

It is possible to zoom in the graph drawing a rectangle from top-left to bottom-right.
To  zoom out,  draw a  rectangle  in  the  opposite  direction.  The  graph  itself  can  be
moved with the mouse keeping pressed the right button.

On the right side of the window there are some buttons. From the top:

1. Saves the graph as a TXT or BMP file.

2. Copies the graph to the Clipboard.

3. Prints the graph.

4. Changes the profile, for realtime analysis.

4.3.7 Grid

This  command displays  a  grid  over  all  images.  This  is  useful  when  centering  the
field during an image session, or to measure distances. The number of sectors and
the color can be set in the Preferences. The hotkey is CTRL+ENTER.
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4.3.8 Night Visualization

This command sets the Windows' system colors as shades of red. This is useful to
don’t disturb your eyes during an observing session.

4.3.9 Zoom

This command changes the visualization of the current image.  Select  the desired

zoom factor from the main menu or click the lens buttons on the toolbar (  ).

Hints 

Use the keys [ + ] and [ - ] on the numeric keypad to zoom in and out the image. To
zoom with the mouse: click the wheel,  move the mouse up or down, then release
the wheel.

4.3.10 Palette

A palette is the set of colors used to display the image, use this command to change
them.

Gray. Shades of gray, this is the default palette. Key: [F11].

Negative. Inverted shades of gray, often used for comparisons and printing. [F12].
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Saw tooth. Cyclic shades of gray, useful to reveal faint details or isophotes.

Rainbow,  Flame,  Jazz.  These  are  color  palettes  that  give  more  visual  information
than shades of gray.

Open palette. Opens a custom palette from disk. It is also possible to open a palette
double-clicking the palette bar on the right side of the Astroart desktop.

Palettes can be easily created with a text editor, example:

Astroart Palette File 

4 

0   10  0   0 

100 255 100 0 

200 40  120 255 

255 255 150

Where the first row is a text description, the second row shows how many entries
the file contains and the rest is palette data. 

Each row of data shows: Palette index, Red value, Green value, Blue value. [0..255].
Spaces  are  ignored,  missing  indexes  are  interpolated.  Index  0  and  255  can  be
omitted (default = [black,white]).

4.3.11 View Range

Changes the visualization of the active image. See also Transfer function.

To change quickly the visualization move the black and white cursors on the right
side of the Astroart desktop or turn the mouse wheel (click the wheel button while
turning the wheel to move the black cursor).

Every image is displayed according two visualization thresholds:  

1. Minimum  (black)  threshold.  Every  pixel  below  this  value  will  be  displayed
black. 

2. Maximum  (white)  threshold.  Every  pixel  above  this  value  will  be  displayed
white.

All the other values between the two thresholds will be displayed as shades of gray
according the current Transfer function. See also: Palette.

Options  

Auto. [F4] Astroart finds for you the best threshold values.

Min  ->  Max.  [F3]  The  black  threshold  is  set  at  the  minimum  pixel  value  of  the
image. The white threshold  is set at the maximum pixel value.

CCD range. [SHIFT]+[F3] The black threshold will be set to zero, white threshold
to the maximum value of the CCD image (usually 65536 or 255).

User Defined. You will be asked to input the minimum and maximum thresholds.
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Hints

Click  the  status  bar  of  the  image  window.  Astroart  will  sets  for  you  the  best
threshold values.

Press [PAG_UP] and [PAG_DOWN] to quickly modify the white threshold with the
keyboard. Press [SHIFT] + [PAG UP/DOWN] to modify the black threshold.

4.3.12 Transfer Function

Use this command to change the visualization of the of the image. See also: View
range.

A Transfer Function (also called lookup table  or  LUT) is  a  transformation used to
visualize  a  scientific  image.  In  Astroart  the  transfer  function  doesn't  modify  the
pixel values, it affects only the visualization on the monitor. This is a big difference
from classical image processing programs.

Linear.  A  straight  line  between  the  black  and  the  white  levels,  to  map  equal
changes in pixel values into equal changes in display levels.

Auto. Astroart finds for you the best transfer function for the active image. It is the
default transfer function when an image is loaded from disk.

Logarithmic. A logarithmic curve (convex or positively skewed) between the black
and the white levels. The contrast is highest at low levels and gradually decreases
toward  the  high  levels.  It  is  often  used  for  astronomical  images  to  enhance  faint
details near the sky background.

Exponential. A concave curve between the black and the white levels. This transfer
function accentuates contrast in the high levels at expense of the low levels. 

Equalized.  Sets  the  spacing  between  levels  proportional  to  the  height  of  the
histogram. This gives the highest contrast to the levels containing the most pixels.

Gauss  Equalized.  Similar  to  equalized,  but  more  “natural”  and  aesthetically
pleasing. It is indicated to highlight structures in galaxies and nebulas.

4.3.13 Equalize Visualization

This  command  displays  all  images  on  the  desktop  with  the  same  visualization
thresholds  and  transfer  function.  This  can  be  very  useful  to  compare  a  group  of
images of the same subject.

4.3.14 Blink

This command compares two or three images by showing them cyclically. Blinking
is used to search minor planets or supernovas.

Blinking two images
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1. Open two images of the same subject.

2. Click Blink 2 to display the blink window.

3. Change the  blinking  frequency  moving  the  scroll  bar.  If  needed,  click  the  auto

align  button  to  align  the  images  or  the  arrows  buttons   to

manually align them. The check button  keeps the final alignment when the

blink is stopped. Use the button   to switch the visualization from positive to
negative.

4. While  the  blink  is  active,  press  "+"  or  "-"  on  the  numeric  keypad  to  zoom,  or
press  the  arrow  keys  to  move.  Rotate  the  mouse  wheel  to  change  the
visualization. Click the "Save" button to create an animation.

Blinking three images

1. Open three images of the same subject.

2. Select the first image of the set, then click Blink 3.

3. Select  the  second  image  and  click  ok.  Repeat  for  the  third  image  to  start  the
blinker. 

4. Change the  blinking  frequency  moving  the  scroll  bar.  If  needed,  click  the  auto
align button to align the three images. If the auto align fails you will need to align
the set using the command Image / Align all.

4.4 Image Menu

These commands perform common elaborations on the active image.

4.4.1 Duplicate

This command duplicates the active image. The keyboard shortcut is [F2]

This  command  is  useful  when  you  need  a  copy  before  modifying  an  image.
Duplicates can be created automatically before all elaborations, see the paragraph:
Preferences.

4.4.2 Flip

Flips the active image along the vertical or horizontal axis (or both). This is useful if
the image comes from an optical system with an odd number of reflections.

Horizontal. The image is flipped along a vertical axis. [Shift] + [F5]
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Vertical. The image is flipped along a horizontal axis. [Shift] + [F6]

Both. The image is flipped along both axes, this is equivalent to a rotation of 180°.

4.4.3 Rotate

Rotates the active image.

90 , 180 , 270 and Angle. Creates a new image rotated of a given angle.

Center  and  Angle.  Rotates  the  image  and  preserve  the  image  size:  (you  will  lose
something at the corners). Set the X and Y coordinates of the center of rotation as
well as the angle. The default center of rotation is the Selected point.

4.4.4 Resize

This command creates a new resized image of the current one.

Interpolation

Bilinear.  Linear  interpolation,  it's  fast  and  preserves  all  scientific  content  of  the
image.

Gauss. Better for publication if you enlarge the image, keeps the scientific content.

Bicubic. Bicubic interpolation, sharper if you enlarge the image, but non-linear.

None. No interpolation, the enlarged pixels will appear as small squares.  

Scale and Size

The  size  of  the  new  image  can  be  entered  as  absolute  values  (x,y)  or  relative
percentage  (%).  It's  also  possible  to  select  from  common  CCD  cameras  with
rectangular pixels.

4.4.5 Crop

This  command  creates  a  new  image  from  a  selected  rectangle  or  a  mask  in  the
current image.

If a point is selected over the image, then the size of the region can be entered as
width and height.

4.4.6 Border

Adds,  cuts  or  overwrites  the  borders  of  the  active  image.  This  is  useful  when  an
image has a blank border or after image stacking.
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Select the task to perform: Add, Cut or Overwrite, then fill the text boxes with the
number  of  lines  to  modify.  With  the  options  Add  or  Cut  a  new  image  will  be
created. With Overwrite you must set a new value for the border.

4.4.7 Align

This command aligns two images using some reference points. 

The command Align all aligns all images opened in the Astroart desktop.

Methods

Star  pattern  (translation/rotation).  Astroart  analyzes  the  stars  on  both  images  to
calculate  the  shift,  rotation  and  scale  between  them.  This  is  the  recommended
option.  If  the  rotation  is  caused  by  meridian  flips,  so  it's  approx  180  degrees,
disable the option "Automatic settings" and set 180 as maximum rotation.

One  star.  You  need  to  select  a  star  before  executing  the  Align  command.  The
Radius must be larger than the maximum shift expected between the images.

Two stars. It works like the One star option but with two stars selected (they must
be as far as possible from each other).  This option shift and rotates, so it's  able to
align images taken with an altazimuthal mount.

Correlation.  Can  align  any  kind  of  images,  usually  it’s  used  for  the  moon.  Select
two points over two edges of the image, if possible the directions of the two edges
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(the tangent) should be orthogonal.

Planet.  This  option does  not  need any point  to  be  selected  over  the  image,  but  it
works only on planet images.

Spectrum. You need to select a rectangle around an absorption line, as explained in
the next figure:

Notes

About the methods "one star"  and "two  stars":  the  stars  can be  selected  inside  the
image that will be shifted or inside the image that is used as reference. 

If you are aligning a set of big images (more than 5000 pixels wide) and you get the
error "cannot align with these references" it's possible that stars are not recognized
because of their big size. To correct the problem increase the FWHM max parameter
in the Preferences to 15 or more. 

To align and sum a group of images use Preprocessing.

4.4.8 Shift

Shifts  the  current  image  by  Delta  X  along  the  X  axis  and  by  Delta  Y  along  the  Y
axis.

If  a  fractional  Delta  X  or  Delta  Y  is  entered  then  Astroart  calculates  a  linear
interpolation. The region of the image that remains uncovered after the translation
is padded with the Outside constant.

4.4.9 Rectangular To Polar

Transforms an image defined in rectangular coordinates (X = horizontal axis, Y =
vertical axis) into an image defined in polar coordinates (R = radius, A = azimuth
angle).
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1. Select the X and Y origin for the center of the polar system: (usually this is the
nucleus of a comet or a galaxy), the default value is the Selected point.

2. Select the maximum radius in pixel on which the calculation will be performed,
starting from the X and Y origin. 

3. Select a scale, in pixels per degrees. Default is 1 pixel/degree, this means that the
new image will be 360 pixels wide.

4.4.10 Polar To Rectangular

Transforms an image defined in polar coordinates (R = radius, A = azimuth angle)
into an image defined in rectangular coordinates (X = horizontal axis, Y = vertical
axis).

The origin of polar coordinates is the bottom row. The distance of every pixel from
this row (simply its Y coordinate) is the radius.

Set the maximum radius for the result  image. The size of  this  image will  be 2R x
2R. If R is less than the Y size of the original image you will lose some information
at the corners.

4.4.11 Coregister

This  command  aligns  two  images  which  are  shifted,  rotated  and  scaled.  If  the
images contain stars and their field of view is not too different, then the command
aligns automatically. If not, use the manual procedure.

Manual procedure

1. Select three points or three stars on the first image. 

2. Select the same three references, in the same order, over the second image. 

3. Click menu Image / Coregister 

Example

Suppose that there are 2 images, A and B on the Astroart desktop:  

If image A is active when Coregister is clicked then a new image C is created, and it
is a rotated/rescaled version of image A, but can be blinked with image B.  

If  B is  active then the new image C is  a  rotated/rescaled version of  B,  and can be
blinked with image A.
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4.4.12 Mosaic

This command combines two adjacent images to create a bigger one.

1. Select  a  reference  point  on  the  first  image  (the  brighter  pixel  of  a  star,  a  lunar
crater, etc.)  

2. Select the same point on the second image.  

3. Click menu Image > Mosaic. Now you may select the width and the height of the
faded  border  between  the  images  and  change  in  real  time  the  brightness  and
contrast of the two parts.

See also the Tutorial #8. 

4.4.13 Fill

Fills  a  region  with  a  constant  value  plus  a  gaussian  noise.  Before  executing  this
command, define a rectangle or a mask over the image.

§ Inside. Fills inside the selected rectangular region. 

§ Outside: Fills outside the selected region.

4.4.14 Isophotes

Transforms the active image into a graph of isophote curves.

Min and Max.  The minimum and maximum values allowed to draw the isophotes.

Step. The interval between each curve (in ADU).

Monochrome.  Draws  the  isophotes  with  a  single  ADU.  If  not  selected,  every
isophote is drawn with the ADU that they represent.  

Area.  This  command measures how many pixels  are  contained between Min and
Max and their sum. This is useful for photometry of diffuse objects. 

To  better  visualize  the  structure  of  the  isophotes,  try  a  logarithmic  scaling  before
applying this command to the image.
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4.4.15 Repair

This  command  replaces  a  column  (row)  with  the  average  of  adjacent  columns
(rows). This is useful if your camera has a damaged column or row.

4.4.16 Binning

Binning X and Y

Compresses  an  image  file  along  the  X-axis  (rows)  or  the  Y-axis,  useful  for
spectroscopy. Select a rectangular area over the image of the spectrum to limit the
filter to that area.

X Average. Each pixel will be replaced by the average of its row.

Y Average. Each pixel will be replaced by the average of its column.

X Median. Each pixel will be replaced by the median of its row.

Y Median. Each pixel will be replaced by the median of its column.

Binning Pixel

A new image will be created where four or nine pixels will be joined, reducing the
image size but keeping the scientific content of the image. This command increases
the dynamic  of  an  image  and it’s  very  useful  to  resize  a  8  bit  image  (JPEG,  BMP,
etc).

4.4.17 Normalize Background

This  command  acts  between  two  images  and  sets  the  background  value  of  the
active  image  equal  to  the  background  value  of  the  other,  multiplying  it  by  a
coefficient.

4.5 Filters Menu

These commands perform various filters on the image. To create a new image as a
result of every filter see Preferences. See also: Image Processing.

4.5.1 High Pass and Low Pass

The  high-pass  filter  emphasizes  the  details  of  the  image  by  enhancing  its  high
frequencies, however it may emphasize noise.

The  low-pass  filter  smoothes  the  image  by  attenuating  the  high  frequencies,
however it may reduce the image sharpness.
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Frequency. Controls the strength of the filter. Click the “lock” button to enable the
real time preview. 

High  Pass  Adaptive.  When  enabled,  the  image  sharpening  is  applied  only  on
important details of the image, skipping for example the sky background. Noise is
therefore reduced, and quality improves. This option is not linear,  so it  cannot be
used before astrometry or photometry.

Low Pass  Adaptive.  This  powerful  option  reduces  the  noise  of  an  image  without
blurring  the  details  and  without  losing  sharpness.  Try  this  filter  before  or  after  a
High-Pass to reduce noise. This option is non-linear. See also: Denoise.

Opacity. This is a further option to calibrate the strength of the filter. The result of
the filter will be averaged with the original image.

4.5.2 Gauss

This  command  performs  a  Gaussian  convolution.  The  Gaussian  curve  is  often
found in nature, for example profiles of stars spread by atmospheric turbulence are
very similar to a Gaussian curves. 

Set a value for the Sigma parameter: a large value will give a heavier blurring effect.
The  option  Opacity  controls  the  strength  of  the  filter,  it  can  be  used  to  obtain  a
“flou” effect.

4.5.3 Multiscale High pass

This filter is used to enhance details in planetary and moon images. It may be used
also on the subject of a deep sky image, after having masked the subject (to avoid
applying the filter to stars).
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At  first  enable  the  realtime  preview,  then  move  the  sliders  to  achieve  the  best
compromise  between  definition  and  noise.  Usually  the  first  two  values  ("high
frequency") are the most critical ones. Sometimes a deconvolution with a gaussian
kernel is useful before applying this filter.

4.5.4 Unsharp Mask

Unsharp masking is a special high-pass filter excellent for planetary images. At first
the  program  makes  a  gaussian  blurred  copy  of  the  image  then  this  copy  is
subtracted, enhancing all details of the image.

The formula is: I'(x,y) = I(x,y) + c * (I(x,y) - Gauss[I(x,y)])  

Where I(x,y) represents the original image and c is a multiplicative coefficient. 

The value I(x,y) - Gauss[I(x,y)]   may become negative,  it  is  truncated to
zero if adaptive is enabled. This may reduce dark halos.

4.5.5 DDP

The DDP (Digital  Development  Process)  gives  to  CCD images  an  aspect  similar  to
film  pictures.  It’s  very  useful  on  nebulas  and  galaxies.  On  grayscale  images  this
may be the first filter to be applied after Preprocessing. 

Procedure

1. Enable  the  real  time  preview  (“Lock”  button)  to  apply  the  filter  with  default
settings.

2. Set  "High pass"  options  to  zero,  and move  the  "Threshold"  slider  to  control  the
strength of the filter.
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3. If  the  image  is  too  dark  or  looks  saturated,  it  could  be  a  visualization  issue,  so
modify the visualization moving the cursors on the palette bar, on the right side
of the Astroart desktop.  

4. If needed, enable the "High pass" options to increase the definition.

5. If you feel that the image can be stretched further, repeat the filter.

This  filter  is  not  linear,  and  the  result  images  cannot  be  used  for  astrometry  and
photometry.

4.5.6 Histogram stretch

This filter improves the contrast of an image.

At first select a transfer function by clicking the Log, Equ, Gauss or Curves buttons.
Select a new range for the result image (default is 0..65535, e.g. 16 bits) then click "
Apply and continue". If needed, continue the procedure with another stretch.

To zoom the histogram, press the left mouse button on the graph and drag up/down
,  or  click  the  "BIT"  button.This  filter  works  with  masks,  but  the  realtime  preview
will be on the whole image.

4.5.7 Hot pixels

This filter finds and deletes "hot pixels",  which are bright isolated points over the
image caused by defects of the CCD or cosmic rays. This filter can also be applied
on RAW images with Bayer pattern (DSLR images).
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One pixel defect. This is the default option which corrects very well isolated pixels,
without modifying anything else in the image.

Group of pixels. This is a much stronger filter which can also correct “cold pixels”
and groups of bright pixels.

Bayer  matrix.  This  is  the  option  to  correct  raw  images  with  color  information
stored as Bayer matrix. Such raw image come from DSLR and color CCDs. Don’t use
the other two methods since they may interfere with the color information, which
is encoded as dithering.

To correct the hot pixels during Preprocessing:

§ On color CCDs enable the option "Hot pixel" inside the window Demosaic.

§ On grayscale CCDs add a filter Hot Pixels in the Preprocessing "Extra" options.

See also: Defect Map.

4.5.8 Denoise

This filter reduces the noise without blurring the details.

Procedure. Enable the real time preview, set the kernel to 1X (fast but low quality)
and move the Sigma slider until you have achieved the desired effect. Then set the
kernel to 2X or 5X and click OK. As shown in the image above, hot pixels are not
corrected.

4.5.9 Defect map

This command corrects all  bad pixels  of  an image using a  map as reference.  This
map is  a  special  image where  all  pixels  are  zero except  the  ones  which  represent
the defects.

To create  a  defect  map you may elaborate  a  dark frame,  deleting all  pixels  which
are  below  a  certain  value.  The  best  command  to  achieve  this  is  the  command
Clamp Minimum.

Example: Clamp Minimum 2000, 0  (All pixels below 2000 will be set to zero).

The Defect Map command will analyze the map before to proceed. If the map is not
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a true defect map (e.g. most pixels are not zero) then it will automatically create a
map considering the 0.5% brightest isolated pixels of the image. For this reason it's
possible  to  use  directly  a  dark  frame  as  a  Defect  Map.  Obviously,  this  option  is
slower and less precise.

4.5.10 Median

The median of a list of numbers is that value that after sorting the array is placed in
the middle. Selecting this value from a matrix around a pixel is an excellent way to
reject impulse noise without losing resolution. This kind of noise is usually caused
by cosmic rays or hot pixels. 

3 x 3 Matrix  

This is the most used size to reduce noise. A dialog box will ask you the strength of
the filter. If you select 100% then the filter always replaces the pixel, but the better
results  are  usually  obtained  with  strength  =  2-5%  where  only  the  brightest  and
isolated pixel are replaced. This filter is very useful to remove the hot pixels of the
image without blurring it.

N x N Matrix  

Uses  a  NxN  matrix  for  a  stronger  median  filter.  When  N  is  bigger  than  7,  stars
disappear from the image and you can isolate the background nebulosity.

Ring median  

Uses a ring around every pixel to calculate the median. It's  very useful  to  remove
the stars from an image. (for example to obtain a synthetic flat field).

4.5.11 Average

The average filter is a particular case of low pass filter. It replaces every pixel with
the average value of a matrix around it, producing a strong blurring of the image.

4.5.12 Scaled dark frame

This command corrects the thermal noise of an image by subtracting an optimized
thermal  frame  that  was  taken  at  a  different  temperature  or  different  integration
time.

Remember that: Thermal frame = Dark frame – Bias frame  

So,  for  precise  results,  the bias must  be subtracted from the  dark  frame and from
the  raw  image  before  executing  this  command.  If  the  bias  was  not  already
subtracted, follow this procedure:

1. Select the image and subtract the bias frame from it (menu Arithmetic / Subtract
),  or  subtract  a  constant  value  (the  average  value  of  the  bias  frame)  with  the
command Add offset.

2. Select  the dark frame and subtract  the same bias frame from it,  just  like  in  the
previous step. You have obtained the Thermal frame.
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3. Select again the image and execute the command Scaled dark frame.  When the
"Select window" appears, just select the thermal frame created at step 2.

4.5.13 Remove gradient

This filter corrects variations in sky background, using different methods:

Adaptive. This is the most effective method, it analyzes the image and choose the
best way to correct it. The option "Low pass" is useful to prevent halos around big
objects in the image. If there are no big objects you may decrease the value to 20-30
for finer corrections. If the image has a black or damaged border, remove it before
to proceed. 

Adaptive Divide should be used only on photometrically corrected images (the dark
frame  was  corrected).  In  all  other  cases  (processed  images,  JPEG  pictures,  etc.)
Adaptive Subtract  works better although it may require a white balance correction
after the filter.  

Linear. Corrects a sky background with a linear gradient.

Vignetting. Corrects vignetting. The vignetting must be centered in the image.

Linear+Vignetting.  Corrects both variations at once, and corrects vignetting when
it's not centered in the image. 

For example, using the N6824.fit demo image, verify that: 

Adaptive:  Corrects  well.   Vignetting:  Does  not  correct  since  it's  not  centered.  
Linear+Vignetting: Corrects well.  Linear: Does not correct but at least it centers the
vignetting.

"Points" method

In  this  method  the  control  points  are  selected  by  the  user.  Before  launching  the
filter select 10-40 points on the image, starting on the border of the image, always
clicking  on  zones  with  no  stars.  If  you  delete  some  points  you  can  recover  them
with  SHIFT+left  click.  With  SHIFT+click  it's  also  possible  to  copy  points  to
another image.

Enable the realtime preview (the Lock button) and move the Smooth slider to find
visually the best correction.  If  you feel  that the filter  is  over-correcting the image,
decrease  the  Opacity  value.  If  some  zones  are  not  corrected  well,  you  may  add
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further  points  there  (press  Preview  to  update).  The  option  "Create  flat  field"  will
show and create the synthetic flat field that is used by the filter.

4.5.14 Erosion & Dilation

Erosion filter is useful to reduce the width of stars, to simulate a sharper image. It
may  be  useful  after  a  resize  (for  example  200%)  to  produce  a  cosmetic
improvement of the image. 

Dilation  is  rarely  used,  it  has  no  applications  in  astronomy.  It  can  be  useful  to
enlarge a mask image.

4.5.15 Cosmetic filters

These filters correct some typical defects of astronomical pictures.

Compress  stars.  Reduces  the  diameter  of  stars  and/or  corrects  elongated  stars
caused by bad tracking.

 

Before executing the command you must select all stars using the command Tools /
Find  stars.  If  the  option  "Adaptive"  is  enabled  then  the  correction  is  stronger  on
wide stars and lighter on small stars.

Enable  the “Elongation”  option to correct  bad tracking,  then move  the  bar  to  find
out the correct angle.

Remove  stars.  This  filter  removes  all  selected  stars,  it’s  useful  for  photometry  of
comets.

Remove lines.  This filter remove satellites and airplanes tracks.  To select  the line
just  select  two  points  at  its  edges.  This  filter  is  smart  and  adaptive  so  it  will  not
delete stars and other details below the line. Sometimes it’s required to apply to it
two times.

Deinterlace. Removes the “venetian blind effect”, e.g. horizontal stripes caused by
interlaced CCDs.



53

4.5.16 Deblooming

The deblooming filter deletes bright stripes around saturated stars.

It's  very  important  to  select  a  correct  value  for  the  saturation  level.  Usually  this
value is 65535 for 16 bit cameras but if the dark frame was subtracted then the real
value  is  surely  lower.  Sometimes  a  value  lower  than  half  dynamic  gives  a  better
result (example: 30000 ADU for 16 bit cameras).

Remove blooming.  This is the most powerful filter, but you must click and select
by hand the stars you want to correct.

Reduce blooming. This filter is soft but it works automatically on all stars. If your
blooming is quite severe you may apply it two times. This filter is also an option (
Extra  Filter)  of  Preprocessing,  because  if  you  need  to  align  and  add  a  group  of
images it's better to apply the filter on every single image. 

4.5.17 Convolution

Spatial  convolution  is  an operation that  modifies  all  pixel  values  according  to  the
adjacent pixels. This command let you build your own convolution filters and save
them to disk.
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§ Get PSF. If a rectangle is selected around a star then a kernel is calculated from it.

§ Gauss. Makes a Gaussian kernel of a given sigma.  

§ Rotate. Rotates the matrix by 180°.

§ Level.  All  pixels  with  intensity  higher  than  level  will  not  be  processed,  this  is
useful to process only the sky background of the image.

§ Open. Loads a convolution matrix from disk.  

§ Save. Saves the matrix to disk, as a text file.

4.5.18 Deconvolution

This  command  performs  the  Richardson-Lucy,  Van  Cittert  or  Maximum  Entropy
restoration of  an  image.  They  are  iterative  algorithms that  can  correct  almost  any
blurring defects over the whole image.  

Procedure

The  most  important  thing  to  know  is  the  kernel  that  has  generated  the  blurring
effect. If you don't know it you can simply obtain one from a non-saturated star.

1. Select a rectangle around a star.  

2. Click Filters / Deconvolution and select one of the four filters listed below.

3. Click "Get PSF", the matrix will be filled with numeric values.

4. If needed, click "Level" to don't apply the deconvolution on the sky background.  
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5. Select the number of iterations.

Maximum Entropy 

This is the most powerful restoring algorithm. 

Select Cut sky background to ignore the background during the process and obtain
sharper images. The value used as background is the Low visualization threshold so
be sure  to  have  the  image  visualized  with  a  dark  sky.  Don't  use  option  to  restore
common images like film photos or astronomical images with variable background. 

During the iterations some logarithms are calculated, so this filter is not linear and
the restored image cannot be used to perform photometry.  

Richardson-Lucy

This  is  a  linear algorithm that  keeps the photometric characteristics  of  the  image,
but provides worse images. It was used to correct the blurred images of the Hubble
Space Telescope.  

Van Cittert

A linear filter sometimes useful on planets, but it  can be used only with guassian
kernels.

Wiener

A  linear  deconvolution  which  is  not  iterative.  Usually  it  produces  only  a  partial
restoration but is very fast. 

Tips and tricks

To  correct  a  bad  focus  blurring,  instead  of  getting  the  PSF  from  a  star,  try  to
synthesize a Gauss kernel clicking the "Gauss" button in the window Deconvolution.
 

To correct a bad tracking (elongated stars) try to build a kernel as a Row of ones like
the following examples:

0 0 0 0    0 0 0 0    0 0 0 0 

0 1 1 0    0 0 1 0    0 1 0 0 

0 0 0 0    0 0 1 0    0 0 1 0 

0 0 0 0    0 0 0 0    0 0 0 0 

These kernels correct  a  bad tracking,  three pixels  wide,  with  direction of  45°  and
22°  (There  is  a  tolerance  of  15  degrees  for  a  good  result).  Use  always  Maximum
Entropy. 

0 0 0 0 0    0 0 0 0 0 

0 0 0 1 0    0 0 0 1 0 
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0 0 2 0 0    0 1 4 1 0 

0 1 0 0 0    0 1 0 0 0 

0 0 0 0 0    0 0 0 0 0

If  the central value is brighter the result  image will have less artefacts.  To correct
both bad  focus  and bad  tracking  apply  deconvolution two times,  one for  tracking
(with row of ones) and one for focus (with Gauss PSF).  

How to obtain better images 

To reduce ringing around stars,  the background value of the image must be set to
near zero before deconvolution.  So,  use the command Add constant  to  remove it.
For example if the background is 1700 ADU, do a "Add offset" of -1700. 

If the deconvolution result is too “sharp” and crispy apply a light Low Pass filter or
decrease the iterations.

With  Maximum  Entropy,  10-20  iterations  are  usually  sufficient,  50  may  be  too
many.  Try this  procedure:  get  the  PSF from the  star  then quit  deconvolution (the
PSF kernel will be retained in memory). Apply a light low pass filter to the image,
then apply deconvolution using the same PSF kernel.

4.5.19 Contour

These are morphological filters used to detect contours.

Sobel

It can reveal fine structures in galaxy arms. It calculates two convolution matrices,
along the X and Y axes:

-1 -2 -1     -1  0  1

0  0  0      -2  0  2

1  2  1      -1  0  1 

This double convolution is used to process image. After this filter it may be
necessary to adjust the View range of the image, for example clicking the status bar
of the active image.  

Prewitt

Like  Sobel,  it  can  reveal  fine  structures  in  galaxy  arms.  It  calculates  two
convolution matrices, along the X and Y axes:

-1 -1 -1     -1  0  1 

0  0  0      -1  0  1 

1  1  1      -1  0  1

This double convolution is merged and used to process the image.

Freeman

It  is  also  called  a  circular  gradient  filter,  it  performs  eight  different  convolutions
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around each pixel to detect the direction of the contour.

Kirsch

Similar  to  Freeman,  it  performs  eight  convolutions  to  detect  the  direction  of  the
contour.

4.5.20 Gradient

Applies  the  gradient  operator,  which  gives  an  “emboss  effect”  to  the  image.  The
result is given by the formula:

I'(x,y)  =  I(x,y) - I(x-dx,y-dy)  

The result image will be displayed with a linear transfer function.

4.5.21 Comet

This command is used to analyze and enhance comet images.

Procedure

Before launching the filter select a point (or a "star")  on the nucleus  of  the comet.
The coordinates of the centroid will be shown in the "X" and "Y" boxes. Enable the
realtime preview (the "lock" button).

Radius.  Select  the  radius  in  pixels  for  the  zone to  be  processed.  You may enable
the option "Fade out border" for a smooth transition with the non-processed zone.

Algorithm.  Change the algorithm and find visually the best  one for  your  purpose.
You  may  enable  the  option  "Adjust  visualization"  to  adapt  in  realtime  the
visualization  to  the  new  algorithm.  In  any  case  you  can  change  the  visualization
and the zoom with the usual methods of the Image Window.

Coordinates.  Try  to  change the  X  and Y centroid.  Sometimes  a  small  change  can
reveal a hidden detail.

4.5.22 Larson-Sekanina

This  command  computes  the  radial  and  the  rotational  gradient  of  an  image.  It  is
used to enhance the faintest  details  of  bright objects,  which exhibits  symmetry of
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revolution (elliptical galaxies and comas of comets). This filter is very powerful to
reveal  inner  details  inside  the  coma  of  bright  comets  (like  jets  and  shells).  Other
information  is  available  in  the  chapter:  Image  Processing  /  The  Larson-Sekanina
filter.

Procedure

At first select the brighter pixel of the coma: this is probably the nearest pixel to the
false nucleus of the comet: a little red cross will appear on the selected pixel. Now
click menu Filters / Larson-Sekanina.

Delta  R.  Computes  the  radial  gradient.  This  value  is  intended  in  pixels  and
depends  on  the  resolution  of  the  image  (values  from  1  to  5  are  suggested).  This
parameter is very important to detect the radial brightness variations, like shells or
fountains.

Angle.  Computes  the  rotational  gradient,  centered  in  the  selected  pixel,  using  a
rotation  of  Angle  degrees  (values  from  1  to  20  degrees  are  suggested).  This
parameter  is  used  to  reveal  faint  straight  jets  departing  from  the  nucleus  of  the
comet. Be careful when interpreting the results obtained with this parameter: a too
large Alpha can produce false details, on the other hand, a small angle could not be
sufficient for the faintest structures.

Coordinates.  Once  the  realtime  preview  is  enabled,  try  to  change  the  X  and  Y
centroid: this could reveal an hidden detail.

4.6 Arithmetic Menu

These  commands  perform  various  operations  between  two  images  ("A"  and  "B"
operands). The formula is:

 A = f ( A, B )

If only one image is opened inside Astroart, then the second operand is simply the
image  itself.  If  three  or  more  images  are  opened  then  a  dialog  window  let  you
choose the second operand.

You  can  force  Astroart  to  create  a  new  image  as  a  result  of  every  operation.  See
Preferences.
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4.6.1 Add Image

Add an image to the active image. 

This command is used to sum aligned images and increase the signal to noise ratio.
After  the  sum  the  result  image  may  appear  bright,  in  this  case  regulate  the
visualization thresholds.

4.6.2 Subtract

Subtract an image from the active image.  

It  is  commonly  used  to  subtract  a  dark  frame  from  an  image,  or  to  analyze  the
difference between images containing variable stars, asteroids etc.

4.6.3 Divide

Divides  the  active  image  A(x,y)  from  another  image  B(x,y)  following  the
formula (for every pixel):

A(x,y) = A(x,y) / B(x,y) * c    

where c is the average value of image B. This command should be used to apply a
flat field to the current image, to correct vignetting, dust, etc.

4.6.4 Multiply

Multiplies  the  active  image  A(x,y)  by  another  image  B(x,y)  following  the
formula (for every pixel):

A(x,y) = A(x,y) * B(x,y) / c    

where  c  is  the  average  value  of  image  B.  This  command  It  is  rarely  used,  it  is
involved during certain image restoration algorithms.

4.6.5 Min

Calculates the minimum of two images.

In the result image every pixel will be replaced by the minimum value of the two
corresponding pixels in both images.

4.6.6 Max

Calculates the maximum of two images.

In the result image every pixel will be replaced by the maximum value of the two
corresponding pixels in both images.

4.6.7 Distance

Calculates the "distance" between two images, which is defined as:

DIST [A,B] = ABS [A(x,y) - B(x,y)]
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This command is useful to find the difference between two images.

4.6.8 Average

Calculates the weighted average of two images.

Inside  the  dialog  window  move  the  slider  to  change  in  realtime  the  weight  (in
percent) for each image.

4.6.9 Merge

This command combines two images.

Both  image  can  be  processed  with  two  constants,  then  the  final  combine  can  be
performed  by  one  of  the  following  functions:  Add,  Subtract,  Multiply,  Divide,
Minimum,  Maximum,  Distance,  Average.  Every  processing  step  is  calculated  in
floating point.

4.6.10 Formula

This  powerful  command  applies  a  formula  to  every  pixel  of  the  image.  Click  the
arrow buttons to experiment with some demo formulas.

For example: to add 20 to every pixel, simply write:

v = v + 20

All  standard  math  functions  are  supported:  sin(),  cos(),  tan(),  exp(),  ln(),  log10(),
log2(), sqr(), abs(), rnd(), sgn(), fix(), int(), round(), frac(), asin(), acos(), atan(), atan2
(,), sinh(), cosh(), tanh(), asinh(), acosh(), atanh(), clamp().

The if()  function  takes  three  parameters:  a  condition  and  two  possible  results.
Example: if(x > y, 7, 4) returns 7 if x is greater than y.

To set a different formula for every color plane, use the colon separator. Example:
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v : v : v*2  doubles the value of the blue channel (red : green : blue). 

Formulas can contain variables. Some of them depend on the position of the pixel.

x. The current x coordinate of the pixel.

y. The current y coordinate of the pixel.

r. Radius, the current distance from the center of the image.

a. Angle, the current angle from the center of the image.

v. The current pixel value.

v(,) The pixel at a given coordinates.

pi. 3.1415926535...

xc yc. The coordinates x and y from the center of the image.

dimx dimy. The size of the image.

vmin vmax vbkg. Minimum, maximum and background value of the image.

vismin vismax. Minimum and maximum visualization thresholds.

4.6.11 Add constant

This command adds a constant to every pixel of the image. To subtract a constant,
set a negative value. 

Formula:  A(x,y) = A(x,y) + c    

If some pixels become negative or higher than 65535, then the dynamic will exceed
the 16 bit numeric format and the FITS file will take double space on disk.

4.6.12 Pedestal

This is an obsolete command that like Add constant adds a constant to every pixel
of the image.  

However if some pixels become negative or bigger than 65535 then their value will
be wrapped around 65536. This makes this command reversible. Example:   

A(x,y) = 5 , B(x,y) = 7    A(x,y) – B(x,y) = 65534.

4.6.13 Multiply and Divide

Multiplies or divides every pixel of the image by a constant.

§ Divide. A'(x,y) = A(x,y) / c 

§ Multiply. A'(x,y) = A(x,y) * c
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4.6.14 Clamp

This command limits the minimum and maximum value of the image.

§ Minimum. Sets all pixels lower than "Value" to the "New value". 

§ Maximum. Sets all pixels higher than "Value" to the "New value".

4.6.15 Scale

Changes  the  value  of  each pixel  of  the  active  image  according  to  a  given  transfer
function.  

Scaling  (often  logarithmic)  was  widely  used  in  the  past  as  a  tool  for  better
visualization, now it should NOT be used for this purpose because it is possible to
obtain the same result  in real time working with the histogram, without changing
the pixel values. Scaling makes an image scientifically useless.

Options

Linear. I’(x,y)  = c * I(x,y)  The  maximum  value  of  A’(x,y)   will  be  the
normalization factor.  

Logarithmic. I’(x,y)  = c * Log(I(x,y)) where c is a given coefficient.

Exponential. I’(x,y)  = c * Exp(I(x,y)) where c is a given coefficient.  

Transfer  function.  I’(x,y)   =  f  (I(x,y))  where  f  is  the  current  visual
transfer function.

4.6.16 Image -> FFT

Calculates the Fourier Transform of an image. 

The  Fourier  transform  is  a  representation  of  the  image  in  the  frequency  domain.
The low frequencies are displayed in the bottom part of the image. Every frequency
is expressed as a complex number in the form X , iY.  See: Tutorial #4.

An  image  may  have  a  periodic  noise,  such  as  stripes,  introduced  during  the
digitization process. In the frequency domain, this periodic pattern is transformed
to a few pixels.
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In  the  example  above,  the  periodic  noise  in  (1)  becomes  a  few  pixels  in  the  FFT
image  (2).  Once these  pixels  have  been  deleted  with  the  Edit  Pixels  window,  the
inverse FFT transform creates an image where the noise has disappeared (3), while
the overall features remain.

4.6.17 FFT -> Image

Calculates  the  Inverse  Fourier  Transform  of  an  image.  This  command  is  required
after a FFT to bring back the image to the spatial domain.

4.7 Color Menu

These commands are related to the color information of the image.

4.7.1 Saturation

Modifies in real time the saturation and the hue.

A saturation of zero will convert the image to gray tones, however the best method
to obtain this result is the command Split Luminance.

When the option “Skip background” is enabled, the sky background of the image is
not  processed,  to  reduce  the  noise.  Two  numbers  define  a  range  for  the  sky
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background:  all  values  below  V1  are  not  processed,  all  values  above  V2  are
processed,  all  values  between  V1  and  V2  are  partially  processed  by  linear
interpolation.

4.7.2 Color balance

This command adjusts the colors of an image, with preview in real time.

The upper sliders control the brightness of a channel (red,  green, blue),  adding or
subtracting a constant to every pixel. The sliders control the contrast, multiplying a
constant. 

It's  possible  to  move  and  zoom  the  histogram  clicking  the  left  mouse  button  and
dragging.  A  good  color  balancing  is  usually  achieved  when  the  three  histograms
have the same shape and position.

4.7.3 Color curves

This command modifies in real time the color tones.

Click the buttons “+” and “-“ to change the number of control points. Left click and
drag  to  zoom or  move  each histogram.  The  whole  window can also  be  resized  in
real time.
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4.7.4 White balance

White balance adjusts the colors the image to achieve a neutral color cast. 

For  classical  8  bit  images  and video cameras,  only  three  parameters  are  required,
the multiplicative coefficients for red, green and blue. For 16 bit images and DSLR
RAW  images,  they  don't  suffice  because  a  strong  bias  is  usually  present,  so  the
black level is not zero and bias must be subtracted.

In the image above, the dynamic range is approx 7000 ADU, but the black level (the
bias) is approx 2000 ADU and it's  also slightly different for every color plane. For
this reason it's required to set other three coefficients, the bias levels for red, green
and blue.

Inside the White Balance window, these six coefficients can be set by the user, or
calculated  by  Astroart  using  several  algorithms.  Try  the  algorithms  on  a  daytime
image with real time preview:

§ Average. This is the classical "gray world" algorithm, which gives good results in
most cases.

§ Adaptive.  It  can  be  useful  if  an  image  contains  a  wide  object  with  a  very
saturated color.

§ Histogram.  The  coefficients  are  calculated  via  histogram  equalization.  It's  used
rarely.

§ White point. The white balance is calculated analyzing the brightest parts of the
image.

4.7.5 Reduce color fringes

This filter attenuates the orange/blue color fringes which are caused by: imperfect
trichromy, DSLR demosaic, lenses.
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At first execute the filter with Cell = 3. If the correction is not sufficient, increase
the cell size.

4.7.6 RGB demosaic

This command creates a color image from a RAW image with Bayer pattern (DSLR
cameras and RGB CCD cameras).

1)  Original  RAW  image.  2)  Demosaic  with  1x1  Bilinear,  where  some  residual
dithering  and  color  fringes  are  still  visible.  3)  Demosaic  with  1x1  Four  gradients
where some color fringes are still a bit  visible (they can be corrected enabling the
option "Reduce color fringes").

Please  note  that  on  astronomy  images  these  defects  are  less  visible,  since  the
original image is probably oversampled. So the Bilinear algorithm may be the best
choice,  because it's  the only one that  preserve the scientific  content of  the image.
The  other  algorithms  are  not  linear,  so  astrometry  and  photometry  will  not  be
possible on the result image.

To demosaic a DSLR image (.cr2, .nef, etc.) the image must be opened as true RAW,
so don't enable the automatic demosaic in Configure RAW.

Pattern

Select here the correct pattern for you camera. Astroart  suggest the most probable
one.
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Algorithm

Binning 2x2. Four pixels will be summed into one, increasing the dynamic. This is
an interesting option since it has four important advantages: 1) On most images you
don’t  lose  any  information  since  multi-megapixels  images  are  often  heavily
oversampled. 2) Hot pixels remain single pixels, so they still can be corrected later.
3)  The  image  consumes  less  memory  when  processed.  4)  It's  linear,  so  you  can
perform astrometry and photometry.

Bilinear 1x1. This is the standard algorithm if you are working with a camera with
less than 15 megapixels so that Binning 2x2 is less appealing. The color image will
have  some  residual  dithering,  but  it  will  be  possible  to  perform  astrometry  and
photometry.

Two and Four gradients 1x1. These are non-linear algorithms which will not cause
any residual dithering. Four gradients is more powerful (but slower) and it's able to
correct partially the color fringes. Please note that the preview is performed always
in binning 2x2.

Channels. These options let you extract a single color channel. It's a useful option
for photometry. You may obtain the same result also setting "Binning 2x2", "None"
for white balance and zero saturation.

Saturation. Select here the extra saturation to be applied to the result image. 20-40
is recommended.

Hot  pixels.  The  strength  of  the  Hot  pixels  filter  applied  during  the  demosaic.  (It
will not be used during the preview).

White balance

See the documentation about  White  balance.  You may also choose "User  defined"
and set your own R,G,B coefficients.

Post processing

Select here which filters are to be executed automatically after the demosaic.

4.7.7 CMY demosaic

This commands creates a color image from a RAW image made with a CMYG (cyan,
magenta, yellow, green) CCD camera.

XY Offset. In the Image panel you will see the pattern of the current image. In the
other panel you must obtain the same pattern, changing the X and Y offsets.

1x1.  This  is  the  default  option,  select  if  for:  Meade  DSI,  DSI  II,  Starlight-Xpress
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M7C, M5C hires.

1x1 filtered. Similar to the previous option, but it provides stronger saturation. This
option can also synthesize Starlight-Xpress images taken with the vertical low pass
filter.

2x2. Images taken with vertical binning (example: M5C 500x290 pixels).

Options

High Pass. Optimized high pass filter for the luminance of the image.

Deinterlace. Removes the “venetian blind effect”, e.g. horizontal stripes caused by
interlaced download.

Hot pixels. Applies the Hot pixels filter during the synthesis.

Low pass. Reduces noise in the colors but slightly blurs the image.

Color curves. Opens the Color Curves window after the synthesis.

Color balance. Opens the Color Balance window after the synthesis.

Anti-Alias.  Reduces  the  false  colors  caused  by  sharp  edges,  but  also  reduces  the
saturation of the colors.

4.7.8 Trichromy

Tri-color imaging is an easy task with Astroart. Once you have taken three images
of  the  same  object  with  the  red,  green  and  blue  filter,  (or  cyan,  magenta  and
yellow), follow this procedure to create a color image:

1. Click the "Red" button and select your red image. Repeat for "Green" and "Blue".

2. If  you  need  to  align  the  images  click  the  "Automatic"  button,  or  click  the
"Manual" button to align with the arrow buttons.  Another solution is to use the
menu  command  "Image  /  Align  all"  before  launching  the  trichromy.  To  zoom,
click  the  image  then  use  a  keyboard  or  mouse  command  as  described  in  the
Image Window.

3. Select  a  white  balance  algorithm  (see:  Color  /  White  balance)  or  select  "User
Defined"  to  enter  your  own  coefficients.  To  emulate  the  result  of  Astroart  5,
select Algorithm = None and Bias = RGB.

4. If  needed,  select  a  post-processing  filter  to  be  applied  automatically  after  the
trichromy.
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4.7.9 LRGB combine

This  command  changes  the  luminance  of  a  color  image  using  the  one  of  another
grayscale image. 

In color imaging the luminance is the most important parameter and gives details to
the  final  image.  The  single  frames  R,  G  and  B  give  only  color  information,  this
means  that  noise  or  blurring  in  the  R,G,B  frames  can  be  corrected  replacing  the
luminance with a high quality grayscale image.

Procedure

1. The LRGB combine can be considered the last step before publishing. So, at first
process the Luminance image applying the filters needed and visualize it with a
pleasing transfer function.

2. Perform a standard trichromy with the R,G,B images to  obtain a  color  image.  If
needed,  improve  this  image  using  the  filters  Denoise,  Low  Pass  adaptive,  Hot
pixels, etc. and visualize it with a pleasing transfer function.

3. Align  the  color  image  to  the  luminance  image,  using  the  command  Align  or
Coregister.

4. Select  the  color  image,  click  "LRGB Combine"  and  select  the  luminance  image.
The color image will be modified with the new luminance.

4.7.10 Split (RGB, CMY, Channel)

This command separates a color image into one or three gray tones images which
represents a primary color of the original image.

4.8 Mask Menu

Masks  are  used  to  analyze  a  part  of  the  image  (see:  Statistics)  or  to  apply  a  filter
only  on  that  part.  Masks  can  be  created  using  a  Formula  (for  example:  all  pixels
below a constant) or using the mouse, just like in graphic programs.

Once a mask is created, you may smooth its boundaries ("feather mask"), invert it,
or copy it to other images.

4.8.1 Create

These tools create a mask using the mouse. To create a mask using a math function
click "Formula".
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Tools

§ Rectangle. Click and drag to draw a rectangle over the image. Press CTRL to force
a Square.

§ Ellipse. Click and drag to draw an ellipse over the image. Press CTRL to force a
Circle.

§ Path. Click to start the path, then left-click to add other segments. To finish, right
click or double-click the left button.

§ Brush. Select the shape of the brush, its size, then click and drag to draw a mask
over the image.

§ Fill. Select the tolerance then click to select the mask by "flood fill". For example,
if the pixel under the mouse pointer has an ADU value of 850 and the tolerance
is 20, all connected pixels between 830 and 870 will be selected.

§ Move.  Moves  the  current  mask,  using  the  mouse.  Click  the  arrow  buttons  for
precise one-pixel movements.

Mode

§ Replace.  When  a  new  mask  is  selected  the  current  one  is  deleted.  This  is  the
default mode.

§ Add. A new mask extends the previous one. This can be useful to select several
parts of the image.

§ Subtract.  The  new  mask  is  subtracted  from  the  current  one.  This  is  useful  to
create holes in the mask.

§ Intersect. The new mask and the current one are intersected, the resulting mask
contains all pixels of the new mask that also belong to the old mask.

Click the button "Smooth" to soften the mask edges.

4.8.2 Undo/Redo

This command restores the previous mask. It's not related with the Undo of image
processing,  so  that  you  can switch the  latest  two  masks  and  the  latest  two  image
processing steps independently.
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4.8.3 Invert

This command inverts the mask, e.g. the parts of the image which are not selected
now become the ones selected.

4.8.4 Smooth

This  command  smoothes  the  edges  of  a  mask  ("feather  mask").  It's  strongly
recommended before applying a cosmetic filter. If needed it can be applied several
times on the same mask.

The Truncate parameter is useful to delete mask values close to zero.  The default
value is 0.001, but if you are working with 8 bit images you may increase it to 0.04
(e.g. 1/255).

4.8.5 Formula

This command creates a mask using a formula. For example, " v > 100 and v <
5000  "  will  create  a  mask over those pixels  with an ADU value between 100 and
5000.

The variable "v" is the ADU value of the pixel. The variable "m" is the mask value
(from  0  to  1,  where  1  means  full  mask).  For  more  information  about  the  other
variables and the functions available, see Arithmetic / Formula.

4.8.6 Open/Save/Copy

These  commands  save  or  open  the  mask  layer  as  a  grayscale  PNG  image.  It  also
possible to Copy and Paste the mask into the Clipboard.
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4.8.7 Mask<>Image

Mask to image

The mask is transformed into a grayscale image with 16 bit dynamic. You may then
apply a filter over the image, then transform the image back to the mask.

Image to mask

This command create a mask from a grayscale image with 8 or 16 bit dynamic.

4.8.8 Show

Controls how the mask is displayed on screen.

1) Show selection. Displays the "marching ants" border around the current mask. 

2) Show layer. Displays the part of the image which is masked as shades of red.

3) Show transparency.  Displays  the  part  of  the  image  which  is  masked  as  a  grid,
just like in graphic programs.

4.9 Tools Menu

4.9.1 Star Atlas

The Star Atlas is a used to display the position of stars, minor planets and deep sky
objects  and  to  perform  the  astrometric  calibration.  Left  click  to  get  information
about an object with the Visibility window. Right click for the context menu, which
has commands for centering the map and to connect with the Aladin web site.

The star atlas can use two star catalogs at a time, to configure them see: Preferences
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1) Time.  Click  here  to  display  the  second panel  where  you  can  move  the  time  or
work in altazimuth mode.

2) Find. Opens the Find window to search for a minor planet or deepsky object.

Click  the  button  "Get  from  image"  to  read  the  object  coordinates  from  the  FITS
header of the current image. Some names (e.g. HALLEY, SPACEWATCH, TEMPEL)
exist both as asteroids and comets, to force a comet write "C TEMPEL" or "COMET
TEMPEL"). You may also write the name as "1P" or "C/1995 O1" or "CJ95O010". The
Find window  also allows to change the current time and to get it  from the current
image.

3) Show. Click these buttons to display deepsky objects, planets, minor planets and
labels.  Remember  that  minor  planets  require  an  updated  MPCORB  file,  see:
Preferences.

4) Lines.  These  buttons  show  constellations,  equatorial  grid,  ecliptic  and  milky
way.

5) Brightness. Changes the brightness of the stars.

6) Objects. Increases or decreases the number of objects displayed.
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7) Zooms the chart.

8) Rotates or Flips the chart.

9)  Astrometry. Manual and automatic reference stars. See astrometry.

10)  Altazimuth.  These buttons  set  the  map in  altazimuth  mode with  horizon and
meridian.

11) Time. These buttons set the time or move by a given interval.

4.9.2 Star atlas (visibility)

This  window  shows  the  visibility  of  the  selected  object  (left  click  on  object  to
show).

Click the "1", "7", "30" buttons to change the date. The graph also shows the moon
phase and the distance of the moon from the object, in degrees. If you enable the
option "Show always" then the object will be always shown in the star atlas,
regardless the zoom level.

4.9.3 Preprocessing

Preprocessing is the first elaboration that is performed when a group of  images of
the  same  subject  are  taken  from  an  astronomic  camera.  It  consists  in  three  main
steps:

1. Calibrating with dark frames and flat fields.

2. Aligning the images using some references.
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3. Combining i.e. adding or averaging all images to improve the quality.

Preprocessing on multi-megapixels images may require a lot of RAM. On Windows
64 bit you may use the appropriate version of Astroart.

Files

Select here the files to be used. There are four boxes where you can put your files
(Images, Dark frames, Flat fields, Dark frames of Flat field). 

To  select  all  files  of  the  same  kind  (for  example  M63-001-R,  M63-002-R,
M63-003-R, etc) just double click on a filename. To put some files in a certain box
drag & drop from the file list or the folder list. You may also drag & drop from the
folders of Windows or other file managers like Total Commander.

To select multiple files at once press [SHIFT] or [CTRL] then left click, or click the
right  mouse  button.  To select  all  files  press  SPACE,  or  drag  the  folder,  or  double
click with the right mouse button. To delete one or more files from the destination
boxes right click or press [DEL].

Add,  Average,  Sigma  or  Median.  Select  how  to  build  the  final  image.  Add  and
average are best methods in terms of S/N ratio. Add should be preferred on 8 bits
images. Sigma is the best method to reject hot pixels if  you don't  correct  the dark
frame, but it  requires more memory and it's  not  recommended for  astrometry and
photometry. Median is rarely used.

Scaled dark frame. See the menu command Filter / Scaled dark frame. As bias, you
may use one or more bias images or just a constant value (ADU).



76

Defect  map correction.  See  the  menu command Filter  /  Defect  map.  Put  here  the
defect map image.

About  bias  frames.  Bias  frames  are  never  needed  if  you  correct  the  dark  frame
(because the bias is included in the dark frame), however if your camera has a very
low  thermal  current  and  you  want  to  use  bias  frames  as  dark  frames  then  place
them in the "dark frames" box.

Alignment 

Auto  alignment.  Enables  the  automatic  alignment.  (see  Align  for  more  details).  If
the  alignment  method  needs  some  reference  points  (e.g.  Correlation)  it's  better  to
open the  first  image  of  the  sequence and select  with  the  mouse  the  reference.  Its
coordinates  will  be  kept  in  memory  and  you  will  have  simply  to  confirm  them.
Remember that to align a sequence of DSLR RAW images, the option "Demosaic" is
mandatory (unless the automatic "Demosaic on load" is enabled in the Preferences,
which is not recommended).

Follow minor planet. If enabled, an extra offset is added to the auto alignment, to
track a minor planet.  The required parameters are the motion of the minor planet
(which can be calculated clicking "Find" if you have an updated MPCORB file) and
the  scale  and  the  orientation  of  the  CCD,  which  is  an  option  of  the  observatory.
This option is also required for astrometry or photometry of a moving object.

Copy missing borders.  If  enabled,  the borders of  the image which  are  lost  by  the
alignment  will  be  copied  from  other  images.  This  attenuates  dark  borders  in  the
final image. This option works only if there is no rotation between the images.

Manual alignment. Select this option if you want to align all images by hand. Every
image will be opened and zoomed, and using the mouse or the keyboard, you will
be able to track a reference object. You may enable the option "Multithreading" so
that while you align the current image Astroart prepares the following one.
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Options

Demosaic. This option is required to align and add raw images from color cameras.
Every  image  will  be  demosaiced  before  being  aligned  (e.g.  shifted),  since  it's  not
possible  to  shift  a  raw  image  with  a  Bayer  matrix  on  it.  To  find  the  correct
parameters  for  your  camera,  you  should  perform  at  least  one  manual  Color  /
Demosaic on a sample image: the realtime preview will reveal the best parameters. 

Normalize  background.  The  Sigma  and  Median  algorithms  work  best  if  the  sky
background  is  constant  in  the  set.  This  option  is  used  when  your  images  have  a



78

different background value, which can happen with light pollution or clouds. The
"Add"  method  adds  a  constant  to  the  images,  this  is  recommended  for  correcting
light  pollution  or  clouds.  The  "Multiply"  method  multiplies  all  images  with  a
constant, this is recommended to stack images with a different exposure time or for
creating  a  master  flat  field.  The  "Scale"  method  both  adds  and  multiplies,  so  it
equalizes the dynamic of the images. 

Confirm all images. Select this option if you want to follow the preprocessing step
by step and discard some images from the final result. For maximum speed, use the
keyboard during the selection: press ESC to discard or ENTER to accept.

Save  all  images.  Every  temporary  image  will  be  saved  with  a  "_P"  postfix.  The
folder can be set in the following section.  

Keep  all  images  open.  (Not  recommended)  every  temporary  image  will  be  kept
opened in the Astroart desktop. Requires much memory.

Multithreading  (assembly  line).  While  an  image  is  processed,  Astroart  opens  the
next image and starts processing it. This doubles the memory requirement.

Reject bad images. Enable this option to discard bad images from the final result.

§ Stars  elongation.  Discards  images  with  bad  tracking.  The  value  means  the  ratio
between  the  long  and  the  short  axis  of  the  stars.  Example:  1.2  means  that  all
images with stars 20% bigger along an axis will be discarded.

§ Stars  FWHM  max.  Discards  images  with  bad  focus,  where  stars  have  a  radius
bigger than the selected value.

§ Planet  sharpness.  For  planetary  and  moon  images  only.  85%  means  that  every
100  images  85  will  be  kept  and  15  discarded.  If  the  seeing  was  very  bad,  then
50% or less should be used.

Filters.  Here  you  can  get  some  filters  from  the  “Available”  box  and  drag  &  drop
them into the “Apply” list. Select also if they are to be performed before or after the
flat/dark correction. For example,  if  you don't  correct  the dark frame then the Hot
pixels filter is recommended.

Extra
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Temporary  folder.  The  folder  used  to  store  temporary  data  when  the  memory
available is low.

Resize.  Resizes  all  images  after  the  dark/flat  calibration,  but  before  aligning  and
combining them.

Drizzle  200%.  Doubles  the  size  of  all  images  to  increase  the  resolution  IF  THE
IMAGES  ARE  UNDERSAMPLED.  You  can  easily  recognize  an  astronomical
undersampled image: its stars are 1 - 2 pixels wide, they look like hot pixels. For a
good  result  the  images  must  not  be  aligned  and  a  minimum  of  20  images  is
required. 

With  modern  multi-megapixels  cameras  it's  almost  impossible  to  get  an
undersampled image, so drizzle is often not useful.

Cut borders. It's used to cut lateral rows or columns from imperfect CCDs.

See also Tutorial #5, Tutorial #6, Tutorial #7.

4.9.4 Text Editor

This command executes a fast text editor inside Astroart. Right click to display the
context menu to save or print your document.

4.9.5 MPC Report

This command open a special Text editor to write a "80-columns" MPC report. This
format is still valid, despite the release of the new "ADES" format.

Usage

1. If needed, setup the MPC header in the Preferences window.  

2. Click Tools / MPC Report.  

3. After  the  astrometric  calibration,  for  every  object  in  the  image  or  in  the  Stars
window right click to display the context menu and select MPC Report.

4. Check the values in the MPC Dialog Window and click OK: a new record will be
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added to the MPC report.

The  report  must  be  written  following  the  rules  of  the  Minor  Planet  Center,  see
http://cfa-www.harvard.edu/iau/ for details.

4.9.6 Find Coordinates

This  command ("plate  solving")  automatically finds  the  center  plate  (RA and DEC
coordinates of the center of the image). This command can be called by scripts to
automatically center the telescope after a long GOTO. See: Scripts.

Search region. In the first section you need to set the approximate coordinate of the
field (or the name of the object, e.g. NGC 4565), and the size of the search rectangle.
The default  is  4x3 degrees or  2x2 degrees  if  the  function is  used  by scripts.  Note
that an unnecessary large region increases the chance of false positives if  you use
only 4 stars as reference.

Image.  The  second  section  is  the  most  important.  You  need  to  set  the  horizontal
field  of  view  of  the  image,  in  arcminutes.  For  example,  the  default  value  is  13.5
+10% which means that every image from 12 to 15 arcminutes will be recognized.

The first time you use the Astroart plate solve write an estimated field of view and
a tolerance of 20-50%. Then if plate solve succeeds, open the Statistics window to
discover the exact value of the field of view and copy it in the Horizontal field, then
decrease  the  error  tolerance  to  +-  2%.  This  will  speed  up  the  following  searches
and will prevent false matches.

The last field is the maximum rotation of the camera relative to the equatorial axes.
The default value is +-180 which means that all rotation will be recognized. If you
mount your camera straight with the equatorial coordinates you may decrease this
value  to  20-30  degrees,  this  will  speed  up  the  search  and  most  important  it  will
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help to avoid false matches.

If the image is flipped remember to  enable the option "vertical  flip"  otherwise the
procedure will fail. If your camera has rectangular pixels, set the pixel aspect ratio
(width / height). For example, the MX9 camera has pixels of 11.6 x 11.2 microns, so
the aspect ratio is 1.04.

Reference  stars.  The  number  of  stars  to  be  matched  for  a  valid  result.  The
recommended  value  is  "5"  stars.   4  stars  can  be  used  in  sky  areas  with  few  stars
(example: high galactic latitude) but the error tolerance must be set to 5% or less (or
the maximum rotation to 10° or less) otherwise false positives may be found.

Example

Using the  M67 demo image,  set  “M 67”  as  center,  “13.5”  as  field,  “20%”  as  error
tolerance and “180” as angle.  Click  "Find".  The  field  is  recognized in  3-4  seconds
and the image will be astrometrically calibrated.

§ Verify  that  the  search  is  faster  if  your  decrease  the  error  tolerance  (field  and
rotation) since the algorithm can discard easily more patterns.

§ Find  out  the  exact  horizontal  field  of  our  camera/telescope  with  the  command
View / Statistics.

§ Try a full sky search: set "0 0 0 +0 0 0" as zone, 360 x 180 rectangle, 13.5 +- 5%,
20 degrees rotation. After 2-3 minutes, when the progress bar arrives at 15%, the
field will be found and you will be able to stop the procedure clicking "Cancel".
The calibration will be kept.

Immediate

The  menu  command  "Find  coordinates  immediate"  performs  the  same  operation,
without displaying the dialog window.

4.9.7 Find stars

This command searches for stars. The data will be available in the Stars window. 

Select  the  maximum  number  of  stars.  Remember  that  you  can  change  the  all
numeric  values  rotating  the  mouse  wheel  and  you  may  press  CTRL  for  faster
changes.
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S/N  Ratio.  Signal  to  noise  ratio,  it's  a  measure  of  the  intensity  of  the  star.  A
minimum good value is 5, you may decrease it to 3 - 4 to recognize very faint stars,
or increase it to recognize only good stars (with a S/N above 20).

ADU.  Select  the  minimum and the  maximum ADU of  stars  you  need  to  select.  If
you need to select  stars  within a  tight  interval,  increase the "Stars"  number,  since
the filter is applied after the stars have been selected.

FWHM.  "Full  Width  at  Half  Maximum" is  a  measure  of  the  diameter  of  a  star  (in
pixels). The standard minimum value is 1.2, you may increase it to find only larger
stars.  If  you  are  working  on  big  images  it's  possible  that  stars  are  not  recognized
because they are bigger than the FWHM maximum. To correct the problem increase
the FWHM max value to 15 or more. 

These parameters can be also set in the Preferences.

4.9.8 Delete Stars

This  command deletes  all  stars  selected  on  the  image.  A  star  can  also  be  deleted
clicking on it with the left mouse button.

4.9.9 Astrometry

The astrometric calibration is a process that establishes a link between each point
of  the  image  (x,y)  and  the  corresponding  celestial  coordinates  (R.A.,  DEC).  To
perform  the  calibration  we  need  some  reference  stars  with  known  coordinates.
Astroart will get them automatically from the Star Atlas.

A quick calibration can also be done with the Find Coordinates command, but the
precision will be 0.4 - 0.7 arcseconds, while this command allows a precision of 0.1
- 0.4 arcseconds.
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Procedure

1. Before to start take a look at Tutorial #9.

2. Click on the menu Tools /  Star Atlas  .  Resize the atlas window until  it  becomes
about the same size of the image and place it on a free area of the desktop.

3. (Optional) If you wish to choose by hand the stars to be used as reference, select
them  on  the  image.  Otherwise  they  will  be  selected  automatically  in  the  next
step.

4. For a full automatic procedure, click on "Reference stars, automatic" button 
on  the  star  atlas.  Otherwise  you  may  assign  the  stars  by  hand  clicking  on  the
"Reference  stars,  manual"  button.  In  this  case  each  star  will  be  indicated  by  a
cross on the image and you will have to click the same star in the atlas. 

5. Click on the menu Tools / Astrometry.

6. For  a  quick  check  of  the  calibration,  take  a  look  at  the  O-C  pos:  this  is  the
residual  error  for  every  reference,  it  should  be  below  1  arc-second,  if  not  you
may exclude some stars decreasing in realtime the Max O-C value (here it's 0.75
arcseconds). 

The  image  is  now  calibrated:  for  every  new  object  added  to  the  list  of  the  Stars
window, Right  Ascension,  and Declination will  be  calculated.  A orientation  mark
will appear at the upper-left of the image. Also, when you move the mouse pointer
over the image the coordinates are displayed in the status bar.

If you save the image and reload it, the image is still calibrated thanks to the WCS
keywords  which  are  saved  in  the  FITS  header.  If  you  click  again  the  Star  Atlas
Button  on the Main toolbar  the atlas  will  display immediately the star  field of  the
active image.

Astrometry of moving objects 
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To perform astrometry  on  a  sum of  a  sequence  with  a  moving  object,  follow this
procedure: At first perform astrometry on the first image, then save it with the same
name. In Preprocessing align the images with the additional option "Follow minor
planets". That's all: the sum image will be correctly calibrated.

Notes  

The  result  of  all  calculations  is  a  two-dimensional  polynomial  that  maps  X,Y
coordinates into a temporary space, and then to RA and DEC coordinates by further
trigonometric  transformations.  This  polynomial  can  also  be  saved  to  disk  then
reopened into another image to copy the calibration.

To  view  the  direction  of  the  sun,  press  CTRL+SHIFT+N,  the  setting  will  be
remembered.

If you open an image with WCS keywords, this data will be used automatically for
all  astrometric  measures.  Astroart  uses  the  same  algorithms  (least  squares,  etc.)
used by most professional astrometric software under UNIX™.

4.9.10 Photometry

Use  this  command  to  perform  the  photometric  calibration.  With  the  term
photometric calibration we intend a process that establishes a relationship between
the ADU values of  the pixels  and the astronomic magnitude.  The  classic  realtime
aperture photometry can be performed instead with the Zoom window.

Method 1 - Instrumental magnitude

1. Inside the "Polynomial" section click the "Instrumental magnitude" button.

2. Set your own k1 and k2 and Click OK. In case of linear response k2 must be set
to -2.5.

3. That's all, the image is now calibrated using instrumental magnitudes.

Method 2 - Reference stars 
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The following methods require that you prepare some reference stars with a known
magnitude  before  launching  the  command  Photometry.  This  procedure  can  be
manual or automatic. 

In the manual procedure right click over a reference star (after it has been selected,
left-clicking on it) and from the context menu select "Edit star": write the magnitude
of  this  reference  star  and  enable  the  option  "Reference  stars".  (The  "Edit  star"
command is available also from the Stars Window).

The  automatic  procedure  is  performed  with  the  Star  Atlas,  the  magnitude  of
reference stars can be copied automatically from the Atlas with the same procedure
used for Astrometry.

Single reference star.  Select on the image the reference star, the variable star and
(optional)  the check star.  Assign the magnitude of  the reference star  as  written  in
the previous paragraphs, click "Tools/Photometry" and "OK" to finish.

Many reference stars. This will perform the "Ensemble photometry". Select on the
image  several  reference  stars  and  the  variable  star.  Assign  the  magnitude  of  the
reference stars as written in the previous paragraphs. Click "Tools/Photometry" and
select the interpolation method: "Linear" is usually better for less than 5 reference
stars,  if  your  camera  has  a  good  linear  response.  Otherwise  the  non-linear
interpolation  can  be  used.  Look  at  the  O-C  box:  if  one  reference  star  has  a  bad
"Observed-Calculated" value then you may exclude it from the process changing the
"O-C max" value. Click "OK" to finish.

The image is now calibrated: for every new object added to the Stars Window the
magnitude will  be  calculated  (so  the  variable  star  could  be  added after  the  image
has been calibrated). The magnitude is also calculated for the aperture photometry
in the Zoom window. To display the rings used for calculating the flux of the star,
zoom the image 200% or enable the option "Show rings.." in the Preferences.

Polynomial. The result of all calculations is a polynomial that maps the ADU value
to  the  magnitude  of  a  star.  This  polynomial  is  saved  into  the  FITS  Header  if  the
corresponding option is selected in Preferences. This polynomial can also be saved
to  disk  then reopened into  another  image  to  copy  the  calibration.  DO NOT ADD,
MULTIPLY, SCALE an image with photometric data, the polynomial cannot change
in realtime.

These  derived  magnitudes  are  only  as  good  as  the  catalog  values.  They  are,
however, instrumental magnitudes which must be corrected with the atmospheric
extinction  and  the  color-dependent  terms  if  you  desire  to  compare  them  with  a
standard photometric system. Higher accuracy demands at least some calibration to
a standard photometric system using appropriate filters.  A complete discussion of
proper  photometric  techniques  is  beyond  the  scope  of  this  manual.  A  good
introduction is the book: A.A. Henden, R.H. Kaitchuck – Astronomical Photometry
-  Published by Willmann-Bell, Inc.

B-V range.  If you use the UCAC4 catalog and many reference stars,  then two new
fields will appear to exclude all the reference stars outside the specified range. 

http://www.amazon.com/gp/product/0943396255/qid=1136148112/sr=2-2/ref=pd_bbs_b_2_2/102-3323135-4168921?s=books&v=glance&n=283155
http://www.amazon.com/gp/product/0943396255/qid=1136148112/sr=2-2/ref=pd_bbs_b_2_2/102-3323135-4168921?s=books&v=glance&n=283155
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See also: Tutorial #9.

4.9.11 Delete calibration

This command deletes the astrometric and photometric calibration of an image.

4.9.12 Batch photometry

This command calculates the photometry (as ADU) of an object on multiple images.
The result is a text file which can be passed to custom software (or an Excel sheet)
for  further  analysis.  It's  also  possible  to  generate  a  graph  as  instrumental,
differential or standard magnitude.

Procedure

1. Open the first image of the sequence into Astroart.

2. Select some stars over the image. The first one is the object to be measured, the
other stars are the reference stars. If you select more than one reference stars then
Astroart will use the differential ensemble photometry as explained in chapter 4.2
of the AAVSO CCD Observing Manual: www.aavso.org/ccd-observing-manual.

3. Click  menu  Tools  /  Batch  photometry.  Select  (drag  and  drop)  all  images  to  be
measured,  the  dark  frame,  flat  fields  and  how  to  auto-align  the  sequence.  (See
Preprocessing).

4. At the end of the process a text  file  will  be created.  ADU of  stars  are  corrected
from local background. The aperture (Signal-Gap-Background) is the default one
in the Preferences. Click the right mouse button for the context menu.

To  create  a  quick graph in  instrumental  or  differential  magnitude  right-click  over
the text editor and select "Photometry plot" from the context menu. It's possible to
click over the points of the graph to get information about magnitude and time of
every measure.

Photometry of moving objects

To  perform  photometry  on  a  moving  object,  remember  to  set  the  option  "Follow
minor planet" as explained in Preprocessing.

4.9.13 Growth curve

Displays a special graph used in photometry. Before using this command select one
or more stars on the image.

http://www.aavso.org/ccd-observing-manual
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On the X-axis there's the aperture in pixel used to measure the star  (see Aperture
photometry), on the Y-axis the signal to noise ratio or the instrumental magnitude.

In the figure above, for three stars, it can be seen that the best S/N is achieved with
an aperture of 6-7 (it slightly depends on the star).

4.9.14 Aperture photometry

Aperture photometry in realtime is available through two special  "pointers"  of  the
Local zoom window.

Circle

The pointer is a circle with a diameter of N pixels. The sum of all internal pixels "S"
will be shown in the status bar. 

The background value,  to  be subtracted from every pixel,  can be  chosen pressing
the  [B]  key  when  the  circle  is  above  a  sky  background  (or  by  clicking  the  item
Background in the context menu). If a background B value is selected, then a new
value "V" will be displayed in the status bar and it is computed as (S - B*npixels). If
the  image  is  photometrically  calibrated,  then  the  value  will  also  be  shown  as
instrumental magnitude.

Annulus

It  works  just  like  Circle,  but  the  background  (which  is  always  subtracted)  is
calculated automatically inside the annulus.
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Press the arrow keys to move the pointer, [ENTER] to collect a star in the Stars list,
[C]  to  center  the  star.  You  may  set  the  default  values  for  the  circles  in  the
Preferences.

4.10 Window Menu

4.10.1 Cascade, Tile, Arrange Icons

Cascade 

Layers all windows so that all title bars are visible.

Tile 

Divides the screen into smaller windows of equal size.

Arrange Icons 

Regroups  the  icons  of  the  minimized  windows  in  the  lower  left  corner  of  the
Astroart desktop.

Minimize All 

Minimizes all the windows to the lower left corner of the Astroart desktop.

4.10.2 Full Screen

Displays the image at full screen over a black background. 

It's  possible  to  move  and zoom the  image  with  the  same commands  of  the  Image
Window. Example: press [PAG_UP] and [PAG_DOWN] to modify the visualization.
Press [+] and [-] to zoom and the [ARROWS] to move the zoomed area. As usual it's
possible to pan with the mouse clicking the right button and to zoom clicking the
wheel (without rotating it) moving the mouse up-down.
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4.10.3 Fit To Image

This command resizes the window frame to the size of the image. The shortcut is "
* " on the numeric keypad.

4.10.4 Fit to Window

This command zooms the image so that it fits the window.

5 Camera control

Camera control in Astroart is implemented as a "plug-in", this solution allow us to
support new cameras very quickly. This documentation refers to the Camera Panel
7.0.  For  compatibility  with  older  cameras  it's  still  available  the  old  Camera  Panel
6.0 which nowadays is obsolete.

5.1 Installation

To  install  a  plug-in,  unzip  it  into  the  Astroart  installation  folder  (usually:  C  :\
Program  Files  x86  \  Astroart).  The  documentation  is  included  in  the  same  zip
archive.

5.2 Setup page

The  first  option  to  be  selected  is  the  camera  model,  then  click  on  "Setup".
Nowadays  most  cameras  are  ASCOM compatible.  If  the  camera  is  not  in  the  list,
then download its plugin in the "Camera control" page of the Astroart web site. To
make indoor tests, use the Simulator.

To  command an auxiliary  camera  click  the  second Setup button.  Later,  it  will  be
possible  to  connect  both  cameras  and  other  equipment  with  a  single  click,  press
CTRL + left click on the first Setup button.

Click the wrench button to open the Options Window:
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Camera control in background. Enables multithreading for image download, focus
and autoguide,  so that  images from the camera are  downloaded in  background.  If
you  see  that  the  Focus  window  or  the  Autoguide  window  get  blocked  during
download and "stutter" then enable the option. On (modern) ASCOM cameras the
option is no longer needed since internally they work in background in any case.
On some old cameras the option cannot be used at all. 

The  options  "Driver  synchronization"  are  used  when  you  are  controlling  two
cameras  of  the  same  manufacturer.  Synchronization  reduces  performance  in  one
rare case: when you are focusing with the primary camera and autoguiding with the
secondary camera at the same time.

Write to FITS header. Select here which keys are to be written in the FITS header.
If  you  select  the  airmass  or  the  observatory  coordinates,  remember  to  configure
them in the Preferences.

Visualization  (automatic  and  custom).  The  view  mode  for  every  new  image.  The
option “Auto (soft)” provides a natural look, “Auto (hard)” is useful for asteroid and
supernova search.  If  ”Auto”  is  not  selected  then  it’s  possible  to  set  the  minimum
and maximum visualization threshold and the transfer function.

Flip, Rotate, Binning, Cut borders. These options modify every image downloaded
from the  camera.  "Binning  software  2x2"  is  useful  if  the  hardware  binning  of  the
camera  is  limited,  or  to  increases  the  dynamic  by  two  bits  (since  4  pixels  are
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summed). For example: a 16 bit camera becomes a 18 bit one.

Annotate saturated stars. All stars with a peak value higher than the first value will
be marked with a yellow circle (red circle if higher than the second value). This is
useful for photometry, to ensure linear response. For example, for a 16 bit camera
you  may  set  50000  and  60000.  This  command  is  also  available  for  any  opened
image, just press CTRL+SHIFT+S.

Alerts.  Options  to  play  a  sound  on  important  events,  for  example  the  lost  of  the
guide star. It's also possible to use a personalized WAV file.

Shutter delay. A time in milliseconds which is added to the exposure start time in
the  FITS  header,  to  compensate  for  the  time  spent  by  the  camera  to  open  the
shutter and flush the CCD. It's useful when you need a precision of 0.1 seconds. 

UT  and  LT.  Universal  time  and  local  time,  as  read  from  Windows.  You  may
compare them with a scientific watch.

Synchronize two sessions.  This option permits to synchronize three cameras:  two
Astroart sessions which are taking sequences, plus an autoguide system in dithered
mode.  Select  "Master"  in  a  session  and "Slave"  in  the  other.  The  session  which  is
guiding  (or  which  is  controlling  the  external  autoguide  software)  must  be  the
Master  one.  Then start  the  sequence  in  both  session  (the  order  is  not  important),
every session will wait until the other one is ready. 

5.3 Image page

To start a new exposure select the Image Page,  write an exposure time in seconds
(example: "0.002" for two milliseconds) or click then arrow buttons,  then click the "
Start" button. The binning factor can be increased and decreased clicking the "1x1"
button.

Dark  frame.  Select  this  option  to  close  the  shutter  during  the  exposition,  if  your
camera has a built-in shutter.

New  window.   Every  new  image  is  usually  displayed  in  a  new  window.  If  this
option  is  disabled  then  every  new image  will  overwrite  the  previous  one,  if  they
have the same size. This is useful when doing sequences or test images.

Filter wheel. Select the filter name and click the arrow button to move the wheel to
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the desired position. The filters can be moved also from the Filter Wheel Window.

FITS Data. Here you may write the object name and a comment for the FITS header
of the image. All other FITS data like date, time, temperature (if  supported by the
driver) are added automatically.

5.4 Sequence page

To improve the  Signal-To-Noise  ratio  it  is  often  necessary  to  take  a  set  of  images
and sum them. In Astroart it's available a simple sequencer and a full sequencer.

Autosave. If selected, every image will be saved with the filename specified in the
edit box plus an ordinal number, into the chosen directory.  In the example above
the  filenames  will  be:  M31_001.fit,  M31_002.fit,  etc.  You  may  also  modify  the
separator  (underscore  in  the  example).  If  you  add  a  "t"  to  the  separator  then  the
exposure time will be added to the filename, for example with "-t" and an exposure
of 60 seconds, the filenames will be: M31-60s-001.fit, M31-60s-002.fit, etc. 

New window.  Not  recommended.  Usually  it's  not  selected,  so  that  all  images  are
displayed into the same window, to save memory.

Dithered guide. This option can be useful during a sequence autoguided exposures.
Between each exposure  the  telescope will  be  move  randomly  by a  given  amount.
This  means  that  every  image  will  not  be  aligned  with  the  following  one,  but  the
signal to noise ratio will improve because different pixels will be used to collect the
same data.

Simple sequencer

This is used when you don't need to move the filter wheel or take dark frames and
images at the same time. Just write the number of exposures to be acquired, from 1
to 9999. It's also possible to set the initial index of the sequence. To take a sequence
of dark frames just enable the option in the Image page. Press the button "Start Seq"
to start.

To stop a sequence click the button "Stop" once, and wait a few seconds

Full sequencer

This is used for complex sequences, or simple sequences which are reused, thanks
to  its  ability  to  save  and  reopen  settings.  Click  the  button  near  "Sequencer"  to
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activate.

Every  row  is  composed  by  Command,  Number  of  images,  Exposure  time,  Binning
and (optional) Focuser position. Click the arrow button to display more rows.

In  the  example,  35  images  will  be  taken  (index  1..35)  if  you  need  to  skip  some
images, then modify this initial and final index in the main sequence panel.

Click  the  option  "Repeat  everything"  to  repeat  the  sequence  several  times.  In  the
example  above  this  could  be  used  to  take  dark  frames  in  the  middle  of  the
sequence, instead of taking them only at the end of the session.

Once  the  focuser  section  is  displayed,  you  may  write  an  absolute  position  to  be
reached before taking a group of images, or write the special code "99999" to launch
the full-frame autofocus. Click the button "Menu" to display more commands:

Filenames preview. This will display the exact list of files which will be generated,
for example: M31_001R, M31_002R, M31_003R, etc. this is very useful to check the
result  of  the  sequence.  Once  the  images  have  been  created,  remember  that  in
Preprocessing  you  can  double  click  on  a  single  file  to  select  all  files  of  the  same
kind (filter, dark frame, etc).

Create similar script. Creates a script which is able take the same sequence. This is
useful to customize a sequence with other commands.

5.5 Dark/Flat page

This page enables the automatic correction of dark frames and flat fields during the
acquisition  of  images.  This  function  is  not  recommended,  since  you  will  not  be
able to analyze the original raw images. It can be useful for live demonstrations.
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Dark  frame  correction.  Select  this  option  to  disable  or  enable  the  dark  frame
subtraction  for  every  new  image.  If  you  change  the  binning  factor  the  correction
will be disabled.

Flat field correction. Select this option to disable or enable the flat field correction
for every new image. 

For  best  results  remember  to  take  at  least  5-10  dark  frames  and  average  them  to
reduce the random noise.

5.6 Focus/Guide page

This page contains several buttons to focus or guide, three for the main camera (left
section) and three for the guider camera (right section). 

For the subframe focus and guide (1, 2, 4, 5) at first download a full image: for the
main camera just click the "Start" button. For the guide camera click the "FOCUS"
or the "GUIDE" button. Then select a rectangle around a bright star and click again
the focus or the guide button.

For the full-frame commands (3, 6) see the chapter Autofocus and Autoguide.

Exposure.  The  exposure  time for  every  frame.  It's  always  possible  to  change  it  in
realtime.

Binning. The binning factor of every exposure.

Correct  Dark  frame.  If  selected,  a  dark  frame  is  acquired  at  the  beginning  of  the
focus  session:  (if  the  camera  has  not  a  shutter  you  should  cover  the  scope  before
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starting)  Astroart  will  keep  in  memory  the  first  frame  as  a  dark  frame  and  every
subsequent image will be automatically corrected.

Hot pixels. Enables the automatic correction of hot pixels for every frame.

Focus window (subframe)

This  window acts  as  "live  view"  and  can  be  used  to  focus  or  center  the  field.  To
select a subframe centered exactly in the image, see: Select rectangle.

FwhmX, FwhmY. "Full Width at Half Maximum" is a measure of the size of the star
(in pixel) along the X and the Y axis.

Focus.  A  precise  sharpness  indicator.  The  higher  the  value  (from  0  to  1000),  the
better  the  focus.  5  algorithms  are  available  to  calculate  the  focus  for  more
information see the paragraph about  Autofocus. 

Average  (FwhmX  /  Fwhmy  /  Focus).  The  averaged  values  from  the  last  few
exposures.

X, Y. The absolute coordinates of the star, inside the full image. This can be used to
center exactly the field between two nights.

At  the  top  of  the  Focus  Window  you  can  find  some  buttons:  The  four  arrow
buttons move the focus subframe across the CCD area. The cross button displays a
reference cross. The [+] and [-] buttons increase or decrease the exposure time. The
[1234]  button  displays  the  calculated  focus  and  its  average  with  a  big  font,  then
click the "loudspeaker" icon to have them spoken by the computer.

For  a  smoother  operation  of  the  Focus  Window  you  may  want  to  enable  "Camera
control in background" in the Options, if the camera driver supports this mode.
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Autofocus

See the paragraph Focuser inside "Other devices".

Autoguide

See the paragraph Autoguide inside "Telescope control".

Camera control

5.7 Settings page

Binning. If 1x1 is selected then the CCD works at full resolution (example: 768x512
for a KAF400). If 2x2 is selected then four pixels will be grouped into one and the
resolution is halved (example: 384x256 for a KAF 400). The advantage of binning is
a faster download and better signal to noise ratio. 3x3 and 4x4 are useful to find or
center an object.

Pause. Before each exposure there will be a pause of N seconds.

 

Sub-frame.  This  is  a  useful  feature  for  planetary  imaging  at  high  resolution.  To
speed-up the download and save space on disk it is possible to acquire only a part
of the CCD array. To use this feature, download a full frame, select a rectangle on it,
then click the "Select from..." button. The frame boundaries will be written into the
four edit boxes as percentage.

6 Telescope control

To  configure  and  control  the  telescope  select  the  Setup  Page  and  click  the
"Telescope" button.

6.1 Setup Page

This  page  is  used  to  connect  the  telescope.  Select  here  the  protocol  used  to
command the telescope ("Goto"),  and the secondary connection (if  available)  used
to send guide pulses ("Guide").  If  you have a guider camera with integrated relays
and a ST4 cable to the mount, the Guide protocol is usually "Camera 2 relays". 
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Options

Parking and Tracking. Commands to park and unpark the telescope and to turn off
and on the sideral tracking. Turning off the tracking can be useful to take flat fields
directly on the sky.

Active  Optics.  These  options  are  shown  when  an  AO  is  connected.  See:  Active
Optics.

6.2 Goto Page

This  page  is  used  to  move  the  telescope  to  a  given  object  and  to  manage  lists  of
objects.

Object or RA,DEC. Write here the name of a object (for example: M42, see also: Star
Atlas)  or  some RA/DEC coordinates  (example:  18  34.3  +34  56)  then  click  on  the



98

GOTO  button  to  slew  the  telescope  to  that  object.  The  "JNow"  option  is  used  to
convert  the  coordinates  from  J2000  to  the  current  epoch.  If  the  observatory
coordinates are set then the altazimuth coordinates will be shown as well, be sure
that the time of the PC is correct.

Sync button. Synchronizes the position of the telescope, three options are available:
1)  The  object  written  in  the  "Object"  box  above.  2)  The  coordinates  of  the  last
GOTO. 3) The current image if it's calibrated (plate solved).

Add to list.  Adds the current object to the list.  When adding a  custom object  you
may specify a name, for example: "MyObject" 23.5 +12.3

Object  list.  Right  click  to  open the context  menu. When opening a  text  file  every
row must  contain:  Name,  RA,  DEC.  The  format  of  the  coordinates  is  free,  but  the
declination must contain the sign. Example:

"NGC4567" 12 34.8 +78 45
"M 67" 12 34 56 +78 23.8
"PK456+789" 12 12.2 + 34 34 34
"UGC 3456", 12, 14, 16, +34, 54, 34     // Comments this way.
"UGC 4567", 12.23445, -23.23456

This  format is  also valid for  the "Add to list"  button.  In this  example  the  last  two
rows are  CSV [comma separated  values]  which  can be  exported  and  imported  by
Microsoft Excel. 

Other commands in the menu allow to delete rows and to sort the list:

The object list is sorted using a compromise between a shortest path algorithm and
a increasing RA algorithm.
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6.3 Move Page

This  is  a  virtual  keypad to move the telescope,  useful  to  center  an object.   Please
note that some ASCOM drivers do not support this function, in this case you may
try the option "Emulate with GOTO".

Emulate  with  GOTO.  Select  this  option  if  your  scope  cannot  be  controlled  for
simple North, South, East, West commands, but it supports the GOTO protocol and
the  STOP-GOTO  command.  The  speed  depends  on  the  telescope,  usually  1  -  2
degrees per second.

Speed.  The  telescope  speed,  this  option  is  not  supported  by  some  telescopes.
Remember to select “Guide” before autoguiding.

Current  position.  Displays  the  current  equatorial  coordinates  as  read  from  the
telescope.  For  the  altazimuth  coordinates  you  have  the  option  to  have  them
calculated or read from the telescope.

6.4 Center Page

This  function  centers  the  object  in  the  field  of  view  of  the  CCD.  You  may
automatically  obtain  the  same  result  using  the  “Find  coordinate”  (plate  solving)
script available in the next chapter.
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Three methods are available to center the object. The first two methods are manual,
you will need to select a point over the object then click the [Center]  button. The
third method is automatic:

§ Pulse (manual). The telescope will be moved using the pulse commands (North,
South, East, West) at the given speed. The field of view of the CCD image must be
known  in  seconds  (time),  this  parameter  is  simply  the  time  necessary  for  the
telescope to move along a full field. The field along the X axis can vary slightly
with the declination, to correct this measure the field X at the equator and enable
the option Cos(declination).

§ Goto  (manual).  The  telescope  will  be  moved  with  a  GOTO  command  (Goto
(ra+dx,dec+dy)).  The field of view of the image must be known in arcminutes.
The field X varies with the declination and it’s possible to enable the option Cos
(declination).

§ Goto  (automatic).  The  telescope  will  be  moved  with  a  GOTO  command,  after
having calibrated the image via plate solving. Be sure that the plate parameters in
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the Find Coordinates window are correctly set.

6.5 Autoguide introduction

If you follow a star with your telescope at high magnification, you will notice that
the position of the star changes. This movement is caused by three reasons:

§ A poor polar alignment which causes a slow drift in declination.

§ The periodic error in the mount’s tracking, this error results from gears that  are
slightly out of round. Some mounts have a built-in periodic error corrector called
PEC.

§ The random errors due to many causes as dirt, dents and variations in the gears.

These problems do not permit to take long exposures with the camera. Actually if
the  mount  is  sufficiently  precise  to  allow  correct  exposures  of  1  minute,  the
autoguide  is  usually  not  needed,  it's  more  productive  to  take  a  Sequence  and  to
stack the images later.  

Autoguide tutorial

To  quickly  understand  how  the  camera  and  telescope  work  together  during  an
autoguide session, try this step by step tutorial.
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1. Inside the Setup page of the camera control panel, select "SIMULATOR" as main
camera and click "SETUP" to connect it.

2. Click  on  "Telescope  ..",  select  "Telescope  Simulator"  as  protocol,  and  click
"Connect".

3. Close the main Telescope Window, but don't close the Simulator window.

4. Click "START" to start an exposure of 3 seconds.

5. Draw a small rectangle around a bright star and click "Guide" in the Focus/Guide
page.

6. Click  "Mark  star"  inside  the  Guide  Window.  The  telescope  simulator  will  now
guide on the reference star and the pulses will be shown with red arrows. 

7. Try  to  pause  the  autoguide:  you  may  disconnect  the  telescope,  clicking  the
button "Connect Telescope" or deselect  the options  "RA",  "D-",  "D+".  Verify  that
the star slowly drifts away.

Let's  repeat  the  procedure  using  the  Guider  Simulator  (the  secondary  camera).
During  the  guide,  we  will  start  a  long  exposure  with  the  Camera  simulator  and
verify that both virtual cameras work at the same time.

1. Close the Guide Window.

2. Go to the Setup page (Guider camera) to connect the Guider Simulator.

3. Click  "Guide"  (second  camera)  in  the  Focus/Guide  page  to  take  a  full  exposure
with the guider camera.

4. Select a rectangle around a star and repeat the procedure above from point (6).
During the guide, start a long exposure with the main camera.

6.6 Autoguide

Autoguide means to use a secondary camera to correct the tracking of the telescope
as  explained  in  the  previous  paragraph.  Four  methods  are  possible  with  Astroart
(the dithering commands are supported for all).

Method 1 - Two cameras using subframe mode

1. Go  to  the  Focus/Guide  page  and  select  an  exposure  time.  A  typical  time  is
between 0.1  and 4  seconds.  Usually  you  will  need to  change  the  binning  from
1x1 to 2x2 or more, since you should aim for stars with a diameter of 2 - 4 pixels,
which are the best compromise between S/N and precision.

2. Click the "Guide" button to download a full frame from the guider camera, then
draw a rectangle around the best star. Click again the Guide button to open the
Guide Window.
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3. The  star  will  appear  in  the  Guide  Window.  Click  on  the  "Mark  Star"  button:  a
green  cross  will  mark  the  initial  position  of  the  guide  star,  while  a  red  marker
will follow the star while it shifts from the original position.

4. If needed, click on the "Connect telescope" button to activate the telescope and to
start sending pulses. If needed, enable all the options "RA" , "D+" , "D-".

Method 2 - Two cameras using full-frame mode

This is a new mode released with Astroart 7 SP4. The most important feature is the
autoguide on multiple stars, with automatic exposure time. See the next chapter for
more details.

Method 3 - PHD Guiding

The only option to configure in Astroart, if needed, is the dithering in the Sequence
page. Inside PHD it's recommended to set "Spiral mode" for dithering.  A complete
communication is also possible via scripts.

Method 4 - Two Astroart sessions

This  is  useful  only  for  autoguiding  for  a  long  time  (several  hours)  on  the  same
subject.  The  second  session  could  be  minimized  and  "forgotten".  If  you  like,  you
may  connect  the  guide  camera  as  "primary  camera"  in  the  second  session  of
Astroart.

Calibration

A guide system requires at least three parameters: apparent speed in RA, apparent
speed  in  DEC  and  rotation  angle.  The  speed  (measured  in  pixels  per  second)  is
"apparent"  since  it  depends  on  the  size  of  the  pixels  and  the  binning  factor.  To
measure  the  speed  and  the  angle,  it's  usually  available  an  automatic  procedure
called "calibration". In Astroart just click the button "Calibrate".
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The apparent speed should be not too slow nor too fast, the best range is between 2
and 5 pixels per second. If the speed is too slow, then the guide pulses will be too
long and this will decrease the frame rate so the "efficiency" of the exposure time. If
the speed is too fast then the guide pulses will be too short (milliseconds) and they
will not be precise.

The apparent telescope speed and angle could be measured also by hand: move the
telescope with the keypad for one second and measure how many pixels the image
moves. The angle is the rotation of the camera relative to the equatorial axes.

In  the  figure  below,  the  Calibration  box  is  filled  automatically  during  the
calibration  procedure.  If  needed  it's  possible  to  set  the  length  of  the  calibration
pulses and the option to calibrate only in RA.

To  completely  define  a  guiding  system  another  value  is  needed:  the  distance  (in
pixels)  from  the  reference  position  where  the  star  is  free  to  move  without
corrections  (sometimes  called  "minimum  movement").  This  "Don't  guide  zone"  for
RA and Dec, is shown in the next figure. This value is needed to prevent unwanted
corrections  caused  by  the  seeing.  0.30  pixels  is  a  good  compromise  between
precision and rejection of noise. Values lower than 0.30 should be used only on a
short focal length. 
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Reusing the calibration

Usually  it's  possible  to  reuse  the  calibration  for  a  long  time.  Two  issues  may
prevent this: the "side of pier" of german mounts and the "Cos(dec)" factor. To solve
the first problem you may use the option "Invert if different Side of pier". This option
must be enabled before launching the Calibration so that the original "side of pier"
is saved in the Calibration box. It's supported only on ASCOM mounts.

The "Cos(dec)" effect slows down the apparent speed in RA at high declination. To
address this problem there are two schools of though, both supported by Astroart:

1. Do a calibration at Dec 0, then multiply all pulses by 1/Cos(dec) to compensate
the problem. This seems natural but it's not without risks: increasing the pulses
will slow down the frame rate, and if the seeing become worse there's the risk to
oscillate on long pulses. In Astroart the calibration can be done at any Dec,  the
original value will be saved in the Calibration box.

2. Do a calibration at Dec 0, then ignore the problem. At high declination the guide
will be less aggressive, for example at Dec 60 every pulse will correct half of the
error.  BUT: at  high  declination  the  telescope tracking  is  much more  precise  by
itself, all defects are attenuated, so the result image may have the same quality of
one guided at low declination.

These  options  are  available  in  the  "Correction"  field  inside  the  RA  box.  Astroart
uses by default an in-between method ("Adaptive") which detects in realtime if the
RA guide is too lazy or too aggressive and then adjusts it.

Options

Correction.  Sometimes  called  "aggressivity",  it's  the  percentage  of  the  correction
that  it's  actually  sent  to  the  mount.  Usually  90%  is  a  good  value.  This  value  is
linked with the "Don't guide zone", in some cases it's possible to decrease the zone
and then decrease the correction so that pulses sent on random seeing don't cause
oscillations.

DEC backlash. Backlash may be a problem when the declination motor changes its
direction.  By  default  Astroart  compensate  automatically  the  DEC  backlash  unless
you set a specific time compensation in seconds. In this case be careful!  Backlash
corrections should be always under-compensated, an over compensation will cause
an overshoot. In RA backlash is never a problem.

Pulse  North  and  South.  If  needed  it's  possible  to  disable  one  of  the  pulses,  for
example  if  you  know  in  advance  the  direction  of  the  declination  drift.  This  will
prevent all problems caused by backlash.

Calibration  pulse.  The  duration  of  the  pulses  during  the  calibration.  The  default
value of 800 ms is usually good, by the way it's recommended to increase to 1200
ms or more it if the guide scope has a very short focal length and to decrease it to
500 ms for some active optics models.

Bad seeing  guide.  A  special  mode  for  extreme  conditions  (bad  seeing,  wind),  it’s
not recommended for normal guide.
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Dual axis guide.  If enabled, Astroart drives the telescope with two axes at a time.
For  equatorial  mounts  this  option  is  usually  not  required  because  the  DEC  axis
changes very slow depending the precision of the polar alignment, while fast DEC
movements (wind, bad seeing) should be ignored.

Star  lost  at.  This  value  is  just  for  safety:  if  the  stars  drifts  away  so  far,  then  the
guide will be paused and the problem will be notified.

Guide on slit for spectroscopy.  This option is used to force the reference position
to  a  given  X  and  Y  coordinates,  to  allow  spectroscopy  during  autoguide.  The
reference  position  can  be  changed  in  real  time  clicking  on  the  8  sectors  near  the
border  of  the  image.  Press  SHIFT+click  to  move  by  0.5  pixels  and
SHIFT+CTRL+click  to  move  by  0.1  pixels.  For  more  information  see  the  PDF
tutorial available at the Astroart forum (search for: Guiding a star on spectroscope
slit). 

The Guide Window can be used as a recorder to measure the dX and dY errors of
the mount (left image). These values can the be copied and pasted into a text file. 

The image on the right shows the statistics of an actual autoguide for a "Don't guide
zone"  of  0.30  x  0.35  pixels.  Click  the  right  mouse  button  for  the  context  menu.
Rotate the mouse wheel  to  zoom in and out the graphs.  The linear graphs can be
panned left-right clicking the left mouse button.

Possible problems

If the system does not guide well, watch the behaviour of the star, this will reveal
where the problem is, since only 4 scenarios are possible:

https://www.astroart-forum.net/forum/viewtopic.php?f=2&t=72
https://www.astroart-forum.net/forum/viewtopic.php?f=2&t=72
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§ Overcorrection.  The  system  is  much  faster  than  expected,  so  every  correction
brings the star beyond the center. This could be a software problem (calibration
not precise) or hardware (guide speed too fast, the best setting is between 0.3 X -
0.7  X  sideral).  If  you  see  long  series  of  oscillations  there  could  be  an
overcorrection problem or the "Don't guide zone" is too small for the seeing.

§ Undercorrection.  The  guide  is  "lazy"  and  the  star  is  brought  to  the  center  too
slowly. This can also mean that the pulses are not reaching the telescope at all.

§ Wrong direction. After a few pulses the star is brought away from the center. The
direction  of  one  of  the  axis  must  be  inverted.  Enable  the  option"Inv.  X"  or  the
option "Inv. Y".

§ Extreme speed. The star disappears at the first pulse. Probably the telescope was
not  configured  for  guide  speed,  see  the  "Move"  page  of  the  Astroart  Telescope
Window, or check if some settings are required in the hardware or in the ASCOM
driver.

6.7 Autoguide full-frame

Astroart 7 SP4 contains a new full-frame autoguide, with the additional features:

§ Usage of all stars. If several "good" stars are present in the field, then those stars
are used to autoguide, just like when stacking a sequence of images.

§ Automatic  exposure  time.  If  the  star  is  too  faint,  then  the  exposure  time  is
increased to an optimal value. If the star is too bright then the exposure time is
decreased.

What is a "good" autoguide star? The classic S/N Ratio was not optimal to define it,
the  reason  is  that  in  amateur  astronomy  the  strongest  source  of  noise  is  light
pollution, which is not included in the formula of the classic S/N.

For this reason a new metric, based on PSNR was used. The noise is now measured
directly on the image, so all contributions (light pollution, thermal current, readout
noise) are evaluated at the same time. The PSNR is usually defined in decibel, e.g.
20 Log(Signal / Noise) here is an example for three stars:

For  more  information  about  PSNR  see  this  internet  search:  www.google.com/
search?q=image+psnr

https://www.google.com/search?q=image+psnr
https://www.google.com/search?q=image+psnr
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Automatic exposure time

The exposure time is controlled by three Time values and three PSNR values:

At first an exposure of Initial seconds is taken. If no stars have an Optimal PSNR
then  the  exposure  time  is  increased  to  achieve  that  optimal  PSNR,  obviously  the
increment is limited by the Max exposure time. Then another exposure is taken, if
no star has at least the Minimum PSNR, then the procedure is declared failed and
it's terminated.

For those rare cases where the star is too bright, so it's brighter than the Maximum
PSNR, the exposure time is decreased to reach again the Maximum PSNR, but not
less  that  the  Min  exposure  time,  this  prevents  blooming  and  gives  a  better  frame
rate to the autoguide.

Scaled dark frames

If the camera needs dark frames, the variable exposure time poses a problem, how
to correct it? To solve, a new scaled dark frame algorithm was created and it's active
by default. The first step of a good dark frame correction is the creation of a master
dark frame, averaging several exposures:

when the procedure is finished, it's possible to click the button "Show current dark
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frame"  to  save it  to  disk for  later  use.  If  the noise is  caused mainly  by  hot  pixels,
then the dark frame could be used as a defect map or completely replaced by the
Hot pixel filter.

A last word about autoguide stars: for best results the stars should have a width of 2
-  5  pixels,  not  more.  This  is  the  best  compromise  between  S/N  and  centroid
precision. This means that on some cameras binning 2x2 or more should be used. If
the camera does not support it, then enable the extra software binning 2x2.

Usage

At first connect the two cameras and the telescope, you may practice indoor with
the camera, guider and telescope simulator.  Then go to the Focus/Guide page and
click the button "FF.Guide" to open the full frame autoguide window:

Click  "Test  exposure"  to  download  a  first  image  from  the  camera,  the  PSNR  of
detected stars will be shown. If needed increase the Binning factor to achieve stars
of 2 - 5 pixels. If you need to calibrate press "Calibration". About all the parameters
and the calibration see the chapter about autoguide.  

To change the zoom of the image, right click for the context menu, or use the same
mouse  commands  of  the  Image  Window.  To  enlarge  the  Statistics,  just  place  the
mouse between the image and the panel and drag left-right.

Script commands

The new script functions for controlling the full-frame autoguide are:

Guider.FullFrameAutoguide()   Guider.AutoguideStatus()   Guider.Calibrate()
 Guider.CalibrationOK()

The  command  AutoguideStatus  returns  a  string,  which  indicates  the  Status
("Guiding", "Calibrating", "Stopped", etc). To wait for settling just make a loop until
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the status is "Guiding". The command "Calibrate" start the calibration, but does not
return a result, use the command CalibrationOK() to verify.

All the other commands for subframe autoguide (Guider.Close(), Guider.WaitStar(),
etc.) remain valid also for the full-frame autoguide.

7 Other devices

To open the control panel for filter wheels, focusers and rotators use the buttons in
the Setup Page of the camera control panel.

7.1 Filter wheel

To open this window click the button "F. Wheel" in the Setup Page of then Camera
Control. Select the model, the number of filters used, and click on "Connect".

Model. Select the model, nowadays most wheels are ASCOM compatible. To make
indoor tests use the Simulator.

Filters used. You may set how many filter are effectively used, or just set the total
number of positions for your wheel.

Serial port.  If  your filter wheel is controlled via the serial port,  select here which
port you are using.

Estimated  rotation  time.  This  value  is  used  for  those  wheels  which  have  no
feedback  on  their  position:  the  value  will  be  used  as  a  pause  for  completing  the
rotation.  For  most  ASCOM  wheels  it's  not  needed.  However  it  has  also  another
purpose: in the Sequencer, it's used to estimate the total time required to complete
a sequence. 

Send command on same filter. If enabled, Astroart sends the "go" command to the
filter wheel also when the correct filter is in position yet.

Filter names

From this page you may set the filter names. The first letter identifies the filter in
scripts, so it must be unique. For this reason you may use the syntax "Character -



111

Name"  as  in  the  following  figure,  but  it's  not  mandatory.  Both  "G-Green"  and
"Green" are acceptable.

Buttons. Click a button to move the wheel to that position. The wheel can also be
moved by the button in the Image page, by sequences and by scripts.

7.2 Focuser

To  connect  the  focuser  select  "ASCOM"  as  model  and  click  Connect.  For  indoor
practice  and  to  test  your  scripts  you  may  connect  the  Simulator.  The  analogic
focuser  of  the  LX200  can  be  used  for  manual  focus  and  it's  available  only  in  the
Focus Window (subframe).

Software  backlash  correction.  If  enabled,  the  focuser  always  moves  in  the  same
direction  (+)  during  the  steps  of  autofocus.  If  your  focuser  has  an  integrated
backlash  correction  (most  focuser  have)  you  may  not  enable  this  option,  which
slightly slows down the procedure.
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In the "Control"  page you may move the focuser to  a  given  position.  The  option "
Temperature compensation" enables that function if available in hardware, by the
way on some focusers it blocks all movements and control.

Autofocus

This  procedure  finds  automatically  the  best  focus  position.  Two  procedures  are
available:  "subframe"  where  a  single  star  is  measured,  and  "full  frame"  where
several stars are measured at a time. Both methods share some options:

Positions.  The  number  of  positions  to  find  the  best  focus.  Usually  it's  an  odd
number. For example, if you set "7" the program will search: three positions back,
the current one, and three ahead. 

Step. The step between positions, this value depends by the range of your focuser
(some have  a  range  0..5000 up to  0..50000).  Usually  1/500  of  the  range  is  a  good
starting value. The best value is the one which gives slightly defocused stars at the
extreme positions.

Binning. The binning mode when taking focus images. If possible set a value which
gives focused stars of 3-4 pixels, this will optimize the S/N ratio and the download
time.

Method. The algorithm to estimate the focus from the star. If you know in advance
that for a good focus you can get stars of 2-5 pixels (i.e. setting an higher binning)
then  the  method  "Small  disc"  is  usually  the  best.  For  slightly  bigger  stars  (5..8
pixels), use the method "Large disc". If you prefer a generic algorithm then it's also
available the FWHM (full  width half  maximum) and the HFD (half  flux  diameter,
see: Wikipedia).  Since the best method depends on your  instrumentation,  a  quick
initial  test  with  all  methods  is  recommended.  Every  focus  method  produces  a
measure from 0 to 1000, which is relative, and cannot be used to compare methods.

The  subframe  focus  window  contains  two  extra  methods  to  focus,  one  for  the
Bahtinov  Mask  on  a  bright  star,  see  Wikipedia,  and  one  for  a  spectrum reference
line, where the width of the line is used to estimate focus.

Exposures. How many exposures per position. This is used only in the "subframe"
procedure when the seeing is not good. If the seeing is good, choose a value from 1
to 3, if it's bad, 3 to 5.

https://en.wikipedia.org/wiki/Half_flux_diameter
https://en.wikipedia.org/wiki/Bahtinov_mask
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Autofocus (subframe)

This  procedure  is  available  in  the  Focus  Window.  It's  recommended  only  at  the
beginning  of  a  session,  when  the  focus  is  unknown  and  a  bright  star  is  used  for
focusing. The exposure time is usually quite short (0.05 - 2 seconds) and the star is
chosen manually.

Click  the  arrow  button  near  the  "Focus"  parameter  to  change  the  algorithm,  then
"Start"  to launch the procedure.  For  every step the measure will  be shown as text
and graphics. At the end the focuser will be moved to the best position (calculated).

Autofocus (fullframe)

This  is  the  procedure  to  be  used when you are  focusing  on  the  same  field  of  the
object. The typical exposure time is usually higher, for example 2 -  8 seconds. To
improve  the  S/N  and  the  download  time,  it's  recommended  to  work  with  a  high
binning, to obtain stars of 3 - 5 pixels if possible. If your camera is unable to do so,
you may enable the further "software binning 2x2". 

If you are using a extremely large CCD with coma at the borders, you may exclude
the borders decreasing the "Subframe" value from 100% to 90-80%.
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This autofocus procedure can be launched by Scripts with the command "Camera.
FullframeAutofocus",  and  can  be  launched  automatically  by  the  Sequencer.  If  no
stars are found during the procedure, the original focuser position will be restored.

7.3 Rotator

In  the  past  these  devices  were  called  "derotators"  and  were  used  on  altazimuthal
mounts. Nowadays they are used on equatorial mounts to easily rotate the camera
to a given position, this is the purpose of this command.

To connect the rotator, select the Model and click Connect.
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In the "Control" page the current position of the rotator will be shown. Press "Sync"
to  set  the  angle  (without  moving  the  rotator)  to  a  given  reference,  manual  or
calculated  from  a  plate-solved  image.  To  move  the  rotator,  use  the  button  in  the
section  "Move".  If  the  rotator  moves  in  the  wrong  direction,  enable  the  option
"Reverse angle" in the Setup page.

7.4 Active Optics

Active  optics  are  managed  as  "Guide  devices"  of  the  Telescope  Window.  Once
selected, a new page will be shown with the following options:

Click the "Center" button to move the prism or the mirror of the AO to the middle
position. Some models do support a faster mode.

Bump pulses

These  are  very  small  pulses  that  can  be  sent  to  the  mount  to  avoid  reaching  the
limits of the AO, which can happen in DEC if the polar alignment is not perfect, or
in RA if the periodic error of the mount is too high. These pulses can be sent via a
dedicated  autoguide  cable  from  the  AO  to  the  mount,  or  just  using  the  main
connection with the telescope (ASCOM, USB, serial port, etc.).
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These pulses need to be calibrated, it's required to measure the apparent speed in
RA and DEC and the rotation of the AO. The procedure ("Calibration") is described
in the chapter about Autoguide.

8 Scripts

A script  is  a  list  of  commands  which  are  executed  in  sequence.  Using  scripts  it's
possible to perform complex tasks, like supernova and asteroid search. 

The script language of Astroart is based on BASIC, see: en.wikipedia.org/wiki/Basic

Try this example after having connected the Camera Simulator:

Camera.Start(10)

Camera.Wait

Image.Save("C:\Temp\sample.fit")

The first command starts a 10 seconds exposure, the second command waits until
the  end  of  the  exposure,  the  last  command  saves  the  image.  To  learn  the  script
features,  try  indoor  all  the  demos  available  in  the  Menu:  all  simulators  will  be
connected  automatically.  Take  a  look  also  at  the  Script  section  of  the  Astroart
Forum.

Library.  Once  you  have  written  your  scripts  you  may  add  them  to  the  Library
menu, so that they are accessible with a simple click.

http://en.wikipedia.org/wiki/BASIC
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Template for images. This command asks you to select a list of files, then creates a
template for analyzing or processing them.

Undo.  To  undo  the  last  changes  to  the  script,  right  click  on  the  editor  for  the
context menu.

8.1 Script Types and Variables

Four  types  are  supported:  numbers  ,  strings  ,  booleans  and  arrays.  A  numeric
variable contains a number, a string variable contains some text, a boolean is "true"
or "false".

Numeric variables

They contain a  number.  The  number  is  internally  represented by a  floating  point
value with double precision (64 bit, 15 digits). Example: 

x = 10.5

y = x + 1

String variables

A string variable contains text.  This text may be a  single row or  a  multi-line text.
The maximum size is 64 MByte. You may append the dollar sign ($) to the variable
name to remember that it contains a string.

a = "Hello"

b = a + "World"   

The variable b now contains the string "HelloWorld". 

A  single  character  of  a  string  can  be  read  using  square  brackets:  referring  to  the
previous  example  a[1]  returns  "H"  and  a[2]  returns  "e"  and  so  on.  If  the  index
exceeds the length of the string then it restarts from the beginning, so a[6] returns
"H".

A single row of a multi-line string can be read using curly brackets. Example, if a
contains:

"This is a 

text placed on 

three rows" 

Then  a{2}  returns  "text  placed  on".  The  function  count(a)  returns  how  many
lines are contained in a multi-line string (3 in our example).

Boolean variables

A boolean can have only two values: true and false. 
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b = false

b = 5 > 2  ; b now contains true, try now: "print b"

Booleans  are  type-compatible  with  numbers.  Just  like  in  most  languages,  zero
means "false" and every non-zero means "true". The following instructions have the
same meaning:

if b then print  ... / ...  if b = true then print  ... / ...  if b = 1
then print ... 

Array variables

An array is a list of values, for example: 

dim a = {1, 99, "Hello", 42}  ... / ...   dim b(4)

every element of the array can be accessed using brackets,  for example:  print a
(4) . The index starts at 1, and ends at 4 in the previous example. The last index
can  be  found  with  the  standard  function:  UBound(a).  Arrays  can  be  passed  and
returned from functions.

Reserved words

The following words are reserved and cannot be used as variables names (see the
documentation available for VBScript, Visual Basic or any other BASIC compiler):

IF  THEN  ELSE  OR  AND  NOT  MOD  REM  FOR  NEXT  STEP  EXIT
BREAK  CONTINUE  WHILE  GOTO  GOSUB  PRINT  INPUT  END  SUB 
FUNCTION  CLS  DIM

Comments

To write a comment into a script use the symbol " ' ", example:

' This is a comment

8.2 Script Functions

USER DEFINED FUNCTIONS

User  defined  functions  (subroutines)  can  be  defined  everywhere  within  a  script,
using the keyword "Sub" or "Function":

sub PrintSum(a,b) 

  print a+b

end sub

User subroutines can return one or two values, so actually they are "functions":

function mySum(a,b,c) 

  return a+b+c

end function

print "the sum is: "; mySum(4,6,2)
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another example:

sub PolToRect(r,a) 

  return r*cos(a),r*sin(a)

end sub

x,y = PolToRect(10,pi/4)

The following example calculates ra and dec at south, for parking.

myLon = 12.5 : myLat = +45

ra,de = AltazToEquat(180,+5,myLon,myLat)

  

See also: Demo scripts

LIBRARY FUNCTIONS

Most  of  these  function are  standard  in  the  Basic  language,  so  it's  possible  to  find
more information with an internet  search:  <function name>  BASIC,  for  example:
"ucase basic". See also the demo scripts in the menu of the Script Window.

Numeric functions
PI()  Sin(n)  Cos(n)  Tan(n)  Exp(n)  Ln(n)  Log10(n)  Log2(n)
 Sqr(n)  Abs(n)  Rnd([n])  Sgn(n)  Fix(n)  Int(n)  Round(n[,
n])  Frac(n)  ASin(n)  ACos(n)  ATan(n)  ATan2(n,n)  Sinh(n) 
Cosh(n)  Tanh(n)  ASinh(n)  ACosh(n)  ATanh(n)  DegToRad(n) 
RadToDeg(n)  Modulo(n,n) 

String functions
Len(s)  Val(s)  Asc(s)  UCase(s)  LCase(s)  LTrim(s)  RTrim(s)
 Chr(s)  Str(n)  Mid(s,n,n)  Hex(n)  Left(s,n)  Right(s,n) 
LTab(s,n)  RTab(s,n)  Instr([n],s,s)  InstrRev(s,s,[n]) 
Format(s,n)  Crlf()  OpenText(sfile)  SaveText(s,sfile) 
AppendText(s,sfile)  CopyText(s)  PasteText()

Other functions
Pause(n)  Speak(s)  Beep()  CreateDir()  FindDirs(s,s) 
FindFiles(s,s)  IsNumber(var)  IsString(var)  IsBoolean(var) 
IsArray(var)

Time and Coordinate functions
JD()  Time()  Date()  UTDateTime([jd])  SideralTime(lon,[jd])
DateToJD(y,m,d)   JDToDate(jd)  LTBias()  Culmination(ra,de,
lon,lat,[jd])  EquatToAltaz(ra,de,lon,lat,[jd])  AltazToEquat
(azi,alt,lon,lat,[jd])  PrecessionJ2000(ra,de)  PrecessionJNow
(ra,de)  Precession(jdFrom,jdTo,ra,de)  RA(n)  DEC(n) 
DistanceFromMoon(ra,de)  DistanceFromSun(ra,de)  DistanceEquat
(ra1,de1,ra2,de2) SunRaDec(jd)  MoonRaDec(jd) 
ObjectCoordinates(name)  ObjectMagnitude(name)  Observatory.
Longitude  Observatory.Latitude
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Camera functions

Camera.Start(time,[shutter])

Starts  an  exposure  of  <time>  seconds.  Set  <shutter>  to  zero  to  integrate  a  dark  frame.
Example: Camera.Start(30,0) takes a dark frame of 30 seconds.

Camera.Wait

Waits until the end of the exposure.

Camera.Exposing

Returns the boolean "true" if a exposure is in progress, otherwise "false".

Camera.Binning(mode)  Guider.Binning(mode)

Sets the binning mode. <mode> is a index to the binning list  in the Settings Page of the
Camera Panel. Example: Camera.Binning(2)

Camera.Subframe(w,h,x,y)

Sets a subframe for future exposures. All number are expressed as percentage. The example
sets a subframe of half size (50%) shifted by 25% so that it's centered on the CCD: Camera.
Subframe(50,50,25,25)

Camera.Connect([driver])  Guider.Connect([driver])  Camera.
Disconnect

Connects  or  disconnects  the  camera.  Disconnecting  the  main  camera  disconnect  also  the
guider. Example: Camera.Connect()  Camera.Connect("Simulator")

Camera.Connected  Guider.Connected

Checks the camera connection and returns true or false.

Camera.SelectDarkFrame  Camera.EnableDarkFrame(enable)

Select the current image as dark frame and enables the correction for the following images.

Camera.Stop  Guider.Stop  Guider.Close

Stops the current exposure or an autoguide session (some cameras are not able to stop an
exposure).

Camera.GetTemperature  Guider.GetTemperature

Returns the current temperature of the CCD.

Camera.SetTemperature(t,[power])  Guider.SetTemperature(t,[power])

Sets  the  temperature  and  starts  cooling.  It’s  also  possible  to  set  the  power  of  the  cooler
(0..100%).

Guider.SetExposureTime(time)

Sets the exposure time used for autoguide (maximum 3 seconds).

Camera / Guider.StartAutoguide(...) () - (r) - (r,x,y) - (r,snrel) - (r,snrel,
satmax,expo)

Starts an autoguided session. It's possible use some parameters to select the radius of the
subframe and its  coordinates,  otherwise  this  command  takes  a  sample  image  and  selects
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automatically  the  best  star.  It's  possible  to  define  a  minimum  relative  S/N  for  that  star,
(default  =  1.0),  a  maximum  saturation  value  and  the  exposure  time.  Example:  g  =
Camera.StartAutoguide() : if g then [.. star found and autoguide active]

Camera / Guider.StopAutoguide()

Stops an autoguide session.

Camera.FullframeAutofocus(...) (time) - (time,darks,count,step,binning)

Starts a full frame autofocus. Example: Camera.FullframeAutofocus(5) starts focusing
with  an  exposure  of  5  seconds,  using  the  parameters  saved  previously  in  the  autofocus
window.

Camera.Autofocus(...) () - (r) - (r,x,y) - (r,snrel) - (r,snrel,satmax,expo)

Starts  a  subframe  autofocus  session.  The  parameters  are  the  same  of  the  function
StartAutoguide().

Guider.ShortExposure

Starts a full frame short exposure with the guider camera.

Guider.WaitStar

Stops the script until the guide star is returned to the central position.

Guider.LostStar

Returns true if it's not possible to center the guide star.

Guider.MoveReference([dx,dy])

Changes the x and y coordinates of the reference star, to perform the "dithered guide". If dx
and dy are not specified then the shift will be pseudo-random.

Guider.FullFrameAutoguide

Starts a full-frame autoguide sessions.

Guider.AutoguideStatus

Returns the full-frame autoguide status as a string ("Guiding", "Calibrating", "Stopped", etc).
To wait for settling just make a loop until the status is "Guiding".

Guider.Calibrate  Guider.CalibrationOK

Starts  the  full-frame  calibration  and  blocks  the  script  until  done.  Use  the  command
CalibrationOK to check for the result.

GuideLog.Text

Returns the log file of the guide window as a string.

Telescope functions
Telescope.Connect  Telescope.Disconnect  Telescope.Connected

Connects or disconnect the telescope.

Telescope.Ra  Telescope.Dec  Telescope.RaDec

Returns the current coordinates of the telescope. Example: ra,de = Telescope.RaDec
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Telescope.Goto(ra,dec)

Moves  the  telescope  to  the  equatorial  coordinates:  ra  (0..24),  dec.  (-90..+90).  Example:
Telescope.Goto(23.4, 45.1)

Telescope.Wait([ra,dec,delta])

Waits  until  the  telescope  has  completed  a  Goto.  On  some  telescopes  the  base  function
Telescope.Wait() is not supported, so you may use the syntax: Telescope.wait(ra,
dec,delta)  which  waits  until  the  telescope  is  arrived  at  coordinates  ra,dec,  with  a
precision of delta degrees, for example 0.005 for a few arcseconds. Then in the script add a
Pause() to wait a few seconds.

Telescope.Pulse(dir [,time])

Moves the telescope for <time> seconds towards the <dir> direction ("N","S", "E","W"). If
<time> is negative then the direction is inverted. If <time> is omitted, it moves until the
Telescope.Stop command. Example: Telescope.Pulse("N", 0.5)

Telescope.SyncTo(ra,dec)

Sets the telescope internal coordinates.

Telescope.Stop

Stops the telescope.

Telescope.Speed(n)

Sets the speed for Pulse motion. (1=guide, 2=center, 3=find, 4=slew). It's  not  supported
by all telescopes.

Telescope.Send(string)  Telescope.Receive

Sends  and  receives  a  string  to  the  telescope  via  the  serial  port.  Example:   Telescope.
Send(“#Hc#”) : R = Telescope.Receive

Telescope.Park  Telescope.Unpark

Parks/Unparks the telescope. They work only with GOTO or ASCOM protocol.

Telescope.StartTracking  Telescope.StopTracking  Telescope.
Tracking

Starts/Stops/Reads the sideral tracking. They work only with GOTO and ASCOM protocol.

Telescope.AOCenter

Sets the Adaptive Optics mirror/prism to the central position.

Telescope.List.Open(file)  Telescope.List.Save(file)

Opens or saves a text file which contains objects and coordinates. See the Telescope Goto
window.

Telescope.List.Count

Returns how many objects are listed in the list.

Telescope.List.Ra(index)  .Dec(index)  .Name(index)  .Comment(
index)
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Returns a field of the i-th object of the list.

Telescope.List.Sort

Sorts the list, using a compromise between a shortest path algorithm and a increasing RA
algorithm.

Telescope.List.Delete(index)  Telescope.List.Clear

Deletes objects from the list.

Filter wheel functions
Wheel.Connect  Wheel.Disconnect  Wheel.Connected

Connects or disconnects the filter wheel.

Wheel.Filters

Returns the number of filters of the filter wheel.

Wheel.Goto(n)  Wheel.Goto(filter)

Moves  the  filter  wheel  to  the  given  filter.  Examples:   Wheel.Goto(4)  ,  Wheel.Goto
("R")

Wheel.Wait

Wait until the movement is complete. On wheels which don't support this feature a time in
seconds will be used. See the Filter wheel window.

Wheel.Position  Wheel.PositionName

Return the number or the name of the current filter.

Focuser functions
Focuser.Connect  Focuser.Disconnect  Focuser.Connected 
Focuser.ConnectASCOM

Connects or disconnects the focuser.

Focuser.Position

Returns the current position.

Focuser.GotoAbsolute(n)

Moves the focuser to a given position.

Focuser.GotoRelative(delta)

Moves the focuser up or down by a specified amount. Example: Focuser.GotoRelative
(-50)

Focuser.Wait

Waits until the movement is complete.

Focuser.IsMoving

Returns true if the focuser is moving.

Focuser.Temperature
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Returns the temperature, it could be used as ambient temperature.

Dome functions
Dome.Connect  Dome.Disconnect  Dome.Connected

These functions are intended for connection with the ASCOM hubs, for example "POTH" or
"DeviceHub", where the movement of the dome is controlled by ASCOM. Your scripts will
just open or close the window, or park the dome. Example:

Dome.Connect("ASCOM.DeviceHub.Dome")  ,  Dome.Connect("POTH.Dome")  ,  Dome.
Connect("Simulator")

By the way, if your dome is fixed and you only need to open and close it, you can directly
connect with its driver. To find out the name of this driver, the first time use the following
code:

Dome.Connect("ASCOM.Chooser") : Print Dome.Name : Dome.Disconnect

Dome.OpenShutter  Dome.CloseShutter  Dome.ShutterStatus

Opens  or  closes  the  window.  The  Status  is  a  number  0..5,  for  more  information  see  the
official ASCOM docs, do an internet search: "ASCOM Dome Class".

Dome.Park  Dome.AtPark  Dome.FindHome  Dome.AtHome

Parks the dome or returns the current status.

Dome.Slewing

Returns true if the dome is moving. See the Demo scripts for a procedure which waits until
the dome is no longer moving.

Dome.GetSlaved  Dome.SetSlaved(true/false)

Reads of sets the "slaved" status of dome, usually you need to disable it before closing the
dome.

PHD Guiding functions
PHD.ConnectDevices  PHD.DisconnectDevices

Connects or disconnects the devices used by PHD Guiding.

PHD.Pause  PHD.Resume  PHD.Stop 

Pauses, resumes or stop the guiding.

PHD.Guide  PHD.CalibrateAndGuide

Starts  guiding.  It's  possible  to  specify  the  three  parameters  for  settling  (pixels,  time,
timeout)  as  described  in  the  PHD  EventMonitoring  interface:  https://github.com/
OpenPHDGuiding/phd2/wiki/EventMonitoring , for example: PHD.Guide(1.5, 8, 50).

PHD.Dither(pixels) 

Request  a  shift  of  the  reference  position.  Again  it's  possible  specify  the  extra  three
parameters for settling (pixels, time, timeout).

PHD.Status 

Returns a string which indicate the status, see "AppState" in the site above.  For example:

https://github.com/OpenPHDGuiding/phd2/wiki/EventMonitoring
https://github.com/OpenPHDGuiding/phd2/wiki/EventMonitoring
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"Guiding" , "Calibrating", etc. See the demo script.

Image functions

Image.Open(filename)

Opens an image from disk. Example: Image.Open("C:\moon.tif")

Image.Save(filename)  Image.SaveView(filename)

Saves the current image. "SaveView" saves with a graphic format (jpg, bmp, etc.). Example:
Image.Save("C:\images\saturn.fit")

Image.Close  Image.CloseLast  Image.ClosePrevious

"Close"  closes  the  current  active  image.  "CloseLast"  instead  closes  the  last  opened  image.
"ClosePrevious" closes the previous opened image.

Image.Rename(name)  Image.Filename()

Renames  the  current  image  or  get  the  current  name.  Example:   Image.Rename
("jupiter.fit")

Image.GetKey(key)  Image.GetKeyString(key)

Reads values (both strings and numbers) from the FITS header. If the key is not found then
zero or an empty string is returned.

Image.SetKey(key,value) Image.DeleteKey(key)

Writes values (both strings and numbers) into the FITS header. Examples: Image.SetKey
("COMMENT", "Bad seeing")  Image.SetKey ("JD", 2453709.22791)

Image.FlipH  Image.FlipV  Image.Resize(x,y)  Image.Rotate(a) 
Image.Binning2x2

These functions modify the current image. Example: Image.Resize(320,240)

Image.Crop(x1,y1,x2,y2)

Removes the outer parts of an image, keeping the subframe defined by the two points x1,y1
and x2,y2.

Image.Ra ([x,y])  Image.Dec ([x,y])  Image.RaDec ([x,y])  Image.XY
([ra,dec])

Returns  the  coordinates  of  the  center  plate,  if  the  image  is  astrometrically  calibrated.  It's
also possible to convert the coordinate of a given point from x,y to ra,dec and vice versa.
Example:  ra,de = Image.RaDec() ,  ra,de = Image.RaDec(440, 186)

Image.EstimateRaDec

If the image is not astrometrically calibrated, returns the approximate coordinates as read
from  the  telescope  keywords  in  the  FITS  header.  Otherwise,  it  returns  the  exact
coordinates of the center plate.

Image.DistanceFrom(ra,de)

Returns the distance from the given coordinates to the center plate, in degrees.

Image.BlinkAlign
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Temporary aligns the current image with the previous one and blinks them.

Image.Align

Aligns the current image with the previous one.

Image.FindCoordinates (ra,de,stars,[side],[fovarcmin])

Finds the center  plate via plate solving.  It's  possible to  set  the side of  the search  zone in
degrees, default is 2°x2° and the field of view in arcminutes.

Image.MaxValue  Image.MinValue  Image.Width  Image.Height 
Image.Rotation  Image.Average  Image.StandardDeviation  Image.
Background

Calculates some statistics on the current image.

Image.GetPixel(x,y)  Image.SetPixel(x,y,v)  Image.Update

Read  and  write  single  pixel  over  the  image.  After  having  written  some  pixels  call  the
function "Update".

Image.Visualize([vMin, vMax, vExp])  Image.Zoom(percentage)  Image.
CenterView(x,y)

Updates the visualization of the image, you may set the black and white thresholds and the
exponent of the transfer function (negative for logarithmic).

Image.Macro(n)

Launches one of the four macros defined in Astroart. Example:  Image.Macro(2)

Image.Formula(s)

Applies  a  formula  over  the  image.  See  the  documentation  about  Formula,  example:  
Image.Formula("v+500")

Image.AddConstant(n)  Image.MulConstant(n)

Adds or multiplies the image with a given constant.

Image.FWHM

Calculates the average width and height of the stars of the image, to evaluate focus or good
tracking:  wx,wy = Image.FWHM

Image.Focus([method])

Calculates  the  average  focus  of  the  stars  of  the  image,  from  0.0  to  1.0.  It's  possible  to
specify the algorithm (1 .. 4), see the Autofocus Window.

Image.JD

Gets  the  time  of  exposure.  Example:  midJD  =  Image.JD  +  Image.GetKey
("EXPTIME")/3600/24/2

Points and Rectangles
Image.GetPoint  Image.GetPointX  Image.GetPointY

Returns the coordinate(s) of the selected point (or selected star, or rectangle) on the current
image.
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Image.Points.Get(i)  Points.GetX(i)  Points.GetY(i)

Returns the coordinate(s) of the i-th selected point over the image.

Image.Points.Count 

Returns how many points are selected.

Image.Points.Add(x,y)  Image.Points.Clear 

Adds a points at coordinate x,y, or delete all points.

Image.Rectangle.X1  .Y1  .X2  .Y2 

Returns the coordinates of the selected rectangle.

Stars

Image.Stars.Find(n)

Finds  and  select  the  N#  brightest  stars  in  the  image.  They  will  be  also  sorted  with  the
brightest first.

Image.Stars.Count

Return how many stars are selected over the image.

Image.Stars.Ra(i) .Dec(i) .ADU(i) .SN(i) .X(i) .Y(i) .Mag(i) .
OCMag(i) .OCPos(i) .FwhmX(i) .FwhmY(i) .ARef(i) .PRef(i)

Returns a field of the i-th star of the image. Example:  adu = Image.Stars.ADU(4)

Image.Stars.Add(ra,de)  Image.Stars.Clear

Adds to the list a star at ra,de coordinates in degrees or clears the list.

Image.Stars.Open(filename)  Image.Stars.Save(filename)

Opens and saves the star list to disk.

SetStarAperture(signal, gap, background)

Configures the size of the circles used to collect stars, see Preferences.

SetCameraSN(gain, readout, current)

Configures the parameters to calculate the Signal/Noise of stars. see Preferences.

Mask
Image.Mask.Active

Returns true or false, depending if a mask is active.

Image.Mask.GetPixel(x,y)

Returns the value of the mask for a given pixel, from 0.0 to 1.0. 

Image.Mask.X1  .Y1  .X2  .Y2

Returns the coordinates of a rectangle which contains the masked region.

Serial port functions

Serial.Connect(port, [baudRate])  Serial.Disconnect()
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The serial port is used to send commands to custom hardware.  By default the protocol is
9600 baud 8N1. Disconnection is automatic when a script terminates. Example: Serial.
Connect(1). After connection a pause of 1 second is recommended.

Serial.Send(string)  Serial.Receive()

Sends and receive string data from the serial  port.  Example:   Serial.Send("#GH#") :
Pause(0.1) : r = Serial.Receive()

System functions

System.Execute(filename)

Starts  an  external  program.  Example:   System.Execute("C:\Windows\Notepad.
exe myfile.txt")

System.Broadcast(message, wparam, lparam)

Sends a Windows Message to all windows. This can be used to control other programs. It's
equivalent  to  the  following  C++  code:  h  =  RegisterWindowMessage(message)  ;
SendNotifyMessage(HWND_BROADCAST, h, wparam, lparam) 

Output functions
Print

Prints a text on the "Script output" panel.

Print [ expression [, expression] [; expression] ]  

Every expression must be separated by a semicolon or comma; if semicolon is used then a
space  is  added  between  the  writings.  If  comma  is  used  then  a  TAB  separator  is  added
between the writings. Example: Print "Some math" ; 3+7 ; 4*4*4 ; pi  will print
three numbers with up to 10 significant figures.

Output.Save(filename)  Output.Append(filename)

Saves the output panel to disk. Remember that it's possible to save strings to disk also with
the functions: SaveText(s, filename) and AppendText(s, filename).

Output.Copy

Copies the output panel to the Clipboard.

Output.Text

Returns the output panel as a string.

Output.SetLines(n)

Sets the number of lines displayed.

Message(text)  Warning(text)

They  show  a  dialog  window  and  wait  until  the  user  press  "OK".  Example:   Message
("Ready to start").

Input functions
Input

Shows a dialog window where the user can enter data with the keyboard. 
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Input [ <Question> , ] variable  

Use this function to ask the user for input values. If the user doesn't press the "OK" button
then  zero  or  an  empty  string  is  returned,  depending  how  the  variable  was  initialized.
 Example:  

Input "How old are you ?", y 
Input "Your name ?", name 
Print name ; "is"; y ; "years old"

InputButton

Shows a dialog window with up to 12 buttons where the user can click a choice. Example:

resp  =  InputButton("Park  the  telescope?",  "Yes",  "No",
"Later")
if resp = "Yes" then
  print "Now parking..."
else
  print "Let's continue..."
end if

A simple function for asynchronous input is: KeyboardCTRL() which returns true if  the
CTRL key is currently pressed and the script window is active.

8.3 Loop Instructions

Two loop instructions are supported: For and While. The following example prints
the numbers from 1 to 10, "a" is the control variable: 

For a = 1 to 10
  Print a 
Next a 

FOR - NEXT loops

For <variable> = <expression> To <expression> [Step <constant>] 

... 

... 

Next <variable> 

Examples:  

For angle = 1+asin(0.4) to 1+asin(0.75) Step 0.1 
  Print angle 
Next angle

sum = 0
For y = 1 To 5 
  For x = 1 To 10 
    z = x*y : Print z : sum = sum+z 
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  Next x 
Next y
Print sum

WHILE - ENDWHILE loops

This instruction evaluates a condition at the beginning of the loop. If the condition
is  false  then  the  cycle  stops  and  execution  continues  after  the  EndWhile
instruction. Example:  

a = 1 
While a <= 10
  Print a 
  a = a+1 
End While 

BREAK and CONTINUE instructions

The Break instruction is used to exit from For/Next and While/EndWhile loops. In
this example the loop stops when "a" becomes greater than 5.  

For a = 1 to 10 
  Print a 
  If a > 5 Then Break 
Next a 

The  Continue  instruction  acts  as  a  Next  instruction.  A  new  iteration  starts
immediately.  

For a = 1 to 10 
  Print a 
  If a > 5 then continue 
  Print "Test"
Next a

8.4 Conditional Instructions

The IF - THEN instructions evaluates a logical expression and determines the flow
of the program based on the result of that expression. For example:  

a > 5 AND exts = ".fits" 

a >= 3 OR NOT (b <> 5 and b+3 = c)  

Precedence of operators

(Higher precedence).

( )

<   >   <=   >=   <>   = 

NOT 

AND 

OR 

(Lower precedence).  

Syntax
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IF <logical expression> THEN 

... 

... 

[ELSE] 

... 

... 

END IF

Compact Syntax

IF <logical expression> THEN <instructions> ELSE <instructions> 

"IF" instructions can be nested without limits. The "ELSE" part is optional. Example:
  

FOR a = 1 TO 10
  IF a < 6 THEN print "-" ELSE print "+"
NEXT a 
 
FOR a = 1 TO 10
  IF a < 6 THEN 
     print "-"
     IF a = 5 THEN print "Half work" 
  ELSE 
     print "+"
     IF a = 10 THEN print "The end"
  ENDIF
NEXT a 

8.5 Demo scripts

Several demo scripts are available in the context menu of the Script Window. Here
is a selection from that menu and from the Astroart Forum.

Simple Loop

for i = 1 to 8

  print i, SquareNum(i)

  if i = 4 then print "half work"

next i

function SquareNum(v)

  return v*v

end function

Arrays-lists ("dim" is optional)

dim a = {1, 99, "Hello", 42}

PrintList(a)
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dim b(4)

b(1) = 1  

b(2) = 99

b(3) = "GoodBye"

b(4) = 43

PrintList(b)

sub PrintList(arr)

  for i = 1 to UBound(arr)

    print arr(i)

  next i

end sub

Reading pixels inside a rectangle

x1 = Image.Rectangle.X1

y1 = Image.Rectangle.Y1

x2 = Image.Rectangle.X2

y2 = Image.Rectangle.Y2

if x1 = x2 then

   print "Please select a rectangle"

   end

end if

cnt = 0

sum = 0.0

for y = y1 to y2

for x = x1 to x2

   sum = sum + Image.GetPixel(x,y)

   cnt = cnt + 1

next x

next y

print "Average inside rectangle = " + Str(sum/cnt)

Reading pixels inside a mask

if not Image.Mask.Active then

   print "Please select a mask over the image"

   end

end if

x1 = Image.Mask.X1

y1 = Image.Mask.Y1

x2 = Image.Mask.X2

y2 = Image.Mask.Y2
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cnt = 0

sum = 0.0

for y = y1 to y2

 for x = x1 to x2

   m = Image.Mask.GetPixel(x,y)

   if m < 0.5 then continue

   sum = sum + Image.GetPixel(x,y)

   cnt = cnt + 1

 next x

next y

print "Average of masked region = " + Str(sum/cnt)

Simple camera control

Camera.Binning(1)

Camera.Start(10)

Camera.Wait

Image.Rename("Hires.fit")

Camera.Binning(2)

Camera.Start(10)

Camera.Wait

Image.Rename("Lores.fit")

Simple telescope control

x = Telescope.RA

y = Telescope.DEC

Message("Position: " + RaToString(x) + DecToString(y))

Pause(1)

Message("Moving telescope 5°North 5°East")

Telescope.Goto(x+(5/15), y+5)

Telescope.Wait

Warning("Telescope arrived")

Simple 2x2 mosaic

ra = Telescope.RA

raStep = 12/60/15    ' 12 arcmin RA step

de = Telescope.DEC

deStep = 8/60        ' 8 arcmin DEC step

for n = 1 to 4

  if n = 2 then ra = ra + raStep

  if n = 3 then de = de + deStep
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  if n = 4 then ra = ra - raStep

  Telescope.Goto(ra,de)

  Telescope.Wait

  Camera.Start(5)

  Camera.Wait

  Image.Rename("Part_" + Str(n))

next n

Configurable NxN mosaic

n = 3                ' 9 images

exposure = 5.0

ra = Telescope.RA

raStep = 12/60/15    ' 12 arcmin RA step

de = Telescope.DEC

deStep = 8/60        ' 8 arcmin DEC step

for y = 1 to n

  for x = 1 to n

    Telescope.Goto(ra, de)

    Telescope.Wait

    Camera.Start(exposure)

    Camera.Wait

    Image.Rename("M_" + Str(y) + Str(x))

    ra = ra + raStep

  next x

  ra = ra - raStep*n

  de = de + deStep

next y

Configurable sequence

dir = "C:\Temp\"

object = "M42"

closePreviousImage = false

'   Images, Exposure, Binning, Filter

Sequ(4,  5.0, 2, "R")

Sequ(4,  5.0, 2, "G")

Sequ(4,  5.0, 2, "B")

Sequ(2, 10.0, 1, "C")

Sub Sequ(images,exposure,binning,filter)

  Camera.Binning(binning)

  if filter <> "" then 
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     Wheel.Goto(filter)

     Wheel.Wait

  end if

  for i = 1 to images

     Camera.Start(exposure)

     Camera.Wait

     fileName = object + filter + Format(i,"000")+ ".fit"

     Image.Save(dir + fileName)

     if closePreviousImage then Image.ClosePrevious

     closePreviousImage = true

     print dir + fileName

  next i

End Sub

Detecting daytime and nighttime

myLon = 12  ' positive if East

myLat = 44  ' North

al = SunAlt

if al < -15 then

   print al; "= nighttime"

else

   print al; "= daytime"

end if

sub SunAlt

  ra,de = SunRaDec(JD)

  az,al = EquatToAltaz(ra,de,myLon,myLat,JD)

  return al

end sub

Detecting star trails

shape = "OK"

wx,wy = Image.FWHM

if wx > wy * 1.3 then shape = "Elongated X"

if wy > wx * 1.3 then shape = "Elongated Y"

if wx = 0 then shape = "No stars found"

print shape ; ":" ; wx ; wy

Pausing and continuing (press the button "Run" to resume).

For i = 1 to 8

  Print i, i*i
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  Pause(9999)

Next i

Waiting for PHD guide settling

while true

  if PHD.Status = "Guiding" then break

  Pause(2)

end while

or, to don't wait forever:

for i = 1 to 100

  if PHD.Status = "Guiding" then break

  Pause(2)

  if i = 100 then .....

next i

Waiting until the dome is not moving (max. 60 seconds)

Sub DomeWait

  for i = 1 to 60

    if not Dome.Slewing then break

    Pause(1)

  next i

End Sub 

Imaging and stacking in realtime

expo = 3.0

for i = 1 to 10

   if i = 1 then

      Camera.Start(expo)

   else

      Camera.StartAndStack(expo)

   end if

   Camera.Wait

next i 

8.6 Automatic research script

A script for automatic research may control the telescope, the camera and the filter
wheel. 

Telescope and camera script

Usually it consists of three tasks:

1. Open a list of objects (example: variable stars, galaxies, etc.)
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2. Setup a loop.

3. For every cycle, move the telescope, select the filter, take an image and save it.

For step (1) two methods are possible:

A) The function "Telescope.List.Open(filename)" which loads a list of objects
(see  Telescope  Goto  page).  Eventually  inside  the  script  it  is  possible  to  use  the
commands  "Telescope.List.Name(index)",  "Telescope.List.Ra(index)"
and "Telescope.List.Ra(index)".

B)  The  function  OpenText(filename)  which  loads  any  text  file  into  a  string
variable. This multi-line string can be parsed using the functions "Mid", "Val", etc.

Example (the object list was already opened):

n = Telescope.List.Count

for i = 1 to n

  ra = Telescope.List.Ra(i)

  de = Telescope.List.Dec(i)

  name = Telescope.List.Name(i)

  print n; name, ra; de

  Telescope.Goto(ra,de)

  Telescope.Wait

  Pause(4)

  Camera.Start(120)

  Camera.Wait

  Image.Save("c:\images\2015\" + name + ".fit")

  Image.Close

next i

Autocenter script

The autocenter script centers the object after a GOTO, using the “Find coordinate”
(plate  solving)  feature of  Astroart  5.  There  are  two versions  of  the  script,  the  first
one uses the “resync” command of the telescope:

' < Get ra,de from your object list>

' < nstars = 4, or 5 if you set an high error >

' <                  in Find coordinates parameters >

....

Image.FindCoordinates(ra,de,nstars)

dist = Image.DistanceFrom(ra,de)

if dist > 0.1 then

   print "Centering telescope..."

   Telescope.SyncTo(Image.RA,Image.DEC)

   Telescope.Goto(ra,de)

   Telescope.Wait

endif
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The function “Image.FindCoordinates()” calibrates the image via plate solving. The
result is “1” on success or “0” for failure. In the example above we don’t check the
return value since the check is performed by the next instruction:

The  function  “Image.DistanceFrom()”  calculates  the  distance  in  degrees  between
the center plate and the given coordinates. If the image is not calibrated, it returns
“0”.  As  you  can see,  if  the  distance  is  higher  than  0.1  degrees  (6  arcminutes)  the
telescope is synced to the corrected coordinates and a small  GOTO is executed to
the object.

This script is safe since a failure in FindCoordinates() does not move the telescope
to  a  wrong  position.  Depending  your  system  you  may  reduce  the  maximum
distance to 0.05 degrees (3 arcminutes). Before using this command it’s mandatory
to calibrate the Find Coordinates parameters, as explained in the Reference chapter.
 

Another script is the following one: it doesn’t need a centering GOTO, nor a resync,
but  the  first  displaced  image  is  not  corrected  so  the  maximum  “dist”  must  be
smaller.

raOff = 0

deOff = 0

...

' <start of cycle>

' <raObj,deObj = read from the object list>

 ra = raObj - raOff

 de = deObj - deOff

' <Telescope GOTO towards ra,de>

 Image.FindCoordinates(ra,de,nstars)

 dist = Image.DistanceFrom(ra,de)

 if dist > 0.05 then

    raOff = Image.RA - raObj

    deOff = Image.DEC - deObj

 endif

 ....

This  script  simply  keeps  track  of  the  difference  between  the  real  coordinates  (as
measured by FindCoordinates)  and the object  coordinates.  This  difference  is  then
stored  in  raOff  and  deOff  to  correct  the  next  GOTO.  This  make  since  the  error
increases with time, so this script is useful on a list of many objects (e.g. supernova
search).

Measuring the offset in RA and DEC can also be used to in the first example, if your
telescope  does  not  support  the  Resync()  command  then  you  may  emulate  it  with
the sequence:

....

if dist > 0.05 then

    raOff = Image.RA - raObj
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    deOff = Image.DEC - deObj

    Telescope.Goto(raObj - raOff, deObj - deOff)

    Telescope.Wait

 endif

....

Blink and align script

The  function  “BlinkAlign()”  automatically  aligns  two  images  and  blinks  them,  to
help you in comparing the images. This is useful for search of asteroids, supernovas
and comets.

Example: open one image from a recent session, then execute the following script:

mydir = "D:\Astroimages\OldReferences\"

Image.Open(mydir + Image.Filename)

Image.BlinkAlign

Image.Close

Image.Close

Where mydir is a folder of old images of the same field. This reference image will
be opened, compared to the new one, then both images will be closed. To compare
another  pair  of  images,  open the next  one from the  recent  folder  and execute  the
script again. The whole procedure could be make fully automatic iterating through
all images of the recent folder, here is a sample script:

new = "D:\Astroimages\NewImages\"

old = "D:\Astroimages\OldReferences\"

im = FindFiles(new,"*.fit")

n = Count(im)

for i = 1 to n

  Image.Open(new + im{i})

  Image.Open(old + im{i})

  Image.BlinkAlign

  Image.Close

  Image.Close

Next i

See all the demos (click the "menu" button) for more examples.

9 Image Processing

This chapter describes the main techniques of image processing and how they can
be performed with Astroart.

9.1 Introduction

A digital image is a rectangular array of pixels (picture elements).

The  location  of  a  pixel  is  expressed  as  (x,y),  called  "coordinates",  while  the  pixel
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value at that location is designated as I(x,y). In a image with X columns and Y rows
the valid range for is 0 <= x <= X-1 and 0 <= y <= Y-1. In Astroart  the origin
(x=0, y=0) is on the lower left corner, just like in the FITS standard.

Pixel  values  can  be  expressed  in  different  units  of  measurements:  in  images
acquired  with  professional  cameras  these  units  are  called  ADUs  (analog-to-digital
units).

The pixel  values of  an image may be grayscale or  color.  A grayscale  pixel  can be
represented by a number, a color pixel needs three numbers, one for every primary
color (red, green, blue).

It  is  very  common  in  astronomic  cameras  to  acquire  images  with  16  bits  of
dynamic. This means that a grayscale image has a range from 0 (no light intensity,
or full black) to 65535 (full light intensity, or full  white),  in integer steps. Each of
these values need two bytes of storage, so an image with a width and height of 512
pixels will need 512x512x2 = 524288 bytes on disk.

9.2 Stretching filters

These filters modify the contrast and the brightness of some parts of the image, to
highlight the subject. The most used filters are DDP and Histogram Stretch.

For  grayscale  images,  these  filters  can  be  the  first  ones  to  be  applied  after
Preprocessing.
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If  the  image  is  used  for  science  and  shall  not  be  modified,  Astroart  permits  to
simulate these filters with the Visualization.

9.3 Convolution filters

The base of many image processing filters is the convolution product. We know that
a digital image is a matrix of numbers,  the convolution product is a mathematical
operator which multiplies of two matrixes. In our case it involves two matrixes of
notably different dimensions: the image to be elaborated composed by thousand of
elements  (example:  512x512  =  262144  pixels)  and  a  smaller  matrix,  designed  to
filter the image. This matrix is called kernel  because it is the center of all changes
that will affect the original image.

In the figure below the image is represented by the matrix [I]  composed by n x m
elements while the kernel is a square matrix [K] of 3x3 elements.

The convolution product consists of multiplying every pixel of the matrix [I]  with
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the matrix [K], adding every product of the generic pixel I(x,y) with the pixel K(u,v)
of the kernel. In our case 1 <= u <= 3 and 1 <= v <= 3.

In  the  preceding  figure,  all  the  pixels  have  an  intensity  of  100  ADUs  except  that
central  one which  has  150.  If  we perform the  convolution  product  on  the  central
pixel  we get  (150•5)  + (-1•100) + (-1•100) + (-1•100)  + (-1•100).  The  pixels  at
the vertexes of the kernel don't appear in the formula because they are zero. 

At the end of the multiplication the result is divided by the sum of the elements of
the kernel. This last operation doesn't belong to the convolution product itself but
it's required to maintain the dynamic range of the original image.

The  example  above  corresponds  to  a  faint  star  that  collects  all  its  brightness  in  a
single pixel (150 ADU) and a sky background of constant intensity (100 ADU). How
can we underline the presence of this star? We usually say that we have to increase
its contrast, but in which way the contrast should be measured? We can start from: 

Contrast = I(x,y) / N

Where I(x,y) is the intensity of the pixel (ADU) and N the average intensity of the
adjacent pixels. In this case the intensity of the central pixel is (150-100) ADU = 50
ADUs (obviously we have to subtract the background value) while the background
is always 100 ADUs; from the definition we get a contrast equal to 0.5. If we apply
the  convolution  product  defined  above,  we  get  a  new  image  where  the  average
background becomes 75 ADUs and I becomes (350-75) ADU = 275 ADUs, bringing
the contrast to 3.67, seven times greater than the original contrast.

For sake of simplicity, a kernel of 3x3 has been used (nine elements). We can also
consider greater kernels (5x5, 7x7 etc.), obviously a greater kernel is justifiable only
if we want to consider more distant pixels from the central one. Astroart allows the
creation of kernels up to 15x15 (225 elements).

9.4 High Pass filters

The main application of  the convolution  product  is  the  creation of  high  pass  and
low pass filters. A high pass filter emphasizes the high spatial frequencies, (e.g. the
details), therefore we will use it to increase the contrast. A high pass filter is always
characterized by a  kernel  with negative values around the  central  pixel,  as  in  the
following example:
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In  this  image  the  high-pass  filter  was  used  to  enhance  the  details  of  the  famous
planetary nebula M57. An accurate examination of the processed image underlines
some side effects:

Noise  increase.  Especially  in  images  with  a  low  Signal-to-noise  ratio,  the
application of high-pass filters inevitably increases the granularity of the image. 

Ring  effect.  The  effect  of  the  filter  on  stellar  objects  is  positive,  increasing  the
contrast and therefore the visibility over the sky background, and negative, creating
an artificial ring around them. The cause of this ring is well comprehensible if we
observe a  kernel  of  a  high-pass  filter:  the  negative  values  near  the  center  create  a
sort of depression around the star, which somewhere degenerates into an ugly ring,
darker than the overall sky background.

These  side  effects  can  be  prevented  using  an  adaptive  (non  linear)  filter.  For
example: High Pass Adaptive and Deconvolution with a gauss kernel.

9.5 Low Pass filters

The low-pass filter truncates most high spatial frequencies. The result is a softening
of the details of the image and a decrease of the granular noise. 

The  low  pass  filter  made  with  simple  convolution  also  blurs  the  image  details,
(unless  the image was  oversampled),  so  if  there's  no  need to  make  photometry  or
astrometry, a non-linear filter is preferred, see below.

Average filters
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These are a particular case of the low-pass filters.  They replace every pixel  of  the
image  with  the  average  of  the  adjacent  pixels,  including  the  central  pixel.  The
larger the kernel is, the greater it is the "softening" effect of the filter on the image.

In figure we can see an example with the kernel 3x3. Using a kernel 5x5 or bigger
the effect on the image will be very heavy and unnatural.

Median filters

The  median  filters  eliminates  all  isolated  pixels  which  have  an  extremely  high
contrast compared to their neighbors. They are therefore ideal to eliminate defects
of the CCD, usually called "hot pixels" or "cold pixels".

The  median  filter  is  not  a  convolution  filter  but  its  operation  is  similar:  a  kernel
flows  on  all  the  pixels  of  the  image  gathering  them  into  a  list.  Considering  the
example in figure below, the kernel is 3x3 = 9 elements,  these elements  are  then
ordered  from  the  lowest  to  highest:  in  this  example  we  obtain  the  following  9
elements:

412, 420, 430, 432, 434, 435, 437, 440, 1120

The median value of this ordered list is represented by the value at the center of the
list (434).  Therefore the algorithm replaces the original value 1120 with the value
434.

The  result  of  the  filter  is  the  elimination  of  isolated  pixels  without  too  much
alteration in the original image. Nevertheless the median filter introduces a defect:
due  to  its  non  linear  characteristics,  it  may  not  preserve  the  photometric  and
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astrometric qualities of the original image.

Non linear filters

The filters above may also modify some interesting parts of the image, so very often
a non-linear (adaptive) if preferred. To remove hot pixels use the specific Hot pixels
filter. To attenuate generic noise use Adaptive low pass or Denoise.

9.6 Gradient filters

Most  image  processing  filters  are  isotropic,  e.g.  they  are  represented  by  a  kernel
which has identical characteristics in all directions. 

Sometime it's useful to have some indications about how the brightness of an object
changes  with  respect  to  one  direction.  For  this  purpose  we  use  the  so-called
gradient filters: in fact they represent the calculation of the partial derivative of the
image along a well determined direction, usually one of the two Cartesian axes.

Laplacian filter

The  Laplacian  is  a  particular  gradient  used  to  emphasize  details  with  rapid
variation of brightness. For this reason the Laplacian is ideal to highlight edges of
objects  and  it  was  used  for  pattern  recognition  and  military  applications.
Mathematically,  the  Laplacian  is  the  second  order  two-dimensional  derivative  in
every point of the image. In formula:
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In image processing, the original picture I(x,y) is not a continuous function, but a
discrete one, from which we approximately make the second order derivative. Three
typical 3x3 kernels often used are:

For example, if we apply the second kernel to the image of M57:

The sum of  all  elements  of  a  Laplacian kernel  is  always  zero:  this  implicates  that
the filter is not linear.

Contour detection

The filters of Prewitt, Sobel, Freeman and Kirsch, which take the name from their
inventors,  have  all  the  same  purpose:  to  detect  with  the  maximum  precision  the
natural  contours  hidden  in  a  digital  image.  They  were  originally  designed  for
artificial  vision,  but  they  can  also  be  helpful  in  the  morphological  studies  of
astronomical objects. 

The Sobel's filter for instance uses two kernels 3x3 one for the horizontal axis (X)
and  one  for  the  vertical  axis  (Y)  that  actually  represents  gradients  along  the
respective axes, then the two gradients  are  combined together and applied on the
image:
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9.7 Gaussian filters

The gaussian filter  is  a  special  isotropic  operator  with some precise  mathematical
properties. The gaussian function is very common in nature and it is often used to
describe statistic distributions. 

In the 1-dimensional case the gaussian function G(x) is defined as: 

In  image  processing  however  we  have  to  deal  with  2-dimensional  functions,
therefore the analogous gaussian function G(x,y) is defined as:
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The parameter s (sigma) is called standard deviation (sdv) and it gives the width of
the Gauss's bell. The most important characteristic of the gaussian distribution is its
similarity with Point Spread Functions (PSF) of stars blurred by turbulence and bad
seeing. 

Since digital images are composed of pixels, the gaussian kernel will necessarily be
discrete, as shown in the following figure:

The effect of the filter is similar to the average filter, indeed it's a weighted average
where the pixels closer to the center of the kernel have more weight in comparison
to those on the border. 

Usually the gaussian filter is used with sigma < 1 to reduce noise and with sigma >
1 to create particular "unsharp masks" for elaboration of planetary images.
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The noise reduction properties of the Gaussian filters can be used in combination
with other filters which increase noise, as for instance the Laplacian filters. In fact,
utilizing the associative properties of the convolution product, we can apply at first
a Gaussian filter to reduce the effects of the noise and therefore the Laplacian filter
to detect the points of rapid variation of brightness.

In  this  example  the  application  of  the  gaussian  filter  before  the  laplacian  filter
reduces the noise of the final image and allows a sharp outline of the regions with
big variation of brightness.
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9.8 Unsharp Mask

This powerful filter creates a blurred image from the original image, then subtract it
from the original one. The result is a new image which contains the sharpest details
present in the original  one:  in fact  the mask that  was subtracted contains the low
spatial frequencies of the image that are therefore eliminated.

The steps of the algorithm are reproducible with the tools of Astroart, but it is more
convenient to use the direct command in the Filter Menu, which allows to see the
result with realtime preview. The filter is defined by two parameters: 

§ s (sigma), is the amount of blur of the mask image, mathematically expressed as
the  standard  deviation  of  the  gaussian  filter  which  blurs  the  mask.
 Recommended values vary from 1.0 to 5.0 accordingly with the sharpness of the
original image.

§ A coefficient (in figure pointed out with k) that has the function to regulate the
effectiveness of the filter: good results can generally be reached adopting values
from 2.0 to 10.0 

Astroart  also  contains  the  option  Adaptive  that  prevents  the  appearance  of  dark
halos around the brightest stars.
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The  unsharp  masking  technique  is  really  effective  on  planetary  imaging,  but  it
needs images with a great S/N ratio.  This ratio,  can be improved (under the same
conditions and equipment) only combining (add or average) a series of images.

The first row of pictures shows the average of 1,  4,  9 and 16 images of Mars.  The
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second row has the same images after the application of the unsharp masking. The
quality clearly improves using many images; in fact the S/N ratio increases with the
square root  of  the number of  images (e.g.  an average of  16 frames has  a  S/N ratio
four times greater than a single one).

Remember that  in image processing Average  and Sum are  almost  the  same thing,
since  the  Average  is  the  Sum  divided  by  a  constant,  and  a  scale  factor  does  not
change an image.

9.9 Larson-Sekanina filter

This is one of the most used filter for the morphological study of comets. It was for
the first time presented by Z. Sekanina and S. M. Larson in 1984 in an article of the
Astronomical  Journal.  In  those  years  there  were  only  some  basic  techniques  to
detect the directional gradient of brightness (see the paragraph about gradient filters
), these techniques were insufficient because they analyze a single direction of the
brightness variations.

Steven  M.  Larson  of  the  Lunar  and  Planetary  Laboratory  in  Arizona  and  Zdenek
Sekanina of the Jet Propulsion Laboratory in California conceived a new algorithm
which  allows  the  application  of  derivatives  on  any  direction  through  a  simple
transformation of coordinates.

With  respect  to  a  Cartesian  system  of  coordinates,  a  digital  image  can  be
represented with a bidimensional function I(x,y). 

In  a  system  with  polar  coordinates  we  can  describe  the  same  function  as  B(r,q)
where r is the distance from the origin and q it is the angle between the point and
the x  axis.  The  origin  of  this  new system of  coordinates  is  no  longer  the  pixel  of
coordinates (0,0) but a generic pixel of our choice that we will point out as (x0,y0),
usually the nucleus of the comet.

The algorithm of Larson-Sekanina can be written as:

http://articles.adsabs.harvard.edu//full/seri/AJ.../0089//0000571.000.html
http://articles.adsabs.harvard.edu//full/seri/AJ.../0089//0000571.000.html
http://articles.adsabs.harvard.edu//full/seri/AJ.../0089//0000571.000.html
http://articles.adsabs.harvard.edu//full/seri/AJ.../0089//0000571.000.html
http://articles.adsabs.harvard.edu//full/seri/AJ.../0089//0000571.000.html
http://articles.adsabs.harvard.edu//full/seri/AJ.../0089//0000571.000.html
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In the formula, from the original image B(r,q), doubled for convenience, we subtract
two  images  which  are  geometrically  modified  with  a  radial  shift  of  -r  and  a
rotational shift of +q and -q . 

The  result  image  will  lose  all  the  possible  photometric  information,  but  it  will
reveal  the  hidden  variations  of  brightness  inside  the  coma.  It  is  interesting  to
outline  that  these  elaborations  appear  very  similar  to  the  sketches  drawn  by  the
most experienced visual observers.

The amount of the shifts r and q is empirically established with some tests and they
greatly  depend  on  the  experience  of  the  analyst.  Sometimes  it  is  also  possible  to
reveal  artifacts  that  don't  correspond  to  any  morphological  characteristic  of  the
comet.

· Dr = 0. The equation of the filter becomes:
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In  the  case  of  zero  radial  shifts,  we  increase  the  contrast  of  all  those  details  that
have an angular gradient of brightness with respect to the origin of our polar system
of  coordinates  (the  false  nucleus).  These  enhanced  details  are  generally  jets
erupting from the nucleus. 

In the figure it's  evident  the principal  jet  that  arise from the origin of  the tail  and
crosses  the  whole  quadrant  to  the  up  left  corner  of  the  image.  This  gradient,
calculated  in  correspondence  of  the  points  P-P1  and  P-P2,  has  enhanced  the
contrast of the main jet  arising from the nucleus of the comet,  while on the other
side of the coma it allows to glimpse some weak fountain structures that would also
be able to originate from points with elevated activity on the surface of the nucleus.
 

The same gradient has  however pointed out  a  defect  of  the CCD:  the  two vertical
lines  in  the  superior  and  inferior  part  of  the  image  are  in  fact  due  to  a  smearing
effect caused by the high brightness of the object and  lack of a fast shutter in the
CCD camera.

· Da = 0: the equation of the filter becomes:
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In  the  case  of  zero  rotational  shifts,  modifying  the  value  of  (Dr),  we  enhance  the
contrast of all those details with a radial gradient of brightness with respect to the
false nucleus. The jets are no more visible, but we enhance halos, spiral structures
and shells of dust and gas that compose the inner layers of the coma. 

The  following  image  illustrates  the  comet  C/1996  B2  (Hyakutake)  taken  at  the
Observatory of Cavezzo on April 28 1996: it's the sum of 30 images of 10 seconds
each.

1) jet; 2) material disconnection; 3) false nucleus; 4) fountains; 5) shells.

10 Image Calibration

An optimum condition for an amateur astronomer (and professional too) is to take a
single shot of the astronomical subject. But life is not that easy!

All raw images returned by a CCD contain a number of instrumental effects which
must  be  removed  before  the  image  can  be  used  for  scientific  purposes.  CMOS
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sensors,  like  those  used  in  many  Webcams  and  DSLR  cameras,  may  also  have  a
fixed pattern noise.

These effects are usually corrected by taking various sorts of calibration frames in
addition to the images of the astronomical objects. A raw CCD image consists of the
following signals:

§ IMAGE SIGNAL - The signal from the source, generated by the arrival of photons.

§ THERMAL  SIGNAL  -  A  signal  (dark  current,  thermal  electrons)  due  to  the
thermal activity of the semiconductor.  This is an unwanted signal,  and must be
reduced as much as is possible. The thermal signal is reduced by cooling of the
CCD to low temperature.

§ BIAS SIGNAL -  Initial  signal  already  on  the  CCD before  the  exposure  is  taken.
This signal is due to biasing the CCD offset slightly above zero A/D counts (ADU).

Now we introduce a few special CCD images: they are the bias frame and the dark
frame, from which we can also extract the thermal frame and finally the flat field.
Using  these  images  it's  possible  to  perform  a  preprocessing  task  called  image
calibration (not to be confused with astrometric and photometric calibration).

10.1 Dark Frame

The  dark  frame  is  an  exposure  without  exposing  the  CCD  to  any  external  light.
Remembering that every image contains the bias signal, so we have:

DARK FRAME = BIAS FRAME + THERMAL FRAME

The dark current is the main component of the dark frame: the motion of atoms in
the  silicon  lattice  release  some  free  electrons  which  are  collected  by  the  CCD
capacitors. This effect increase greatly with temperature, for this reason most CCDs
used in astronomy are cooled to very low temperatures.

To  remove  the  dark  frame from an  image  it's  required  to  take  an  exposure  of  the
same duration, keeping the shutter of the camera closed. The dark frames must be
taken at the same temperature and duration of the light images. The thermal signal
is generated by a current of electrons,  it  is a time dependent phenomenon, a long
duration exposure will have more dark current than a short one. 

Like every other CCD image, the dark frame has some casual noise associated with
it. The more dark frames you combine, the less noise will be introduced into your
image when subtracting the master dark frame.

Usually, if you subtract a single dark frame the overall noise of the image increase.
You are obviously favorably impressed by the disappearing of hot and cold pixels,
but  actually  you  are  adding  noise  to  your  image.  To  avoid  this,  always  combine
(average, median) some dark frames. For example, try to take two dark frames and
subtract  one  from  the  other:  what  you  get  is  a  "salt  &  pepper"  image.  This  is  a
representation  of  the  noise  that  you  will  add  to  your  images  using  a  single  dark
frame.
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In  conclusion:  it’s  recommended to  get  many dark  frames  and average  or  median
them  (see  Preprocessing).   Averaging  frames  reduces  the  random  components  by
the square root of the number of frames averaged: although it takes more time, you
will obtain much better images.

10.2 Flat Field

Another problem of  CCD images is  that  the response to  light  may  change  slightly
from pixel to pixel, due to variations in electrode size and shape, vignetting or just
dirt and dust on the CCD window. If these variations are not corrected, they end up
as errors in magnitudes of stars. The three main culprits are:

§ Vignetting in the optics.

§ Intrinsic and surface defects of the CCD.

§ Shadows cast by dust. 

Vignetting 

A perfect optical system would lead every incoming light ray to its proper place on
the focal plane and the entire focal plane would receive equal amounts of light. In
the real world, some portions of the focal plane get more light than others. Usually,
the central portions get a bit more than the outer edges.

Figure above: in this raw frame the typical aspect of a vignetted field with a brighter center area in
the field of view.

Intrinsic and surface defects of the CCD 

Sometimes,  one  region  of  the  CCD  is  just  more  sensitive  to  light  than  others.
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Thinned, back-illuminated chips are prone to showing artifacts due to the grinding,
polishing and etching of their surfaces.

Figure  above:  in  this  highly  stretched  dark  frame  taken  from  a  thinned  back-illuminated  chip  is  
clearly visible a diagonal pattern caused by the grinding and polishing of the silicon layer.

Dust particles in the optical path 

Dust gets everywhere. Any particles which stick to the optical surfaces, the lenses
of a focal reducer or the optical window of the CCD will cast shadows on the focal
plane. Diffraction turns these shadows into the so called "dust donuts".
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Figure above: some dust particles are visible in this flat field.

To correct these defect it's used a special image called "Flat field". This image must
be corrected for dark frame then it used as a divisor for the light frame:

Corrected image = Image / Flat field

Some flat field methods

§ White screen. Many professional astronomers take their flat fields using a white
screen illuminated by lamps inside the dome. This will work well  to flatten the
image  to  about  1%  and  has  the  convenience  of  being  able  to  be  made  in  the
afternoon, or when conditions are poor. The signal to noise of these flats are very
good  because  the  light  levels  are  high.  However,  the  screens  often  do  not
accurately match the illumination pattern of the night sky, nor the colors, but for
small  telescopes  this  method  tends  to  provide  better  results  than  twilight  flats
which often have too many stars.

§ The sky + white plexiglass. This combination produces results that are as flat as
dome  flats  and  eliminates  the  need  to  remove  stars.  At  twilight,  point  your
telescope  at  the  zenith  and  place  a  1/8-inch  to  1/4-inch  thick  piece  of  white
plexiglass over your telescope. You may need to integrate longer than a dome flat
since the signal to noise may be lower.

§ The sky. Accurate flat fields are very important when trying to detect the faintest
portions of a nebula or the coma and tail of comets. To very accurately flatten the
images,  you  need  to  use  the  sky  as  a  flat  field.  You  can  take  flats  during  the
twilight,  beginning  just  after  sunset  in  your  bluest  (B)  filters,  and  progressing
toward  redder  (R)  filters  as  the  sky  darkens.  Be  sure  to  have  the  telescope
tracking  on  and  to  move  the  telescope  significantly  between  each  exposure  so
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that  the  stars  can  be  removed  later.  Take  a  minimum of  3  flats  for  each  of  the
filters you plan to observe with. Ideally, at least 5 good flats per filter are needed,
each with  a  signal  level  approximately  2/3  the  level  of  the  linear  range  of  your
detector. These flat fields accurately represent the illumination pattern of the sky.

10.3 Thermal Frame

The  thermal  frame  is  an  image  of  the  dark  current  of  the  CCD  (thermal  signal)
corrected  from  the  bias  level.  It  has  not  practical  use,  but  it's  an  important
theoretical concept.

THERMAL FRAME = DARK FRAME - BIAS FRAME

The thermal  frame can be obtained subtracting the bias frame from a  dark  frame.
This  signal  is  caused  by  the  "dark  current"  of  the  CCD.  It  increases  with
temperature and exposure time.

10.4 Bias Frame

The  bias  frame  is  an  image  taken  with  an  exposure  of  zero,  with  shutter  closed.
Usually it's not used in image processing, since the bias frame is always included in
the dark frame, so when you subtract the dark frame your subtract the bias frame as
well. The only use for bias frames is for scaled dark frames.

The  bias  is  an  additional  voltage  at  the  output  port  of  the  ADC (analog  to  digital
converter). For this reason the bias is a signal which is added to the signal of every
pixel  of  the  CCD.  This  bias  varies  slightly  with  position  on  the  chip,  it  can  vary
slowly with time and inevitably has noise associated with it.

In  the  figure  above  we can see  a  typical  bias  frame  analysis.  The  profile  window
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shows that pixels along the profile line vary from about 3086 to 3096 ADU leading
to an average value throughout all the line of about 3091 ADU, this is what we call
the "offset" value. 

The "pixel to pixel" variations are caused by random noise. The standard deviation,
sometimes  called  "sigma"  or  "rms"  (root  mean  square)  of  the  bias  signal  is  called
system readout noise.

If we plot an histogram of the bias frame (figure above), we can find that the shape
of  the  histogram  is  similar  to  a  gaussian  bell.  The  width  (s  =  sigma)  of  this
distribution  is  related  to  the  readout  noise  and  the  device  gain  by  the  following
expression:

sR = NR / G

where NR is the total number of electrons per pixel resulting from the readout noise

and G is the gain of the CCD (expressed in electrons/ADU).

But  which  role  has  the  bias  frames  in  our  CCD  image  processing?  Usually  none,
because when we subtract the dark frame, we are subtracting at the same time the
bias frame and we do not need to deal with it any more.

A last note: professional CCD cameras cooled to cryogenic temperature may have a
zero dark current, in this case it's possible to use the bias frame as a dark frame. If
your camera has an extremely low dark current and/or the exposure was very short,
then it could be possible to use the bias as dark frame. As usual, to minimize noise
it's important to average some bias frames into a master bias frame.

10.5 Calibration

If  you read a  paper  in astronomy journals,  you'll  often see the phrase "we applied
the  standard  reduction  procedure  to  our  images."  What  does  that  mean?  Let's
suppose we have a raw CCD image, we have to:
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1. Subtract a (master) dark frame. As written before this will correct the bias frame
too.

2. Divide by a (master) flat field, (but the flat field must be corrected with its dark
frame).

Every set should be composed of at least 5-10 image to decrease the noise.

§ SET  #1.  Dark  frames  for  the  light  image:  be  sure  to  take  the  set  at  the  same
temperature and exposure time of your light frames.

§ SET  #2.  Flat  fields,  which  are  usually  taken  at  a  different  exposure  time  and
different temperature.

§ SET #3.  Dark  frames  for  the  flat  fields.  Since  the  flat  fields  were  taken  with  a
different exposure and temperature, you cannot reuse the dark frames of Set#1.

Using  the  Preprocessing  Window,  it's  possible  to  drag  and  drop  each  set  into  its
box.

11 FITS Overview

The native file format for Astroart images is FITS (Flexible Image Transport System
), the standard used in the scientific community.

FITS data format was designed by NOST (NASA / Science Office of Standards and
Technology) to provide a way to exchange astronomical data between installations
whose internal formats and hardware differ. It is important to outline that FITS was
designed  to  transport  scientific  data,  it's  not  a  simple  graphical  format  like  BMP,

http://fits.gsfc.nasa.gov/
http://fits.gsfc.nasa.gov/
http://fits.gsfc.nasa.gov/
http://fits.gsfc.nasa.gov/
http://ssdoo.gsfc.nasa.gov/nost/
http://ssdoo.gsfc.nasa.gov/nost/
http://ssdoo.gsfc.nasa.gov/nost/
http://ssdoo.gsfc.nasa.gov/nost/
http://ssdoo.gsfc.nasa.gov/nost/
http://ssdoo.gsfc.nasa.gov/nost/
http://ssdoo.gsfc.nasa.gov/nost/
http://ssdoo.gsfc.nasa.gov/nost/
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TIFF, JPEG etc.

All FITS files are structured as records of 2880 byte and consist of three parts: the
header, the data and the tailer.

§ The header. The beginning of the file is a human-readable text of 36 rows and 80
columns,  for  a  total  of  2880  bytes.  Most  rows  are  composed  of  a  keyword  (left
justified, 8-character) followed by a numeric or a string value. It's possible to add
other records of 36 rows, until the header is terminated by the keyword "END".

§ The  data.  The  data  (for  our  specific  case  the  image  data)  is  coded  in  binary
format. FITS supports 8, 16, 32, 64 bits and floating point.

§ The  tailer.  The  tailer  adds  extra  bytes  (ASCII  0  characters)  to  pad  the  file  to  a
standard length multiple of 2880 bytes. This is required by obsolete tape readers.

In FITS the first bytes of data describe the bottom pixels of an image. This feature
was  ignored  by  some  Windows  programmers,  the  result  is  that  some  Windows
software  now  save  and  open  all  FITS  files  flipped  up/down  which  are  not
compatible  with  the  NASA's  standard.  Astroart  is  one  of  the  few  software  which
manages FITS correctly, letting you to pass your images to professional astronomers
which use academic software under UNIX.

For  more  information  about  the  FITS  file  format  see  official  FITS  web  site:
http://fits.gsfc.nasa.gov/

11.1 Standard mandatory keywords

Any FITS header must contain the keywords shown below in the order given:

§ SIMPLE. This value can be T (true) or F (false) to indicate a "simple" FITS image.
"Non-simple" images can be encoded as binary tables, also in compressed format.

§ BITPIX. The number of bits (8, 16, 32, 64). Minus 32 means floating point. 

§ NAXIS. The number of axes (images have NAXIS = 2, or 3 for color FITS).

§ NAXISn. The number of pixels along the n# axis. For an ordinary image NAXIS1
is the width and NAXIS2 is the height.

§ END. This keyword has no associated value and ends the header.

11.2 Standard reserved keywords

These keywords are optional, but they are defined by the FITS standard.

§ DATE-OBS.  The  date  and  time  of  the  start  of  exposure,  in  UTC,  in  the  form
YYYY-MM-DDThh:mm:ss[.sss...]. Please note that the mid of exposure, which is
used for all measures, is always a calculated field, as: DATE-OBS + EXPOSURE /
2.

§ EXPTIME  or  EXPOSURE.  The exposure time,  used to calculated the mid of  the
exposure with the formula above.

http://fits.gsfc.nasa.gov/
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§ JD or DATE--JD. The Julian Date, in UTC.

§ ORIGIN. The organization creating the FITS file.

§ TELESCOP. The model of the telescope.

§ INSTRUME. The model of the camera used to acquire the image.

§ OBSERVER. The name of who acquired the image.

§ OBJECT. The name of the observed object.

§ BZERO and BSCALE. These keywords are used when the data values are not the
true  physical  values.  These  coefficients  allow  to  recover  the  physical  values
using  the  following  equation.  (If  not  used  the  default  values  for  BZERO  and
BSCALE are 0.0 and 1.0).

physical value = BZERO + BSCALE  x array value

§ BUNIT.  The  unit  of  measure  of  the  physical  units,  after  the  application  of
BSCALE and BZERO. 

§ COMMENT.  This  keyword  has  no  associated  value,  columns  9-80  just  contain
ASCII text. Any number of COMMENT can appear in a header.

§ HISTORY.  This  keyword  has  no  associated  value,  columns  9-80  just  contain
ASCII text. It contains a history of the steps used to process the image.

11.3 Color FITS

A key feature of Astroart is the creation and management of FITS files with colors.
Astroart uses the standard keywords NAXIS=3  and NAXIS3=3,  to  store the three
color channels in the same FITS file as a 3-D data cube (see the picture below).

Other programs which are able to read color FITS are: SAOIMAGE DS9 (http://hea-
www.harvard.edu/RD/ds9/) and FV,  The Interactive  FITS File  Editor  (http://heasarc.
gsfc.nasa.gov/ftools/fv/). 

http://hea-www.harvard.edu/RD/ds9/
http://hea-www.harvard.edu/RD/ds9/
http://heasarc.gsfc.nasa.gov/ftools/fv/
http://heasarc.gsfc.nasa.gov/ftools/fv/
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Using  color  FITS,  you  can  save  in  a  single  file  the  three  RGB  components.  Each
component  can  be  as  deep  as  32  bit  floating  point  data,  giving  you  the  unique
power of a 96 bit color imaging.

11.4 WCS

The WCS (World Coordinate  Systems) is  a  standard  composed by FITS keywords
which permits to share the astrometric calibration. 

§ CTYPE1  and CTYPE2  indicate  the coordinate type and projection.  The first  four
characters  are  RA--  and  DEC-   in  case  of  equatorial  coordinates).   The  second
four characters contain a four-character code for the projection type (-TAN).

§ CRPIX1 and CRPIX2 are the pixel coordinates of the reference point to which the
projection and the rotation refer.

§ CRVAL1  and  CRVAL2  give  the  center  coordinate  as  right  ascension  and
declination in decimal degrees. 

There are three options for the scale and rotation:

http://tdc-www.harvard.edu/software/wcstools/wcstools.wcs.html
http://tdc-www.harvard.edu/software/wcstools/wcstools.wcs.html
http://tdc-www.harvard.edu/software/wcstools/wcstools.wcs.html
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§ Historically,  CDELT1  and CDELT2  have been used to  indicate  the  plate  scale  in
degrees  per  pixel  and  CROTA2  has  been  used  to  indicate  the  rotation  of  the
horizontal and vertical axes in decimal degrees. 

§ The  FITS  WCS  standard  uses  a  rotation  matrix,  CD1_1,  CD1_2,  CD2_1,  and
CD2_2 to indicate both rotation and scale, allowing a more intuitive computation
if the axes are skewed. This model has been used by HST and IRAF for several
years.

§ Another  standard  uses  PC001001,  PC001002,  PC002001,  and  PC002002  to
represent the rotation matrix but retained CDELT1 and CDELT2 for the scale. It is
also read by this software, but should not be used for new WCS's. 

Astroart  supports  both  the  approximate  standard  based  on  keywords  CDELT  and
CROTA and the more precise system based on keywords CDx_y.

12 Glossary

12.1 ADU

A.D.U. or "Analog to Digital Unit" is the unit of measurement of pixel values.

Electrons  captured  during  the  exposure  are  converted  to  ADU  by  the  ADC  chip
(analog to digital  converter).  ADU represents the voltage of the pixel  as  read from
the  CCD  compared  to  the  maximum  voltage  of  the  ADC.  This  maximum  value
defines the dynamic range of the ADC (12 bit  = 2^12th = 4096 values, 16 bit  =
2^16th = 65536 values, etc.).

To read the ADU value of a pixel with Astroart  just  move the mouse pointer over
that pixel and look the Status bar of the Astroart desktop. To modify a pixel's ADU
see: Edit Pixels.

12.2 Binning

Binning means the union of two or more pixels.

A  CCD  chip  is  an  array  of  light  detecting  regions  called  pixels  (for  picture
elements). A CCD picture can be acquired joining some adjacent pixels and making
them one effective superpixel. The figures below represent a detector of 144 pixels,
the thick lines indicate the current binning mode.
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Binning 1x1 

Number of pixels: 576 

Binning 2x2

Number of pixels: 144

Binning 4x4

Number of pixels: 36

The  advantage  of  binning  is  the  reduction  in  noise,  so  the  Signal  to  Noise  ratio
increases. 

Imagine a 2x2 array of pixels. Each pixel has signal and noise. If you add the values
of  the  four  pixels  the  new  S/N  doubles,  because  it  becomes  4*Signal  /  sqrt
(4*Noise). Noise adds as the square root because it is a random process.

The  drawback  of  binning  is  the  loss  of  resolution.  Smaller  pixels  detect  more
portions of an object. However with sufficiently small pixels binning has not a large
impact since it's generally the sky (seeing) that limits the resolution.

12.3 CCD

CCD chips consist of an array of light-sensitive capacitors. When light falls on the
chip during the exposure, electrons released by the semiconductor are collected by
these capacitors. The number of electrons is proportional to the amount of light.

At the end of the exposure the charge of each capacitor is measured, the resulting
electric signal is converted by a component called ADC (analog-to-digital converter)
into  a  number  which  is  transmitted  to  the  PC.  This  number  is  called  "ADU",  the
value of the pixel.

12.4 FWHM

FWHM  or  Full  Width  at  Half  Maximum  is  a  measure  of  star  size.  To  calculate  it
from a profile of a star simply measure the distance between the two points where
the signal is 50% of the peak value.
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The FWHM can be measured in pixels or arcseconds. Inside the Stars window the
FWHM is measured in pixels.

12.5 Gain

The  gain  of  a  CCD  camera,  or  the  system  gain,  express  how  many  electrons  are
represented  by  one  ADU.  A  gain  of  2.0  electrons/ADU  means  that  each  ADU
represents 2 electrons. This implies that the total well depth of a Kodak KAF-0400
CCD (85,000 electrons) could be represented by 85000 / 2.0 = 42500 counts.

As long as the total well depth of a sensor can be represented, a lower gain is better
to  minimize  the  noise  and  give  better  resolution.  Gains  which  are  unnecessarily
high  can  result  in  more  digitization  noise,  while  gains  which  are  too  low  will
minimize  noise  at  the  expense  of  well  depth.  For  example,  a  16  bit  CCD  camera
with a gain of 1.0 would allow only 65,536/1.0 = 65,536 electrons of the 85,000 to
be  digitized.  System gains  are  designed  as  a  balance  between  digitization  counts,
digitization noise, and total well depth.

12.6 LAA and 64 bit

The Setup always install three executables of Astroart:  32 bit,  32 bit  LAA, and 64
bit  (Astroart.exe,  AstroartLAA.exe  and  Astroart64.exe).  They  are  installed  in  the
same folder and they share the same settings and data files. Depending your  task,
just use the best one for you.
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Version OS Max memory Use

32 bit Windows 32 and 64 2 Gb Image processing and camera control

32 bit LAA Windows 64 only 4 Gb Image processing and camera control

64 bit Windows 64 only Physical RAM Image processing only

Astroart LAA is a special version of Astroart compatible with the Microsoft "LARGE
ADDRESS AWARE" technology on Windows 64 bit. Astroart LAA can therefore use
4 Gb of RAM instead of 2 Gb. This version is kept separate because some very old
camera and telescope drivers are not compatible with it.

Astroart 64 bit works only on Windows 64 bit, it's intended for image processing of
large images (20+ megapixels), it does not contain camera and telescope control.

After the installation the 64 bit and the LAA version can be launched from the Start
Menu of Windows. If you use them often, add a shortcut to the Desktop.

12.7 Point Spread Function

The Point  Spread  Function  (PSF)  is  a  function which  defines  how a  point  source
would appear if imaged with the instrument.

Ideally a point source would produce a clear signal in just one pixel on the image
but  due  to  the  optical  effects  this  is  not  the  case.  Optical  diffraction  and
atmospheric  distortion  are  the  factors  causing  light  from  point  sources  to  be
smeared  into  many  pixels.  This  means  that  the  PSF  defines  the  resolution  of  the
instrument.

12.8 Outside constant

This is a constant used when considering points "outside the image".

In  the  Preferences  window it’s  possible  to  set  a  value  for  it  (example:  zero)  or  to
force to make it variable and equal to the sky background.This constant is used by
the  commands:  Rotate,  Shift,  Align,  other  filters  calculates  a  more  precise  value
computed near every edge of the image.

12.9 Readout Noise

Each  time  the  charge  is  dumped  out  of  the  CCD  there  is  an  uncertainty  in  the
measure which is called readout noise and expressed in electrons (e-).

Readout  noise  is  specified  both  for  the  CCD  sensor  and  the  total  system.  For
example,  a  good  noise  figure  for  the  Kodak  KAF-0402E  and  KAF-1602E  is  13e-
typical,  while  a  good  number  for  the  entire  system  is  15e-  typical.  Most
applications  are  not  limited  by  readout  noise,  since  the  noise  caused  by  the  sky
background and dark current is much higher.
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12.10 Seeing

Without  an  atmosphere,  a  small  star  would  appear  as  a  diffraction  figure
determined  by the  optical  system,  and would  be  inversely  proportional  in  size  to
the  diameter  of  the  telescope.  However  when light  enters  the  Earth's  atmosphere,
the different temperature layers and different wind speeds distort the light and the
image of the star. 

This distortion changes at a high rate, usually more than 100 times a second. In a
typical  astronomical  image  with  an  exposure  of  several  seconds,  the  distortion
blurs  the  star  into  a  disc  called  the  point  spread  function  or  "seeing  disc".  The
diameter of the seeing disc is the Full Width at Half Maximum (FWHM) which is a
common measure of the seeing conditions.

On the  left,  an  image  with  a  seeing  of  2.9  arcseconds.  On the  right,  the  same  image  on  a
worse night, with a seeing of 4.6 arcseconds. Courtesy Cavezzo Observatory.

The FWHM of  the seeing disc (or  just  Seeing)  is  usually measured  in  arcseconds,
abbreviated  with  the  symbol  (").  A  1.0"  seeing  is  a  good  one  for  average
astronomical sites. The seeing of an urban environment is usually much worse. At
the  best  high-altitude  mountaintop observatories  the  air  is  stable,  since  it's  not  in
contact with the ground during the day, so sometimes the seeing is as good as 0.4".
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12.11 Signal to noise ratio

Signal-to-noise ratio (SNR) is the ratio between the signal and the noise of an image
(or a part of it). The higher the SNR, the better the image. Noise in CCD images is
caused  by  sky  background,  dark  current,  electronic  sources  and  statistical
randomness of the signal. For a correct measure of SNR of stars,  you must set the
camera parameters (gain, etc.) in the Preferences. 

What  is  the  noise  with  a  ideal  CCD camera  (i.e.  with  zero  noise)  on  a  absolutely
dark sky (again, zero noise)? The result is not zero, it's SquareRoot(N), where N is
the number of photons collected.

This  result  is  surprising,  there  is  still  some  noise  as  predicted  by  the  Poisson
theory.  This  noise  is  caused  by  randomness.  For  example,  with  100  photons  the
noise  is  10,  so  measuring  the  star  you  may  get  92,  104,  88,  107  and  so  on.  To
understand that, remember that photons are emitted with a random trajectory and a
random emission rate. 

So, even with with a perfect CCD under a black sky we still need a long exposure,
to  be  able  to  collect  thousand  of  samples.  For  example,  with  50000  photons  the
noise is 223, so we may expect an error of about +- 223/50000 = 0.4 % which may
be acceptable. The error itself follows a gaussian distribution, so there may be cases
where the error is much higher than 0.4 %.

Please notice that the unit in this example is photons, while in CCD images the unit
is ADU. If your camera produces 1 ADU every 4 photons then a star measured 25
ADU was sampled by 100 photons. The Poisson noise is 10 photons, so 2.5 ADU. 
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